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3 1章　概要

システム構成例

ワイヤレス 
マイクロホン 
パッケージ 
UWP-D21 
UWP-D22 
（受信機： 
URX-P40）

マルチインター 
フェースシュー 

アダプター 
SMAD-P5

ワイヤレス 
マイクロホン 
レシーバー 
URX-P03D

マルチインター 
フェースシュー 

アダプター 
SMAD-P3D

XLR アダプター 
キット 

XLR-K3M

ビデオライト 
HVL-LBPC

S35 PL レンズ
MIシュー搭載ハンドル 
(A-5012-165-) ハンドル

VFモジュール

バッテリーパック 
BP-GL95B

AC アダプター 
AC-DN10A

リモートコントロール 
ユニット 

RM-30BP/1BP
RCP-1530/3100/3500/3501

MPC-2610

CFexpress 
Type B 

メモリーカード

ショルダーアダプター 
VCT-FSA5

グリップリモコン 
GP-VR100

SD カード

PLマウントアダプター

アナモフィックレンズ 
（PL マウント）

フルフレームレンズ 
（PL マウント）

E マウントレンズ

A マウントアダプター 
LA-EA4 
LA-EA5

マイクロホン 
ECM-680S*、ECM-678、 
ECM-674、ECM-MS2
*	 EC-0.5X5F3Mが必要

CFexpress Type B 
カードリーダー／ 

SD カードリーダー

ロッドクランプ 
（A-2182-621-） 
マイクホルダー ASSY 

（A-5012-206-）
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各部の名称と働き
操作スイッチ面

LOCK

MFAF

ND STEP ND VARIABLE

FULL MENU

ND ON

1 2

3

CLEAR

DISP

AUTO

A

B

CLIPS

CH-1

CH-2AUTO

SLOT
SEL

MENU

BACK

REC

SD

4 7 92 10

14151718
16

1920

21
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26
27

24

22

1 3 65 8
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CFexpress Type Bカード 
スロット部（5ページ）

1.	 FOCUSスイッチ（96ページ）

2.	 LOCKスイッチ
ボタン操作をロックします。
ロックするとスイッチ背面のLEDがオレンジ色に
点灯します。

3.	 ND VARIABLEダイヤル（103ページ）

4.	本体内蔵スピーカー（78ページ）

5.	 吸気口
［ご注意］
吸気口をふさがないでください。

6.	MENU(メニュー )ボタン（29ページ、
34ページ）

MENU（メニュー）ボタンを押すと、ステータス画
面が表示されます。MENU（メニュー）ボタンを長
押しすると、フルメニュー画面が表示されます。
ステータス画面、フルメニュー画面のときに押す
と元の画面に戻ります。

7.	 CH1/CH2（AUTO/MAN）スイッチ
（106ページ）

8.	Wi-Fiアンテナ

［ご注意］
この部分を手や金属などで覆うと、Wi-Fi通信が遮断され
ることがあります。

9.	 AUDIO LEVEL(CH1/CH2)ダイヤル（106
ページ）

10.	CLIPSボタン（75ページ）
押すと再生アクティブなメディアのクリップがク
リップ一覧画面に表示され、再生操作を有効に
します。クリップ一覧画面のときに押すと撮影画
面に戻ります。

11.	 アクセスランプA/B（19ページ）

12.	SLOT SELECT (CFexpress Type Bメモ
リーカード選択)ボタン（78ページ）

13.	ヘッドホン端子（ステレオミニジャック）
音声モニター用のイヤホンを接続します。撮像、
記録中は収録音を、再生中は再生音をモニター
できます（78ページ）。

14.	Utility SDカードスロット／アクセスランプ
（21ページ）

15.	本体内蔵マイク（106ページ）
環境音収録用のナレーションマイクです。

16.	BACKボタン
メニュー表示中は、メニューのキャンセルやメ
ニュー階層を1つ上に戻します。実行中表示また
は実行指示待ち表示のときは、実行中または実
行指示待ち表示中の処理をキャンセルします。

17.	 電源スイッチ
電源を入れるときは（ON）の位置にします。電源
を切るときは（Standby）の位置にします。

［ご注意］
•	 本機は、電源を切った状態でも、わずかに待機電力を

消費します。本機を長時間使用しないときは、バッテリー
パックを取り外してください。

•	 バッテリーパックやDC IN電源は、電源スイッ チを
STANDBYにして電源ランプが消えてから取り外してくだ
さい。ONのまま取り外すと、本機やメモリーカードの故
障の原因となることがあります。

18.	電源ランプ（89ページ）

19.	REC ACTIVEランプ
RECボタンが有効な状態のときに緑色に点灯し
ます。

20.	REC（記録開始／記録停止）ボタン／ランプ
押すと記録が始まりRECランプが点灯します。も
う一度押すと記録が停止し、RECランプが消灯し
ます（89ページ）。

21.	ASSIGN 3（アサイナブル3）ランプ（108ペー
ジ）

割り当てられた機能がオン（有効）または起動して
いる場合はオレンジ色に点灯し、オフ（無効）ま
たは停止している場合は消灯します。

22.	マルチファンクションダイヤル（108ページ）
LCDモニターに映像が表示されているときに押す
とダイレクトメニューが表示され、操作すること
ができます。
また、LCDモニターに各種メニューが表示されて
いるときに回すとカーソルが上下に移動して、メ
ニュー項目や設定値を選択できます。押すと選択
している項目を確定します。
メニュー表示していないときは、アサイナブルダ
イヤルのように機能させることができます。

［メモ］
工場出荷時は、Eマウントレンズ装着時に回すと、Irisを調
節できます。
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23.	マルチセレクター（8方向＋決定）
オートフォーカスで被写体認識枠の選択やフォー
カスエリアの移動に、ピント拡大で拡大位置の
移動に使用します。LCDモニターが映像監視モー
ド（22ページ）のときはメニュー操作に使用す
ることもできます。

［メモ］
グリップリモコン（別売）やLANCリモコン（別売）のマルチセ
レクターはこのマルチセレクター相当の働きをします。

24.	DISPLAY（画面表示）ボタン（23ページ）

25.	ASSIGN 1/2（アサイナブル1/2）ボタン／ラ
ンプ（108ページ）

割り当てられた機能がオン（有効）または起動して
いる場合はオレンジ色に点灯し、オフ（無効）ま
たは停止している場合は消灯します。

26.	ND FILTER POSITION上下ボタン／	
ND CLEARランプ（103ページ）

NDフィルターをCLEARにすると、ND CLEARラ
ンプが点灯します。

27.	ND STEP/VARIABLEスイッチ（103ペー
ジ）

28.	PLマウントアダプター（16ページ）

CFexpress Type Bカードスロット部 
（19ページ）

CFexpress Type Bカードスロットはカバー内に
あります。

1

1.	 CFexpress Type BスロットA/B

端子面

SDI OUT  1

SDI OUT  2
INPUT LINE

MIC
MIC + 48V

TC

OUT
IN

REF

12V

REMOTE GRIP

VF

7

1

INPUT
2

LINE
MIC

MIC + 48V

3 4

13 12 11 10

14

15

1 2

6
5

7

9
8

1.	 記録／タリーランプ（89ページ）
記録中は点灯し、記録メディアやバッテリー残量
が少なくなると点滅します。

2.	 USB-C™端子（82ページ、86ページ、
118ページ）

3.	 ASSIGN 7（アサイナブル7）ボタン／ランプ
（108ページ）

割り当てられた機能がオン（有効）または起動して
いる場合はオレンジ色に点灯し、オフ（無効）ま
たは停止している場合は消灯します。

4.	メジャーフック
メジャーフックがイメージセンサー面の位置とな
ります。本機から被写体までの距離を正確に測
るには、メジャーフックの位置を参考にしてくだ
さい。メジャーフックにメジャーの先端をかけて、
被写体からの距離を実測できます。

5.	 Wi-Fiアンテナ
［ご注意］
この部分を手や金属などで覆うと、Wi-Fi通信が遮断され
ることがあります。

6.	 INPUT 1スイッチ(LINE/MIC/MIC+48V)
（106ページ）

7.	 INPUT 1（オーディオ入力1）端子
（106ページ）
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8.	 INPUT 2スイッチ(LINE/MIC/MIC+48V)
（106ページ）

9.	 INPUT 2（オーディオ入力2）端子
（106ページ）

10.	グリップリモコン取り付け部
グリップリモコン（別売）を取り付ける部位です。

11.	 排気口
［ご注意］
排気口をふさがないでください。

12.	グリップリモコン端子
グリップリモコン（別売）を接続する端子です。

13.	REMOTE端子
汎用のLANC端子アクセサリーを接続する端子
です。

14.	TC/REF IN/OUT切り替えスイッチ（116
ページ）

後面2端子の機能を、TC IN/REF INにするか、
TC OUT/REF OUTにするかを切り替えます。

15.	ビューファインダー接続端子（11ページ）

フロント（前面）

3

1

3

2

1.	 PLレンズ通信用端子（トップ）

2.	 PLレンズ通信用端子（サイド）

3.	 ASSIGN 3（アサイナブル3）ボタン（108
ページ）

押すたびに、割り当てられた機能のオン（有効）
とオフ（無効）を切り換えたり、割り当てられた機
能を起動したりできます。
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リア（後面）

12
11

10

1
2

3

4

5

6

7

9 88

1.	 HDMI OUT端子（115ページ）

2.	 SDI OUT 1端子（115ページ）
12G-SDI出力に対応しています。

3.	 SDI OUT 2端子（115ページ）
3G-SDI出力に対応しています。

4.	 TC IN/TC OUT（タイムコード入力／出力）端
子（116ページ）

5.	 REF IN/REF OUT（同期信号入力／出力）端
子

TC/REF IN/OUT切り替えスイッチによって、以
下のいずれかの用途に使用します。
IN：外部から本機にGenlockをかけるとき、また

は本機のタイムコードを外部ロックさせると
き、基準信号を入力します。

OUT：外部機器の同期用に同期信号を出力しま
す。REF OUT端子は常にHD sync信号を出
力します。

6.	ネットワーク端子（RJ-45）
LANケーブル（別売）を接続することで、有線
LAN接続による安定したネットワーク機能を使用
できます（82ページ）。

［ご注意］
Wi-Fiと同時に使用できません。

7.	 DC-IN端子（XLR 4ピン）（14ページ）
本機に外部電源を供給するためのDC IN（DC電
源入力）端子（XLR4ピン、凸）です。入力電圧は
12V（11 ～ 17V）に対応しています。

No. 信号
1 GND
2 NC
3 NC
4 12V（11V ～ 17V）

8.	吸気口
［ご注意］
吸気口をふさがないでください。

9.	記録／タリーランプ
記録中は点灯し、記録メディアやバッテリー残量
が少なくなると点滅します。

10.	バッテリー取り付け端子（14ページ）

11.	 バッテリーパック取り付け部（14ページ）

12.	バッテリーリリースレバー（14ページ）
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トップ（上面）

22

1

1.	 ハンドル接続端子
MIシュー搭載ハンドル（別売）を接続する端子で
す。

2.	アクセサリー取り付けねじ穴
ネジ種：1/4-20UNC（×8）
ネジ種：3/8-16UNC（×6）
ネジ勘合長：10 mm 以下

ボトム（底面）

1

2

1.	 三脚プレート取り付け穴
ネジ種：1/4-20UNC（×4）
ネジ種：3/8-16UNC（×4）
ネジ勘合長：9 mm 以下

2.	吸気口
［ご注意］
吸気口をふさがないでください。
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LCDモニター部

H&V FLIP

8

9

10

HOME

11

1 32

245

10

6

7

9
8

1.	 ASSIGN 11（アサイナブル11）ボタン（108
ページ）

2.	 ITEMボタン 1～ 6（26ページ）
ホーム画面・再生操作画面の操作を行います。

3.	 ルーペロックつまみ（12ページ）

4.	タッチパネル
アサイナブルボタンまたはメニューでタッチ操作
を無効にすることもできます（10ページ）。

5.	 H&V FLIPスイッチ(ON/OFF)
画面の表示を、反転なし（OFF）または上下左右
反転（ON）に切り換えます。

6.	ASSIGN 8（アサイナブル8）ボタン（108
ページ）

7.	 ASSIGN 9（アサイナブル9）ボタン（108
ページ）

8.	マルチセレクター（8方向＋決定）
LCDモニターに表示されている内容を操作すると
きに使用します。

9.	 ASSIGN 10（アサイナブル10）ボタン（108
ページ）

10.	HOMEボタン（22ページ）
押すとホーム画面が表示されます。

［メモ］
撮影画面を基点として各種操作を行う映像監視モードと、
ホーム画面による設定確認・変更に特化した情報表示モー
ドを切り替えます。
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タッチパネルの使いかた
タッチパネル利用上のご注意

本製品のLCDモニターはタッチパネルになってお
り、指で直接触れて操作を行えます。
•	 タッチパネルは指で軽く触れるように設計され

ています。指で強く押したり、先の尖ったもの
（爪／ボールペン／ピンなど）を押し付けたりし
ないでください。

•	 次の場合はタッチパネルに触れても動作しない
ことがあります。また、誤動作の原因となりま
すのでご注意ください。

•	 	爪の先での操作
•	 	異物を操作面に乗せたままでの操作
•	 	保護シートやシールなどを貼っての操作
•	 	ディスプレイに水滴が付着または結露して

いる状態での操作
•	 	濡れた指または汗で湿った指での操作

タッチパネル上の操作

タップ
アイコンやメニューなどの項目に指で軽く触れ、
すぐに離します。

ドラッグ
画面に触れたまま目的の位置までなぞって指を離
します。

フリック／スワイプ
画面に触れて上下または左右にはらうように操作
します。

［メモ］
表示内容が画面の外へ続く場合は、表示内容をドラッグし
たりフリックしたりしてスクロールさせることができます。

タッチパネルの設定

タッチパネルを利用するかどうかは、Technical
メニューのTouch Operation（62ページ）で
設定できます。
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ハンドルとビューファインダーの取り付け
ハンドルを取り付ける

1	 ハンドルを上面の前部または後部のネジ穴（4
箇所）に合わせて配置する。

2	 六角ネジ（4本）を取り付け、六角レンチ（3/16
インチ）を使用して締め付けトルク1.4N・m
で締め付ける。

ハンドルを取り外すには

六角レンチを使用して六角ネジ（4本）を取り外し、
ハンドルを取り外します。

ビューファインダーを取り付
ける

1	 本機にハンドルを取り付け、ビューファイン
ダーアームの固定つまみを反時計方向に回し
て緩め、アームを前方に180°回す。

	 ［メモ］
固定つまみが回しにくい位置にある場合は、固定つま
みを引き出してから操作しやすい位置まで回します。
位置を決めたら固定つまみを元の位置に戻します。

2	 固定つまみを時計方向に回して締める。

固定 
つまみ

アーム六角穴
付きボ
ルト

	 ［ご注意］
アーム取り付けロッドがハンドルに対して回転してし
まう場合は、ロッド基部裏側にある六角穴付きボル
トを六角レンチ（3 mm）で締めてください（締め付けト
ルク：1.6 N・m）。

3	 ビューファインダー取り付け台座をLCDモニ
ター後面に取り付け、固定つまみを時計方
向に回して締める。
ビューファインダー
取り付け台座

固定つまみ

4	 アームのピンを指先で押しながら、ビューファ
インダー取り付け台座をアームに取り付け、
固定つまみを時計方向に回して締める。

ピン
固定つまみ

ビューファインダー 
取り付け台座

	 ［ご注意］
アーム取り付け部の固定つまみを緩めたときにアーム
が極端に緩む場合は、6角レンチ（2.5 mm）でロック
ネジを調節してください。

ロックネジ

5	 本体のビューファインダー接続端子のマー
クとLCDモニターに付いているケーブルのプ
ラグのマークを合わせて、ケーブルを差し
込む。
必ずマークが外側になるように、向きを確
認してから差し込んでください。

6	 ケーブルを3箇所のうち任意のケーブルホル
ダーに取り付ける。

ケーブルホルダー



2章　準備：ハンドルとビューファインダーの取り付け12

7	 LCDモニター上部の溝に、ビューファインダー
ルーペの取り付け部を図のようにスライドさ
せて取り付ける。

8	 ビューファインダールーペを矢印の方向に押
して閉める。

ビューファインダールーペを取り外す

ビューファインダールーペ下部のレバーを押して
上へ開き（）、ビューファインダールーペ取り付
け部のルーペロックつまみを矢印の方向に押し

ながら（）、ビューファインダールーペを取り付
けたときと逆の方向に抜き取ります（）。

ルーペ 
ロック 
つまみ

レバー

ビューファインダーを取り外す

1	 ケーブルホルダーからケーブルを外し、ビュー
ファインダー接続プラグの両側面を押しなが
らケーブルを抜く。

2	 ビューファインダーの固定つまみを緩め、
ビューファインダーを取り付けたときと逆の
方向に抜き取る。

ビューファインダーを取り付
ける（ビューファインダールー
ペを使用しない場合）

1	 本機にハンドルを取り付け、アームの固定つ
まみを反時計方向に回して緩め、アームを前
方に180°回す。

2	 固定つまみを時計方向に回して締める。

固定 
つまみ

アーム六角穴
付きボ
ルト

	 ［ご注意］
アーム取り付けロッドがハンドルに対して回転してし
まう場合は、ロッド基部裏側にある六角穴付きボル
トを六角レンチ（3 mm）で締めてください（締め付けト
ルク：1.6 N・m）。

3	 ビューファインダー取り付け台座をLCDモニ
ター側面に取り付け、固定つまみを時計方
向に回して締める。

ビューファインダー 
取り付け台座

固定つまみ

4	 アームのピンを指先で押しながら、ビューファ
インダー取り付け台座をアームに取り付け、
固定つまみを時計方向に回して締める。

ピン 固定つまみ

ビューファインダー 
取り付け台座

	 ［ご注意］
アーム取り付け部の固定つまみを緩めたときにアーム
が極端に緩む場合は、6角レンチ（2.5 mm）でロック
ネジを調節してください。

ロックネジ
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5	 本体のビューファインダー接続端子のマー
クとLCDモニターに付いているケーブルのプ
ラグのマークを合わせて、ケーブルを差し
込む。
必ずマークが外側になるように、向きを確
認してから差し込んでください。

6	 ケーブルを3箇所のうち任意のケーブルホル
ダーに取り付ける。

ケーブルホルダー

LCDモニターを操作パネルとして運用
する場合の設置例

ビューファインダー取り付け台座の側面をアーム
に取り付けると、下図のようにLCDモニターを設
置することができます。LCDモニターを操作パネ
ルとして運用する場合に便利です。

ビュー 
ファインダー 
取り付け台座
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電源の準備
バッテリーパック、またはACアダプターを介して
AC電源を使用できます。
安全のため、下記ソニー純正以外のバッテリーを
使用しないでください。

リチウムイオンバッテリーパック
BP-GL95B

ACアダプター
AC-DN10A

バッテリーパックを使用する

バッテリーパックをバッテリーパック取り付け部
（7ページ）に差し込んで、下にスライドさせ
てロックします。
取り外すときは、バッテリーリリースレバー（7
ページ）を押してロックを外しながらバッテリー
パックを上にスライドさせて取り外します。

［ご注意］
•	 装着する前に、バッテリーチャージャーを使用して充電

してください。
•	 使用直後でバッテリーパックの温度が上昇した状態で充

電すると、完全に充電されないことがあります。
•	 バッテリーアダプターを取り外す際は、必ず手で支えな

がら外してください。

残量を確認する

バッテリーパックを使用して撮影・再生している
ときは、LCDモニターにバッテリー残時間または
バッテリー電圧が表示されます。
残り時間は、現在の消費電流のペースで本機を
継続使用した場合のバッテリーパックの使用可能
時間を計算して分単位で表示されます。

バッテリーパックの容量が低下すると

使用中にバッテリーパックの容量が一定の値まで
低下すると、バッテリー残量表示が点滅し、REC
ランプの点滅で警告します。
さらに容量が減り、動作が継続不可能な状態に
なると、バッテリーパックの残りがないことを知
らせるメッセージが表示されます。
充電されたバッテリーパックに交換してください。

警告残量を変更する

フルメニューのTechnical > Camera Battery 
Alarm（64ページ）で変更します。

AC電源を使用する（DC IN電
源） 

本機は100WのACアダプターを使用することに
よって、AC電源に接続して動作させることがで
きます。
入力電圧範囲は11 V ～ 17 Vに対応しています。
入力電圧が低下した場合は警告を表示します。
フルメニューのTechnical > Camera DC IN 
Alarm（65ページ）で変更できます。

［ご注意］
バッテリー運用時にDC IN電源へ切り換える際には、 
12 V ～ 17 Ｖの電圧の電源を使用することで、より安全に
電源を切り換えることができます。

バッテリーパックとDC IN 電
源の併用について

バッテリーパックおよびDC IN電源がどちらも給
電可能な電圧の場合は、DC IN電源側から優先
的に給電状態となります。

［ご注意］
バッテリー運用時にDC IN電源からの給電状態に切り換え
ると、以下の要因等により本機の動作が停止する場合があ
りますのでご注意ください。
•	 DCコネクター挿抜時のコネクター部のチャタリング（コ

ネクターこじり等）
•	 電源供給元が切り換わったときの電圧降下（消費電力が

大きいほど大きい）
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時計を合わせる
本機を初めて使用するとき、電源を入れるとLCD
モニターに初回設定画面が表示されます。
この画面を使用して内蔵時計の日付／時刻を設
定してください。

Time Zone について

UTC（協定世界時）からの時差を設定します。必
要に応じて変更してください。

［ご注意］
Time Zoneを変更すると時差に合わせて時刻設定が変更
されます。

日付／時刻を設定する

マルチファンクションダイヤル（4ページ）を回
して項目や数値を選び、ダイヤルを押して決定し
ます。最後にカーソルをSetに合わせてダイヤル
を押すと、設定画面が消えて時計合わせが完了
します。
初回設定画面が消えた後は、フルメニューの
Maintenance > Clock Set（71ページ）を使
用してTime Zoneおよび日時の設定を変更でき
ます。

［ご注意］
•	 動作電源が供給されていない（バッテリーパックもDC IN

電源も接続されていない）状態でバックアップ電池が消
耗するなどして現在日時の情報が失われた場合は、次に
電源を入れると初回設定画面が表示されます。

•	 初回設定画面が表示されている状態では、この画面で
の設定が完了するまで電源を切る以外の操作はできま
せん。

［メモ］
マルチセレクターでも操作できます。
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	˜ 本機で使用できるレンズについて詳しくは、ソニーの
サービス窓口にご相談ください。

レンズを太陽に向けて放置しないでください。太
陽光がレンズを通して機器内部に焦点を結び、
火災の原因となることがあります。

［ご注意］
•	 レンズおよびアダプターの取り付け／取り外しは、本機

の電源を切った状態で行ってください。
•	 レンズは精密部品です。レンズは、マウント部側を下に

して直に置かないでください。必ず付属のキャップをか
ぶせてください。

•	 本機のPLレンズインターフェースは、工場出荷時に
Cooke型コネクター付きレンズ用に合わせて設定されて
います。Cooke型コネクターを持たないレンズを使用す
る場合は、フルメニュー > Technical > Lens > PL-Mt 
Interface Position（63ページ）をOffに設定します。

PLマウントレンズを取り付け
る

1	 PLマウントレバーを反時計方向に回して、レ
ンズマウントからPLマウントキャップを外す。

PLマウント
レバー

PLマウント
キャップ

	 ［ご注意］
PLマウントレバーを反時計回りにストッパーの位置ま
で回してください。

2	 レンズマウント上面右の位置決めピンに、レ
ンズの凹部を合わせ、レンズをマウントに差
し込む。

3	 レンズを支えながら、PLマウントレバーを時
計方向に回して、レンズを固定する。

	 ［ご注意］
PLレンズを装着の際は、レンズを回さないでください。
レンズを回すと、PLレンズ用通信端子のピンが折れる
原因となります。

Cooke /i レンズを取り付けるには

レンズ側のコンタクトと本機側のPLレンズ通信端
子の位置を合わせてください。本機側の端子は2
箇所ありますが、どちらも使用できます。フルメ
ニュー > Technical > Lens > PL-Mt Interface 
Position（63ページ）を合わせた側に設定して
ください。

レンズを取り外すには

1	 レンズを下から支えて、PLマウントレバーを
反時計方向に回す。

2	 レンズを前方に引き抜く。

	 ［ご注意］
別のレンズをすぐに取り付けないときは、PLマウント
キャップの凹部を確実に合わせて、PLマウントレバー
を時計方向に回して固定してください。

フランジバックを調整する

本機はフランジバックを調整した状態で出荷して
います。フランジバックの調整を行いたい場合は、
PLマウントフランジを取り外し、シムを適切な厚
みのものと交換してください。0.01 mm単位で
±0.1 mmの調整ができます。

シムについて

本機には以下のシムが同梱されています
0.05 mm ×1（円弧型）
0.01 mm ×15（1/3円弧型）
1/3円弧型シムは3枚組でご使用ください。フラ
ンジバックを長く調整する場合は、シムを挿入し
てください。本機は出荷時に以下の3種類のシム
によってフランジバックを調整した状態で出荷し
ています。
0.10 mm（円弧型）
0.05 mm（円弧型）
0.01 mm（1/3円弧型）
また、出荷時のシム厚みを示すシールが貼られて
います。

［ご注意］
フランジバックの確認を行う場合は、精度を高めるため電
源を入れてから10分以上経過後に実施してください。
また、撮影状況に近い環境温度で確認すると運用時の誤
差を最小限にすることができます。

フランジバックの調整

1	 トルクスネジ（6本）を外してPLマウントフラ
ンジを取り外す。

1

PLマウントフランジ

2	 PLコネクター（2箇所）の両側の十字ネジ 
（4本）を緩めてPLコネクターとPLコネクター
台を取り外す。

3	 PLマウントアダプター（3箇所）にシムを取り
付ける。

33

33
33

22
22

PLコネクター

PLコネクター台

1/3円弧型のシムを使用する場合
3箇所とも同じ厚みになるようにシムを取り
付けます。

レンズの取り付けとフランジバックの調整
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シム

円弧型のシムを使用する場合
刻印がある面を表にして取り付けます。

刻印

刻印

4	 PLコネクター（2箇所）を元の位置に戻し、
締め付けトルク0.18 N・mで十字ネジ（4本）
を締め付ける。

5	 PLマウントフランジを元の位置に戻し、トル
クスレンチ T8を使用して、締め付けトルク
0.35 N・mでトルクスネジ（6本）を締め付け
る。

光学フィルターのお手入れに
ついて

光学フィルターを掃除するときは、アダプターを
外して拭いてください。アダプター中央部（網掛
け部）をクロスなどで拭くと、繊維が付着する場
合がありますので注意してください。繊維が付着
した場合は、ソフトブラシで掃除してください。

アダプター

PLマウントアダプターを取り
外す

本機にEマウントレンズを取り付ける場合、PLマ
ウントアダプターを取り外します。取り付け／取
り外しは、本機後面を下にした状態で行います。
六角ネジ（2.5 mm、6本）を緩めて、PLマウント
アダプターを取り外します。

PLマウント 
アダプター

［ご注意］
取り付け／取り外し作業時、本機とPLマウントアダプター
の端子接点に触れないようにご注意ください。

［メモ］
バッテリーを取り付けて本機後面を下にして置くと、安定
した状態で作業できます。

PLマウントアダプターを取り付けるに
は

1	 Eマウントレバーがロック位置になっているこ
とを確認する。

Eマウント
レバー

2	 PLマウントアダプターを元の位置に戻し、六
角レンチ（2.5 mm）を使用して、締め付けト
ルク0.8±0.12N・mで六角ネジ（2.5 mm、
6本）を締め付ける。
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Eマウントレンズを取り付ける

1	 PLマウントアダプターを取り外す（17ペー
ジ）。

2	 ロックスイッチを上方向に押してから、Eマ
ウントレバーを時計方向に回してロックを解
除する。

Eマウントレバー

ロックスイッチ

3	 本体とレンズのマウント標点（白色）を合わせ、
レンズをマウントに差し込む。

4	 レンズを支えながら、Eマウントレバーを反
時計方向に回して、レンズを固定する。

 

マウント標点（白色）

［ご注意］
一部のEマウントレンズでは制御できない場合があります。
推奨レンズをご使用ください。

	˜ 本機で使用できるレンズについて詳しくは、ソニーの
サービス窓口にご相談ください。

レンズを取り外すには

1	 ロックスイッチを上方向に押してから、Eマ
ウントレバーを時計方向に回してロックを解
除する。

2	 レンズを前方に引き抜く。

	 ［ご注意］
別のレンズをすぐに取り付けないときは、Eマウント
キャップの凹部を確実に合わせて、Eマウントレバー
を反時計方向に回して固定してください。
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CFexpress Type Bメモリーカードの取り扱い
本機では、「推奨記録メディアについて」に記載のソニー製CFexpress Type Bメモリーカード*をご使
用ください。
他社製メディアの動作については、各社メディアの取扱説明書やメーカー情報をご確認ください。
*	 本書ではCFexpressカードと表現しています。

［ご注意］
•	 2TB以上のサイズのCFexpress Type Bメモリーカードは使用できません。
•	 XQDメモリーカードは使用できません。

推奨記録メディアについて

動作保証条件はRec FormatやRecording設定によって異なります。
Yes：動作を保証
No：保証しない

記録フォーマット CFexpress Type B (exFAT)
非VPG VPG200 VPG400

XAVC H Intra HQ 8192x4320 No No Yes
7680x4320 No No Yes

XAVC H Intra SQ 8192x4320 No No Yes
7680x4320 No No Yes

XAVC H Long 7680x4320 No Yes Yes
XAVC Intra 4096x2160 No Yes Yes

3840x2160 No Yes1) Yes
1920x1080 No Yes1) Yes

XAVC Long 3840x2160 No Yes1) Yes
1920x1080 No Yes1) Yes

記録フォーマット CFexpress Type B (exFAT)
非VPG VPG200 VPG400

X-OCN (LT) 8.6K 17:9 No No Yes
8.6K 16:9 No No Yes
6K 17:9 No No Yes
6K 16:9 No No Yes
5.8K 17:9 No No Yes
5.8K 16:9 No No Yes
5.8K 6:5 No No Yes
4.3K 4:3 No No Yes
4K 17:9 No No Yes
3.8K 16:9 No No Yes
1.9K 16:9 No Yes Yes

1)	 スロー＆クイックモーションモードでは保証されません。

メモリーカードを入れる

1	 カードスロット部のメディア蓋を開ける。

2	 CFexpressカードをラベルを左にして差し
込む。

ラベル

アクセスランプ（4ページ）が赤く点灯し、
使用可能な状態になると緑で点灯します。

	 ［ご注意］
アクセスランプの赤い点滅が長く続き緑点灯にならな
い場合は、一度電源を切りメモリーカードを抜き差し
することで、緑点灯になる可能性があります。

3	 メディア蓋を閉める。

［ご注意］
•	 誤った向きで無理に入れると、メモリーカードやメモリー

カードスロット、画像データが破損することがあります。
•	 CFexpress Type BカードスロットA/B両方にメディア

を挿入して記録を行う際には、どちらのスロットにも、
記録するフォーマットに対して動作が推奨されているメ
ディアを挿入してください。
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メモリーカードを取り出す

カードスロット部のメディア蓋を開け、メモリー
カードを軽く1回押して取り出します。

［ご注意］
•	 メモリーカードにアクセス中に本機の電源を切ったりメ

モリーカードを抜いた場合はデータは保証されません。
カードに記録されたすべてのデータが壊れる可能性があ
ります。また、本機の動作に影響が出る場合があります。
電源を切ったり、カードを抜くときは、必ず使用するメ
モリーカードのアクセスランプが緑で点灯または消灯し
ていることを確認してから操作してください。

•	 記録終了後にメモリーカードを取り出した際、メモリー
カードが熱くなっている場合がありますが故障ではあり
ません。

メモリーカードをフォーマット
（初期化）する

フォーマットされていないメモリーカード、また
は別の仕様でフォーマットされたメモリーカード
を装着すると、メッセージ「フォーマットが必要な
メディアです」がLCDモニターに表示されます。
下記の手順に従ってフォーマットしてください。

1	 フルメニューのTC/Mediaメニューの
Format Media（55ページ）を選択する。

2	 Media（A）（スロットA）またはMedia（B）（ス
ロットB）を選択して、Full Formatを選択す
る。
確認メッセージが表示されます。

3	 Executeを選択する。
実行中はメッセージが表示され、アクセスラ
ンプが赤く点灯します。

フォーマットが終了すると、完了メッセージ
が表示されますので、マルチファンクション
ダイヤルを押して消します。

［ご注意］
•	 記録メディアの性能を最大限発揮するために、必ず本機

でフルフォーマットしてください。
•	 メモリーカードをフォーマットすると、記録された映像

データ、セットアップファイルなどを含む、すべてのデー
タが消去されます。

•	 フォーマットの処理時間によっては、実行中のメッセー
ジが表示されない場合があります。

フォーマットできなかったときは

本機で使用できないメモリーカードはフォーマッ
トできません。
警告メッセージが表示されますので、メッセージ
に従って、使用できるメモリーカードに交換して
ください。

本機でフォーマットしたメディアを他
の機器で使用するには

あらかじめバックアップを取り、お使いになる機
器でフォーマットし直して使用してください。

残りの記録可能時間を確認
する

撮影中（記録中／記録待機中）は、撮影画面また
はホーム画面（23ページ）のA/Bスロットメディ
ア残量表示部で、各スロットに装着したメモリー
カードの残量を確認することができます。
現在設定されている記録フォーマットで撮影した
場合に記録可能な時間を、それぞれのスロット内
のメディアの残量から計算して分単位で表示しま
す。

メモリーカードの交換時期

•	 記録中に2枚のメモリーカードの残記録可能時
間の合計が5分を切ると、警告メッセージ「メ
ディア残量がわずかです」（Media Near Full）
が表示され、記録／タリーランプの点滅とブ
ザー音（ヘッドホン出力）で警告します。 
空きのあるメディアに交換してください。

•	 記録を継続して、残記録可能時間の合計が0
になると、メッセージが「メディア残量がありま
せん」（Media Full）に変わり記録が停止しま
す。

［ご注意］
1枚のメモリーカードに約600個までのクリップを記録でき
ます。

メモリーカードを修復する

何らかの原因でメモリーカード内のデータに異常
が発生した場合は、メモリーカードの修復が必
要になります。
修復が必要なメモリーカードを挿入したときは、
修復を実行するかどうかを確認するメッセージが
LCDモニターに表示されます。

修復を実行する

マルチファンクションダイヤル（4ページ）で
Executeを選択し、マルチファンクションダイヤ
ルを押します。
実行中メッセージと進捗状況（％）が表示され、
アクセスランプが赤く点灯します。
修復が終了すると、完了メッセージが表示されま
す。

修復できなかったときは

•	 エラーが発生したメモリーカードは修復できま
せん。警告メッセージが表示されますので、メッ
セージに従って別のメモリーカードに交換して
ください。

•	 エラーが発生したメモリーカードは、フォーマッ
トをし直すと再利用できる場合があります。

•	 一部のクリップのみが修復できない場合もあり
ます。修復できたクリップは再生可能になりま
す。

［ご注意］
•	 本機で記録されたメディアは、本機で修復してください。
•	 本機以外で記録されたメディアや、本機と同一機種で

あってもバージョンが異なる機器で記録されたメディア
は、本機では修復できない場合があります。

•	 2秒以下のクリップは修復できません。
•	 修復を実施したメディアは性能を発揮できない可能性が

あります。必要なクリップをバックアップしたあと、フル
フォーマットをしてからお使いください。
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Utility SDカードの取り扱い
UTILITY SDカードは、プロキシ記録、設定内容
の保存・読み出しと、将来のバージョンアップ（ソ
フトウェアアップデート）時に使用します。

本機で使用可能なSDカード

SDXCメモリーカード*
SDHCメモリーカード*
SDメモリーカード*
*	 本書ではSDカードと表現しています。

［ご注意］
プロキシ記録使用時は、Speed Class10を推奨します。

SDカードを入れる

Utility SDカードスロット（4ページ）にSD
カードを差し込みます。
アクセスランプ（4ページ）が赤く点灯し、準
備が整うと消灯します。

アクセスランプによる状態表示

ランプ スロットの状態
赤で点灯 装着されているSDカードにアク

セス中（データの書き込み／読
み出し中）

SDカードを取り出す

SDカードを軽く1回押して取り出します。

［ご注意］
•	 メモリーカードにアクセス中に本機の電源を切ったりメ

モリーカードを抜いた場合はデータは保証されません。
カードに記録されたすべてのデータが壊れる可能性があ
ります。電源を切ったり、カードを抜くときは、必ず使
用するメモリーカードのアクセスランプが消灯しているこ
とを確認してから操作してください。

•	 出し入れ時にはメモリーカードの飛び出しにご注意くだ
さい。

SDカードをフォーマット（初期
化）する

本機で初めてSDカードを使用するときは、フォー
マットが必要です。
本機で使用するSDカードは、本機のフォーマッ
ト機能を使用してフォーマットしてください。SD
カードを装着したときに注意メッセージが表示さ
れた場合も、フォーマットして使用してください。
本機が対応していないフォーマットで初期化され
たSDカードを装着すると、ファイルシステムが異
なることを知らせるメッセージが表示されます。

1	 フルメニューのTC/Mediaメニューの
Format Media（55ページ）を選択する。

2	 Utility SDを選択して、フォーマット種別（Full 
FormatまたはQuick Format）を選択する。
確認メッセージが表示されます。
•	 Full Format：メディアのデータ管理情報

だけでなくデータ領域を含む全体を初期
化します。

•	 Quick Format：メディアのデータ管理情
報を初期化します。

3	 Executeを選択する。
実行中はメッセージが表示され、アクセスラ
ンプが赤く点灯します。
フォーマットが終了すると、完了メッセージ
が表示されますので、マルチファンクション
ダイヤルを押して消します。

［ご注意］
SDカードをフォーマットすると、すべてのデータが消去さ
れ、復元できません。

クイックフォーマットとフルフォーマッ
トの違い

フルフォーマットは、カードへの記録／読み出し
速度が遅くなったと感じるときや、データを完
全に消去するときなどに実行してください。フル
フォーマットは、メモリーカードの全領域を初期
化するため、クイックフォーマットより時間がか
かります。

本機でフォーマットしたメディアを他
の機器のスロットで使用するには

あらかじめバックアップを取り、お使いになる機
器でフォーマットし直して使用してください。
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LCDモニター画面構成
LCDモニターには、ホーム画面を中心に映像を確認しながら設定などを確認する映像監視モードと、各種情報や設定値等を確認・変更する情報表示モードの2つがあり、HOMEボタンによって切り替えること
ができます。また、それぞれのモードの中でステータス画面、フルメニュー画面、再生画面、クリップ一覧画面が表示されます。
HOMEボタン、MENUボタン、CLIPSボタンを操作してLCDモニターに表示される画面が下図のように遷移します。

映像監視モード

ステータス画面

再生画面
クリップ選択 

（再生）
クリップ選択 

（再生）

CLIPS 
ボタン

CLIPS 
ボタン

ステータス画面

再生操作画面

フルメニュー画面

クリップ一覧画面

HOMEボタン

撮影画面 ホーム画面

HOMEボタン

MENUボタン HOMEボタン MENUボタン

CLIPSボタン HOMEボタン CLIPSボタン

MENU 
ボタン

MENU 
ボタン

HOMEボタン

フルメニュー画面

クリップ一覧画面

情報表示モード

［メモ］
•	 映像監視モードでは、外部モニターにLCDモニターと同じ画面表示を出力させることができます。
•	 情報表示モードは、HDMI出力に外部モニターを接続してLCDモニターと併用するよう設計されています。外部モニターは映像の監視用に操作スイッチ面に配置し、LCDモニターは設定操作用として、撮影チーム体制に応じて操作スイッチ面または

端子面に配置してください。映像出力フォーマットがMonitor FHDの場合を除き、SDI出力に画面表示を重ねることはできません。
	‒ LCDモニターに表示された機能の操作は、LCDモニターのマルチセレクター、または操作スイッチ面のマルチファンクションダイヤルで行います。
	‒ 外部モニターに表示された機能の操作は、操作スイッチ面のマルチセレクターで行います。被写体認識枠の選択やフォーカスエリア、ピント拡大位置の移動ができます。

•	 X-OCNの場合、クリップ一覧画面に代表画像は表示されません。
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撮影画面・再生画面
映像監視モードのとき、撮影中（記録中／記録待機中）および再生中は、LCDモニターおよび外部モニ
ターの映像の周囲に本機の状態や設定が表示されます。
情報表示モードのときは外部モニターの映像に対して、撮影中および再生中に本機の状態や設定の一
部を重ねて表示できます。あらかじめMonitoringステータス（29ページ）のInfo DispをOnに設定
してください。
表示／非表示の切り替えは、DISPLAYボタンで行います。映像監視モードでは、非表示にした場合も、
ダイレクトメニュー（108ページ）の操作中は重ねて表示されます。
また、項目ごとに表示／非表示を選択することもできます（56ページ）。
*印が付いている項目は、情報表示モードのとき外部モニターに表示できない項目です。

撮影中の画面に表示される情報
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1.	 フォーカスモード表示（100ページ）
意味 表示
Focus Holdモード Focus Hold
MFモード MF
AFモード AF
リアルタイムトラッキング 
AFモード
被写体認識AF（AF/ /Only/ ）

人物検出アイコン

人物限定AFアイコン Only

意味 表示
AF一時停止アイコン1)

1)	 AF動作中にAF動作が継続できず、一時的にAF動作が
停止したときに表示されます。AF動作を停止する原因が
解消しAF動作が再開すると、非表示になります。

2.	 フォーカスポジション表示
フォーカスの位置が表示されます（フォーカス設
定表示対応レンズ装着時のみ）。

3.	 ネットワーク状態表示（25ページ）
ネットワーク接続の状態がアイコンで表示されま
す。

4.	アップロード中表示／転送ファイル残数表示
（84ページ）

5.	 記録モード／スロットA/B/動作状態表
示、インターバルレック記録間隔時間表示
（110ページ）

表示 意味
Rec 記録中
Stby 記録待機中

6.	 SDI出力／ HDMI出力のRec Control状態
表示（115ページ）

RECコントロール信号の出力状態を表示します。

7.	 バッテリー残量／DC IN電圧表示（14
ページ）

8.	被写界深度表示

9.	ルック名表示（94ページ）、High Key/
Low Key表示（112ページ）

選択したルックを表示します。
High Key（高輝度の白飛び確認画面）または
Low Key（低輝度の暗部の確認画面）が有効の場
合は、「High Key」または「Low Key」を表示しま
す。

10.	UWP-Dシリーズの状態表示（25ページ）
UWP-DシリーズをMIシュー搭載ハンドル（別売）
のMIシューにデジタルオーディオ伝送の設定で
接続したとき、電波強度を示すRFレベルなどが
アイコンで表示されます。

11.	 フォーカスエリア表示（97ページ）
オートフォーカスでフォーカスを合わせる領域が
表示されます。

12.	ガンマ表示アシスト表示*

Customモード（87ページ）のとき、ガンマ
表示アシストの状態を表示します。ガンマ表示
アシストの表示／非表示は、Gamma Display 
Assistが割り当てられたアサイナブルボタン

（108ページ）で切り替えることができます。

13.	映像信号モニター（111ページ）
ウェーブフォーム、ベクトルスコープ、ヒストグラ
ムを表示します。
オレンジの線はゼブラレベルの設定値を表しま
す。
Cine EIモード（87ページ）のときは、表示の
上にモニター対象としているSDI系統の色域など
を表示します。
•	 LUT On時は、適用されているLUTの種類に関

わらず、一律「Look」を表示します。
•	 High KeyまたはLow Keyが有効の場合は、
「High Key」または「Low Key」を表示します。

•	 LUT Off時は、Color Gamutの設定値を表示
します。

14.	映像レベル注意表示*

15.	クリップ名表示（55ページ）
記録中または次に記録するクリップの名前が表示
されます。
以下の場合は、クリップ名に下線がつきます。
•	 新しい記録メディアが挿入された場合
•	 記録メディアの最終クリップと、フルメニュー

のTC/Media > Clip Name Format（55
ページ）のCamera IDやReel Numberの設定
値が一致していない場合

16.	イメージャースキャンモード表示（87ペー
ジ）
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17.	 スロー＆クイックモーション撮像フレーム
レート表示（109ページ）

18.	記録フォーマット（フレームレート）/記録
フォーマット（コーデック）表示（44ページ）

メモリーカードに記録されるフォーマット名称を
表示します。

19.	記録ルック表示（94ページ）

20.	水準器表示
本機の水平方向の傾きが±1°刻みで±15°まで表
示されます。

21.	オーディオレベルメーター
CH1 ～ CH4のオーディオレベルを表示します。

22.	ホワイトバランスモード表示（104ページ）
表示 意味

自動モード

 Hold 自動モード一時停止

W:A メモリー Aモード
W:B メモリー Bモード
W:C メモリー Cモード
W:D メモリー Dモード
W:E メモリー Eモード
W:F メモリー Fモード
W:G メモリー Gモード
W:H メモリー Hモード

23.	シャッター表示（103ページ）
表示 意味

自動モード

24.	Base ISO／ Base Sensitivity表示（102
ページ）

Cine EIモード（87ページ）のときは、Mainス
テータスのBase ISO/Sensitivity、またはフル

メニューのShootingメニューのISO/Gain/EIの
Base ISOで設定されているBase ISO感度が表
示されます。
Customモード（87ページ）のときは、Main
ステータスのBase ISO/Sensitivity、またはフ
ルメニューのShootingメニューのISO/Gain/EI
のBase Sensitivityで設定されている基準感度
が表示されます。

25.	タイムコード外部ロック表示／タイムデータ
表示（89ページ）

他機のタイムコードにロックさせると「EXT-LK」と
表示されます。

26.	Exposure Index表示（102ページ）
Customモード（87ページ）のときは、ISO感
度またはゲインを表示します。

表示 意味
自動モード

一時調節モード
ボケ調節モード（112ページ）

27.	アイリス表示
アイリス値（T値またはF値）を表示します。（アイリ
ス設定表示対応レンズ装着時のみ）

表示 意味
自動モード

［ご注意］
T値が取得できない場合など、T値ではなくF値が表示され
る場合があります。

28.	NDフィルター表示（103ページ）
NDフィルターの濃度が表示されます。

表示 意味
自動モード

ボケ調節モード（112ページ）

29.	AEモード／AEレベル表示（51ページ）

30.	メディア状態表示
表示 意味

マウント処理中／マウント状態 
（メディアA）
マウント処理中／マウント状態 

（メディアB）
プロキシ記録が有効でマウント処理
中／マウント状態 

（Proxyメディア（SDカード））

（点滅）

プロキシ記録が有効で準備が整って
いない状態（メディア未挿入など）

（点滅）

プロキシ記録が停止している

メモリーカードがプロテクトされている場合は、
 マークが表示されます。

31.	手ブレ補正モード／手ブレ補正焦点距離表示
（105ページ）

表示 意味 PLマウント
アダプター

手ブレ補正ON（High） 装着

手ブレ補正ON（Low）

手ブレ補正OFF

手ブレ補正ON（Active） 非装着時

手ブレ補正ON（Standard）

手ブレ補正OFF

フルメニューのShootingメニュー > Image 
StabilizationのStabilization Adjustment

（43ページ）がManualのとき、手ブレ補正モー
ドアイコンの下に、手ブレ補正焦点距離を表示
します。

32.	ズームポジション表示（95ページ）
ズームの焦点距離を表示します。（ズーム設定表
示対応レンズ装着時のみ）
バー表示または数値表示に変えることもできます

（64ページ）。
数値表示は広角端が0で望遠端が99です。
全画素超解像ズームを有効にすると、以下の表
示が追加されます。
表示 意味

全画素超解像ズーム機能が有効

倍率数値 全画素超解像ズーム中

33.	リアルタイムトラッキングAF終了ボタン
（101ページ）
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再生中の画面に表示される情報

再生画像には、次のような情報が重ねて表示されます。

43

7

65

15

1314

9
10

21

8

11
12

004/004

1.	 クリップ番号／クリップ総数

2.	ネットワーク状態表示

3.	 アップロード中表示／転送ファイル残数表
示

4.	再生動作状態表示

5.	 ルック名表示

6.	バッテリー残量／DC IN電圧表示

7.	 X-OCN画像サイズ表示
X-OCN再生クリップの記録解像度とアスペクト比
を表示します。

8.	スロー＆クイックモーション撮像フレーム
レート表示

9.	再生フォーマット
再生クリップのフレームレートとコーデックを表
示します。XAVCの場合は、加えて画像サイズを
表示します。

10.	記録ルック表示

11.	 ガンマ表示アシスト*

12.	オーディオレベルメーター
再生オーディオレベルを表示します。

13.	タイムデータ表示

14.	クリップ名表示

15.	メディア残量表示
メモリーカードがプロテクトされている場合は、

 マークが表示されます。

アイコン表示について

ネットワーク接続のアイコン表示

ネットワークモード 接続状態 アイコン
アクセスポイントモード アクセスポイントとして動作中

アクセスポイント動作エラー

ステーションモード Wi-Fi接続済み
電波強度によりアイコンが変化（4段階）

   

Wi-Fi接続断（準備中含む）

Wi-Fi接続エラー

USBテザリング USBテザリング接続済み

USBテザリングリンク検出中

デバイス未接続USBテザリングエラー

有線LAN 有線LAN接続済み

有線LAN切断

有線LANエラー

UWP-Dシリーズのアイコン表示

送信機の状態 受信状態 アイコン
電源OFF 未受信

通常送信状態 受信中  ～  （受信レベル
を4段階で表示）

ミュート状態 受信中（ミュート中）

バッテリー残量警告状態 受信中  （アイコン点滅）

ミュート、かつバッテリー残量警告状態 受信中  （アイコン点滅）
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ホーム画面
HOMEボタンを押すとホーム画面が表示されます。ホーム画面では本機の状態の確認や基本的な項目
の設定ができます。

項目名／設定値／
機能表示部

ステータス
表示部

［ご注意］
•	 ホーム画面では、各機能のオート／マニュアルの切り替えはできません。ダイレクトメニュー（108ページ）またはフル

メニューのShootingメニューで設定してください。
•	 情報表示モードのとき、ダイレクトメニュー（108ページ）は使用できません。HOMEボタンで撮影画面へ切り替えてか

ら操作してください。

［メモ］
LCDモニターのアサイナブルボタン（108ページ）に以下を割り当てると、LCDモニター部の操作だけでホーム画面に表示
される項目の設定ができます。
•	 MENU
•	 IRIS（Eマウントレンズを使用する場合）

項目名／設定値／機能表示部

1 2 3

4 5 6

ITEMボタン4 ITEMボタン5 ITEMボタン6

ITEMボタン3ITEMボタン2ITEMボタン1

［ご注意］
1 ～ 6に表示される各項目はITEMボタン1 ～ 6にそれぞれ
対応しています。ITEMボタンを押すと、対応する項目の操
作ができます。

1.	 FPS
撮像フレームレートの表示／設定

2.	 Exposure Index/Base ISO
Exposure IndexおよびBase ISOの表示／設定

［メモ］
Customモードの場合はISO/Base Sensitivity、または
Gain/Base Sensitivityの表示／設定となります。

3.	 Shutter
電子シャッターの表示／設定

4.	ND Filter
NDフィルターの表示／設定

［ご注意］
VARIABLEモードの場合はNDフィルターをホーム画面で
設定できません。操作スイッチ面にあるNDフィルター用の
ボタン・ダイヤルで設定してください。

5.	 Look
ルックの表示／設定

［メモ］
CustomモードのときはSceneファイルの表示／設定とな
ります。

6.	WB（White Balance）
ホワイトバランスの表示／設定
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ステータス表示部

1 3 5

8 79

42

610
11

1.	 タイムデータ表示
フルメニューのTC/Mediaメニュー > TC Display
の設定に従って、デュレーション、ユーザービッ
トまたはタイムコードが表示されます（54ペー
ジ）。
タイムデータに現在表示しているデータの種類
は、次のように表示されます。

TCG：記録タイムコード 
EXT-LK併記：外部ロック中

UBG：記録ユーザービット
TCR：再生タイムコード
UBR：再生ユーザービット
Clk：クロック
Dur：デュレーション

2.	イメージャースキャンモード表示
Projectステータス > Imager Scanの設定値が
表示されます。

3.	 フレームレート表示
Projectステータス > Frequencyの設定値が表
示されます。

4.	記録フォーマット（コーデック）／画像解像
度表示

CFexpressカードに記録されるフォーマット名称
および画像解像度が表示されます。

5.	 電源電圧／バッテリー残量表示
電源電圧またはバッテリー残量が表示されます。

6.	音声レベルメーター
音声記録レベルまたは再生レベルが表示されま
す。「1」～「4」は音声チャンネル1 ～ 4を示します。

7.	 クリップ名表示
「Reel：Camera ID + Reel Number」と「Shot：
Camera Position + Shot Number」が表示さ
れます。

8.	メディア残量表示
各記録メディアの状態と残時間（現在の記録
フォーマットで記録できる時間）が表示されます。

9.	アイリス表示
アイリスの位置（T値またはF値）が表示されます。

10.	警告／エラーアイコン
警告またはエラーがあるときに表示されます。
メニューを表示させると、警告またはエラーの内
容が確認できます。外部モニターに画面表示を
重畳している場合は外部モニターでも確認できま
す。

11.	 記録動作状態表示
本機の記録動作状態が次のように表示されます。

表示 説明

　Stby 記録待機中

Rec 記録中

Cache ピクチャーキャッシュレック記録
待機中

ホーム画面の基本操作

1	 HOMEボタンを押す。
ホーム画面が表示されます。

2	 ITEMボタン1 ～ 6で設定したい項目を選ぶ。
下図はITEMボタン3を押した場合の表示例
です。

3	 ボタン（ITEMボタン1）、ボタン（ITEMボタ
ン4）で、選択項目または設定値にカーソル
を合わせる。

4	 Setボタン（ITEMボタン3）を押して決定する。

［メモ］
LCDモニター部のマルチセレクター、または操作スイッチ面
のマルチファンクションダイヤルでも操作できます。最初に
押し込んでカーソルを表示させてから操作してください。
また、タッチ操作も可能です。
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ホーム画面設定項目一覧

各項目で設定できる内容は次のとおりです。フルメニューに同じ設定がある項目については、フルメ
ニューをあわせて参照してください（32ページ）。

項目 内容
FPS 撮像フレームレートをシステム周波数に固定するか、システム周波数と異なる

値にするかを設定する。
•	 Fixed 

設定画面で「Fixed」を選択すると、撮像フレームレートをシステム周波数に
合わせて「Fixed」とシステム周波数を表示します。

•	 Variable 
設定画面で「Variable」を選択すると、撮像フレームレートをシステム周波数
と異なる値に設定できます。 
1 ～ 60 / 66 / 72 / 75 / 88 / 90 / 96 / 100 / 110 / 120 / 150 / 180 / 
200 / 240 fps

［ご注意］
設定値の範囲は、選択されているシステム周波数やコーデック、ビデオフォーマットによっ
て異なります。  

［メモ］
この設定は、Projectステータス > Rec FunctionのS&Q Motionと、フルメニューの
Shootingメニュー > S&Q Motionに相当します。

Exposure Index/Base 
ISO

（Cine EIモード時）

Exposure Index（38ページ）を設定する。
Base ISOを押すとBase ISO（38ページ）を設定できます。

［メモ］
Exposure IndexはフルメニューのShootingメニュー > ISO/Gain/EIのExposure 
Index、Base ISOはフルメニューのShootingメニュー > ISO/Gain/EIのBase ISOに相
当します。

ISO/Gain / Base 
Sensitivity

（Customモード時）

ゲイン（38ページ）を設定する。
Base Sensitivityを押すと基準感度（38ページ）を設定できます。

［メモ］
ISO/GainはフルメニューのShootingメニュー > ISO/Gain/EIのISOまたはGain、Base 
SensitivityはフルメニューのShootingメニュー > ISO/Gain/EIのBase Sensitivityに相
当します。

項目 内容
Shutter 電子シャッター（39ページ）を設定する。

AngleまたはECSを押すと、それぞれ開角度または周波数による設定に切り替
わります。

［メモ］
•	 AngleはフルメニューのShootingメニュー > ShutterのShutter Angle、ECSはフル

メニューのShootingメニュー > ShutterのECS On/Off、ECS Frequencyに相当しま
す。

•	 フルメニューのShootingメニュー > ShutterのModeをSpeedに設定すると、開角度
の代わりに時間で設定できます。

ND Filter NDフィルターのポジションを設定する。ND STEP/VARIABLEスイッチがSTEP
のときのみ有効です。

Look
（Cine EIモード時）

ルック（51ページ）を設定する。Edit Lookボタン（ITEMボタン4）を押してルッ
クを選択します。ITEMボタン1、5、6で各出力系統にルックを適用するかどう
かを設定します。状態により、設定不可または設定が連動となる組み合わせが
あります。

［メモ］
この設定は、Monitoringステータスの一部、およびフルメニューのPaint/Lookメニュー 
> Base LookのSelectと、フルメニューのShootingメニュー > LUT On/Off以下の各項
目に相当します。

Scene File
（Customモード時）

あらかじめ用意された画質設定を切り替える。
プリインストールされた画質設定のほか、お好みの画質設定を保存（51ペー
ジ）して切り替えることができます。

［メモ］
この設定は、フルメニューのPaint/Lookメニュー > Scene FileのRecallに相当します。

WB（White Balance） ホワイトバランスを設定する（41ページ）。
A/B/C/D/E/F/G/H、8つのホワイトメモリーポジションが用意されています。
それぞれ次の方法で値を設定できます。
•	 色温度・Tint値をそれぞれ設定
•	 オートホワイトバランスで自動設定
•	 特定のプリセット値を選択

［メモ］
この設定は、フルメニューのShootingメニュー > White以下の各項目に相当します。
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ステータス画面
ステータス画面では、本機の設定や状態を確認
することができます。また、*印が付いている項
目については設定を変更できます。
ステータス画面はタッチ操作に対応しています。

ステータス画面を表示させるには
•	 MENU（メニュー）ボタンを押す

［メモ］
TechnicalメニューのMenu Page On/Off（63ページ）
で、各ステータス画面の表示／非表示を切り替えることが
できます。

ステータス画面を切り替えるには
•	 マルチファンクションダイヤルを回す
•	 マルチセレクターを上下に操作する
•	 ステータス画面を上下にスワイプする

［ご注意］
LCDモニターが情報表示モードのときは、操作スイッチ面
やリモコンのマルチセレクターでは操作できません。

ステータス画面を消すには
•	 MENU（メニュー）ボタンを押す

設定を変更するには
ステータス画面の表示中にマルチファンクション
ダイヤルやマルチセレクターを押すと、ページ内
の設定項目を選べるようになります。ページ番号
を選んで押すと、ページ切り替えに戻ります。
なお、タッチ操作で直接選ぶこともできます。

［ご注意］
フルメニューのTechnicalメニュー >Menu Settingsの
User Menu Only（63ページ）をOnにすると、ステータ
ス画面で設定変更できなくなります。

プロジェクトステータス画面

撮影プロジェクトに関する基本的な設定を表示
します。

表示項目 説明
Frequency/
Scan*

システム周波数と走査方式の
設定

Codec* 記録するコーデックの設定
Rec Function* 特殊な記録機能のOn/Offと

主な設定
Simul Rec* 2スロット同時記録機能の

On/Off状態と設定
Reel* クリップ名のCamera IDと

Reel Numberの設定値
Imager Scan* イメージセンサーの読み出し

モード
Video Format* メモリーカードに記録する画

サイズ
Picture Cache 
Rec*

ピクチャーキャッシュレック機
能のOn/Offとキャッシュサイ
ズの設定

Shot* クリップ名のCamera 
Positionの設定値と、次
または現在記録中のShot 
Numberの値

Shooting 
Mode*

撮影モードの設定

Proxy Rec* プロキシ記録のOn/Offの設
定

Genlock ゲンロックの状態

オーディオステータス画面

各チャンネルの入力設定、オーディオレベルメー
ターと音声モニターの設定を表示します。

表示項目 説明
CH1 Level 

Control
自動調節のOn/Off状態

Level 
Meter

オーディオレベルメーター

Source* 入力ソース
Reference* 入力リファレンスレベル
Wind 
Filter*

マイクの風音低減フィルター
の設定

CH2 Level 
Control

自動調節のOn/Off状態

Level 
Meter

オーディオレベルメーター

Source* 入力ソース
Reference* 入力リファレンスレベル
Wind 
Filter*

マイクの風音低減フィルター
の設定

CH3 Level 
Control*

自動調節のOn/Off状態

Level 
Meter*

オーディオレベルメーター

Source* 入力ソース
Reference* 入力リファレンスレベル
Wind 
Filter*

マイクの風音低減フィルター
の設定

CH4 Level 
Control*

自動調節のOn/Off状態

Level 
Meter*

オーディオレベルメーター

Source* 入力ソース
Reference* 入力リファレンスレベル
Wind 
Filter*

マイクの風音低減フィルター
の設定

表示項目 説明
Audio Input 
Level*

音声入力レベル（マスターボ
リューム）の設定

HDMI Output 
CH*

HDMIに出力される音声チャ
ンネルの設定

Volume* ヘッドホン／内蔵スピーカーの
音量の設定

Monitor CH* モニターするチャンネルの設
定

モニタリングステータス画面

SDI、HDMI出力の設定を表示します。

表示項目 説明
SDI1 Signal* 出力画サイズ

Info. 
Disp.*

画面表示出力On/Off

Gamut/
Gamma*

モニター LUTの適用状態／
色域の設定値

SDI2 Signal* 出力画サイズ
Info. 
Disp.*

画面表示出力On/Off

Gamut/
Gamma*

モニター LUTの適用状態／
色域の設定値

HDMI Signal* 出力画サイズ
Info. 
Disp.*

画面表示出力On/Off

Gamut/
Gamma*

モニター LUTの適用状態／
色域の設定値

LCD/
Stream

Gamut/
Gamma*

モニター LUTの適用状態／
色域の設定値

Base Look/LUT* Base Look/LUTの設定
Gamma Display 
Assist*

Gamma Display Assistの
On/Off状態

［メモ］
Customモードのとき、Gamut/Gammaの代わりにColor 
Gamutを表示します。
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アサイナブルボタンステータス画面

各アサイナブルボタンに割り当てた機能を表示し
ます。

表示項目 説明
1 ASSIGN 1ボタンに割り当てら

れている機能
2 ASSIGN 2ボタンに割り当てら

れている機能
3 ASSIGN 3ボタンに割り当てら

れている機能
4 ASSIGN 4ボタンに割り当てら

れている機能
5 ASSIGN 5ボタンに割り当てら

れている機能
6 ASSIGN 6ボタンに割り当てら

れている機能
7 ASSIGN 7ボタンに割り当てら

れている機能
8 ASSIGN 8ボタンに割り当てら

れている機能
9 ASSIGN 9ボタンに割り当てら

れている機能
10 ASSIGN 10ボタンに割り当て

られている機能
11 ASSIGN 11ボタンに割り当て

られている機能
Focus Hold 
Button

レンズのFocus Holdボタンに
割り当てられている機能

Multi Function 
Dial

マルチファンクションダイヤル
に割り当てられている機能

Grip Dial グリップアサイナブルダイヤル1)

に割り当てられている機能

1)	 グリップリモコンは別売です。

インフォメーション画面

イメージセンサー温度と電源の情報を表示します。

表示項目 説明
Detected 
Battery

バッテリーの種類

Battery 
Voltage / 
Charge Count

バッテリー電圧（V）/充電を
行った回数

Power Source / 
Supplied 
Voltage

電源供給源/供給電源電圧

Video Light 
Battery 
Remaining

ビデオライトバッテリー残量
表示

Imager 
Temperature

イメージセンサー温度（℃）

Battery 
Remaining / 
Capacity

残容量（％）/残容量（Ah）

Battery 
Manufacture 
Date

バッテリーの製造年月日

メディアステータス画面

記録メディアの残量および残記録可能時間を表
示します。

表示項目 説明
メディアAのメディ
ア情報

スロットAにメディアが挿入さ
れているとき、メディアアイコ
ンを表示する

メディアAの残量
メーター

スロットAに挿入されている記
録メディアの残容量を、残比
率で表したバーで表示する

メディアAの残時
間

現在と同じ状態でスロットA
に挿入されている記録メディ
アに記録したときの予測残時
間を分単位で表示する

表示項目 説明
Format 
Media(A)*

フォーマット種別（Full 
Format）を選択して、メディ
アAを初期化する

メディアBのメディ
ア情報

スロットBにメディアが挿入さ
れているとき、メディアアイコ
ンを表示する

メディアBの残量
メーター

スロットBに挿入されている記
録メディアの残容量を、残比
率で表したバーで表示する

メディアBの残時
間

現在と同じ状態でスロットBに
挿入されている記録メディア
に記録したときの予測残時間
を分単位で表示する

Format 
Media(B)*

フォーマット種別（Full 
Format）を選択して、メディ
アBを初期化する

Utility SDカード
のメディア情報

Utility SDカードスロットにメ
ディアが挿入されているとき、
メディアアイコンを表示する

Utility SDカード
のプロテクト情報

Utility SDカードスロットに
挿入されている記録メディア
がプロテクトされているとき、
Protectアイコンを表示する

Utility SDカード
の残量メーター

Utility SDカードスロットに挿
入されている記録メディアの
残容量を、残比率で表したバー
で表示する

Utility SDカード
の残容量

Utility SDカードスロットに挿
入されている記録メディアに
プロキシ記録したときの予測
残時間を分単位で表示。また
は残容量を単位GBで表示す
る

Format Utility 
SD*

フォーマット種別（Full 
FormatまたはQuick 
Format）を選択して、SDカー
ドを初期化する

ネットワークステータス画面

ネットワーク接続の接続状態を表示します。

表示項目 説明
Wireless LAN* ワイヤレスネットワークの設

定、接続状態
Wired LAN* 有線LANネットワークの設定、

接続状態
USB Tethering* USBテザリングによるネット

ワークの設定、接続状態

ファイル転送ステータス画面

ファイル転送の情報を表示します。

表示項目 説明
Auto Upload オリジナルクリップの自動転

送のOn/Off状態
Auto Upload 
(Proxy)

プロキシクリップの自動転送
のOn/Off状態

Total Transfer 
Progress

総ジョブの転送進捗状況

Default Upload 
Server

クリップ自動転送の転送先
サーバー名

Job Status 
(Remain / Total)

総ジョブ数と残りのジョブ数

Current File 
Transfer 
Progress

転送中ファイルの転送進捗状
況

Current 
Transferring File 
Name

転送中のファイル名

Server Address ファイル転送先サーバーのア
ドレス

Destination 
Directory

ファイル転送先サーバーの転
送先ディレクトリー
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タッチ操作対応設定画面の使いかた

画面構成
設定項目

直前の設定値
を示す印

Set（決定） 
ボタン

設定値選択
カーソル 

（橙色枠）

設定項目名

設定値の選択肢

操作方法

1	 設定項目をタップする。

タップ
設定値の選択肢が表示されます。

2	 設定値をドラッグまたはフリックして選択す
る。

フリック

3	 Setボタンまたは設定値選択カーソルをタッ
プする。
設定値を確定し元の画面に戻ります。

［メモ］
•	 BACKボタンを押すと直前の設定値に戻ります。
•	 マルチファンクションダイヤルやマルチセレクターでも操

作できます。
•	 タッチ操作を無効にすることもできます（62ページ）。
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フルメニューの構成と階層
MENUボタンを長押しすると、撮影や再生に必
要な各種設定を行うフルメニューがLCDモニター
に表示されます。下記のメニューから選択して設
定します。

メニュー構成

Userメニュー
任意の設定を集めたメニュー 
Edit User Menuから編集できます。

Edit Userメニュー
Userメニューの編集に関する設定

Shootingメニュー
撮影に関する設定

Projectメニュー
プロジェクトの基本的な設定

Paint/Lookメニュー
画質に関する設定

TC/Mediaメニュー
タイムコードと記録メディアに関する設定

Monitoringメニュー
ビデオ出力やビューファインダー出力に関す
る設定

Audioメニュー
音声に関する設定

Clip Operationsメニュー
クリップ操作に関する設定

Technicalメニュー
技術的な内容の設定

Networkメニュー
ネットワークに関する設定

Maintenanceメニュー
時計や言語設定などの機器設定

フルメニューの階層

User 
（工場出荷時の設
定）

Focus
Auto Exposure
Noise Suppression
Image Stabilization
Rec Format
Assignable Button
Multi Function Dial
All File
User File
Base Look
Clip Name Format
Format Media
De-Squeeze
Marker
LCD Monitor Setting
Peaking
Zebra
Menu Settings
Lens
APR

Edit User Menu Add Item
Customize Reset

Shooting ISO/Gain/EI
ND Filter
Shutter
Iris
Auto Exposure
White
White Setting
Focus
S&Q Motion
LUT On/Off
Noise Suppression
Flicker Reduce
Image Stabilization

Project Base Setting
Rec Format
Cine EI Setting
HDR Setting
Simul Rec
Proxy Rec
Interval Rec
Picture Cache Rec
SDI/HDMI Rec Control
Assignable Button
Assignable Dial
Multi Function Dial
User File
All File

Paint/Look Scene File
Base Look
Reset Paint Settings
Black
Knee
Detail
Matrix
Multi Matrix

TC/Media Timecode
TC Display
Users Bit
HDMI TC Out
Clip Name Format
Update Media
Format Media

Monitoring Output Format
De-Squeeze
Output Display
Display On/Off
Marker
LCD Monitor Setting
Gamma Display Assist
Peaking
Zebra
Focus Magnifier

Audio Audio Input
Audio Output

Clip Operations Display Clip Properties
Set Clip Flag
Lock/Unlock Clip
Transfer Clip
Transfer Clip (Proxy)
Filter Clips
Customize View
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Technical Color Bars
ND Dial
Rec/Tally
LOCK Switch Settings
Touch Operation
Rec Review
Zoom
Handle Zoom
Menu Settings
Menu Page On/Off
RCP
Fan Control
Lens
Video Light Set
APR
Camera Battery Alarm
Camera DC IN Alarm

Network Network Setup
Wireless LAN
AP Mode Settings
ST Mode Settings
Wired LAN
USB Tethering
File Transfer
Network Reset

Maintenance Language
Clock Set
All Reset
Hours Meter
Version
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フルメニューの操作方法
MENUボタンを長押しすると、詳細な設定を行う
フルメニューがLCDモニターに表示されます（映
像監視モードのときは外部HDMIモニターに表示
させることもできます）。

メニュー操作部

MENUボタン（4ページ）
長押しするとフルメニューを表示します。フ
ルメニューの表示中に押すと非表示にしま
す。

マルチセレクター（8方向＋決定）（5ページ）
8方向ボタンを押すと、カーソルが上下左右
に移動して、メニュー項目や設定値を選択
できます。
マルチセレクターの決定ボタンを押すと、選
択している項目を決定します。

マルチファンクションダイヤル（4ページ）
マルチファンクションダイヤルを回すとカーソ
ルが上下に移動して、メニュー項目や設定値
を選択できます。
マルチファンクションダイヤルを押すと、選
択している項目を決定します。

BACKボタン（4ページ）
1つ前の階層に戻ります。確定前の変更はキャ
ンセルされます。

［ご注意］
•	 ピント拡大（96ページ）になっていると、フルメニュー

は操作できません。
•	 メニューを表示させたときの状態によって選択できない

項目があります。
•	 LCDモニターが情報表示モードのときは、操作スイッチ

面やリモコンのマルチセレクターでは操作できません。

メニューを設定する

8方向ボタンを押すか、またはマルチファンクショ
ンダイヤルを回して設定したい項目にカーソルを
合わせ、決定ボタンまたはマルチファンクション
ダイヤルを押して決定します。
•	 選択項目が表示される選択肢エリアは最大8

行表示です。選択肢が一度に表示できない場
合は、カーソルを上下に移動すると表示がスク
ロールします。

•	 選択肢の範囲が大きい項目の場合 
（例：－99 ～ +99）は、選択肢エリアは表示
されません。文字がハイライト表示になり設定
変更が可能な状態であることを示します。

•	 実行項目でExecuteを選択した場合は、対応
する機能が実行されます。

•	 実行前に確認が必要な項目を選択すると、一
旦メニューが消え、確認メッセージが表示され
ます。メッセージに従って、実行するかキャン
セルするかを選択してください。

文字列を入力する

ファイル名など、文字列を設定する項目を選択し
た場合は、文字列の入力画面が表示されます。

1

2 3

1	 8方向ボタンを押すか、またはマルチファン
クションダイヤルを回して入力したい文字タ
イプを選択し、決定する。
ABC：英大文字
abc：英小文字
123：数字
!#$：特殊文字

2	 選んだ文字タイプから文字を選択し、決定
する。
カーソルが次の欄に移動します。
Space：カーソルの位置にスペースを入力し

ます。
/：カーソル位置を移動します。
BS：カーソルの左の文字を削除します。

3	 入力が終わったら、Doneを選択し、決定す
る。
文字列を確定して、入力画面が消えます。

メニューのロックと解除

フルメニューの表示をロックして、Userメニュー
だけを表示させることができます。
ホーム画面およびステータス画面では設定変更
できなくなります。

メニューをロックする

1	 マルチファンクションダイヤルを押しながら
MENUボタンを長押しする。

2	 TechnicalメニューのMenu Settingsの
User Menu with Lockを選択する。

	 ［ご注意］
MENUボタンのみを長押しして通常のフルメニュー
を表示した場合、TechnicalメニューのMenu 
SettingsにはUser Menu Onlyが表示されますが、
マルチファンクションダイヤルを押しながらMENUボ
タンを長押しすると、User Menu with Lockが表示
されます。

3	 Onを選択して決定ボタンまたはマルチファ
ンクションダイヤルを押す。
LCDモニターの表示が、暗証番号入力画面
に切り替わります。

4	 任意の番号を入力する。
0000 ～ 9999の4桁の数値が入力できま
す。初期値は0000となっています。
数値を入力し、決定ボタンまたはマルチファ
ンクションダイヤルを押すと、カーソルが次
の桁に移動します。
すべての桁を入力したら、カーソルがSETに
移動します。
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5	 決定ボタンまたはマルチファンクションダイ
ヤルを押す。
入力が確定します。
設定が完了したメッセージが表示され、
Userメニュー表示に切り替わります。

メニューのロックを解除する

1	 マルチファンクションダイヤルを押しながら
MENUボタンを長押しする。

2	 UserメニューのMenu SettingsのUser 
Menu with Lockを選択する。

	 ［ご注意］
MENUボタンのみを長押しして通常のフルメニュー
を表示した場合、TechnicalメニューのMenu 
SettingsにはUser Menu Onlyが表示されますが、
マルチファンクションダイヤルを押しながらMENUボ
タンを長押しすると、User Menu with Lockが表示
されます。

3	 Offを選択して決定ボタンまたはマルチファ
ンクションダイヤルを押す。
LCDモニターの表示が、暗証番号入力画面
に切り替わります。

4	 メニューをロックしたときの番号を入力す
る。
数値を入力し、決定ボタンまたはマルチファ
ンクションダイヤルを押すと、カーソルが次
の桁に移動します。
すべての桁を入力したら、カーソルがSetに
移動します。

5	 決定ボタンまたはマルチファンクションダイ
ヤルを押す。
入力が確定します。
メニューをロックしたときの暗証番号と入力
した番号が一致した場合、ロックが解除で
きたことのメニュー表示に切り替わります。

［ご注意］
•	 メニューをロックしたときの暗証番号と入力した番号が

不一致の場合は、ロックを解除できません。
•	 暗証番号は、忘れたときのため、手元に記録を残すこと

をお勧めします。忘れたときはソニーのサービス窓口に
お問い合わせください。

•	 下表のフルメニューのメニュー項目をUserメニューに登
録せずにメニューをロックした場合、同機能をアサイナ
ブルボタンに設定することはできません。

•	 下表の機能をアサイナブルボタンにアサインしていた場
合は、メニューをロックした時点でアサイナブルの設定
が強制的にOffになります。

フルメニューのメニュー
項目

アサイナブルボタン
の選択肢

Shooting>ISO/Gain/
EI>Base Sensitivity、
Shooting>ISO/Gain/
EI>Base ISO

Base ISO/
Sensitivity

Shooting>Auto 
Exposure>AGC

AGC

Shooting>Auto 
Exposure>Auto ND 
Filter

Auto ND Filter

Shooting>Auto 
Exposure>Auto Iris

Auto Iris

Shooting>Iris>Bokeh 
Control

Bokeh Control

Shooting>Auto 
Exposure>Auto 
Shutter

Auto Shutter

Shooting>Auto 
Exposure>Level

Auto Exposure 
Level

Shooting>Auto 
Exposure>Mode

Backlight

フルメニューのメニュー
項目

アサイナブルボタン
の選択肢

Shooting>Auto 
Exposure>Mode

Spotlight

Shooting>White> 
Auto White Balance

Auto White 
Balance

Shooting>White> 
ATW

ATW

Shooting>Focus> 
AF Transition Speed、
Shooting>Focus> 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting>Focus> 
Subject Recognition 
AF

Subject 
Recognition AF

Monitoring>Focus 
Magnifier>Focus Mag 
Button Target

LCD Focus 
Magnifier

Monitoring>Focus 
Magnifier>Focus Mag 
Button Target

Output Focus 
Magnifier

Shooting>S&Q 
Motion>Setting

S&Q Motion

Shooting>LUT On/
Off>SDI/HDMI、
Shooting>LUT On/
Off>SDI

LUT On/Off

Shooting>LUT 
On/Off>LCD/
Proxy/Stream、
Shooting>LUT On/
Off>LCD/HDMI/
Px/Stream

LUT On/Off

Monitoring>Display 
On/Off>Image 
Stabilization

Image 
Stabilization

Project>Rec 
Format>Imager Scan 
Mode

Crop Select

Project>Picture 
Cache Rec>Setting

Picture Cache Rec

フルメニューのメニュー
項目

アサイナブルボタン
の選択肢

Technical>Rec 
Review>Setting

Rec Review

Clip Operations>Set 
Clip Flag>Add OK

Clip Flag OK

Clip Operations>Set 
Clip Flag>Add NG

Clip Flag NG

Clip Operations>Set 
Clip Flag>Add KEEP

Clip Flag Keep

Technical>Color 
Bars>Setting

Color Bars

TC/Media>TC 
Display>Display 
Select

DURATION/TC/
U-BIT

Monitoring>Display 
On/Off>Lens Info

Lens Info

Monitoring>Display 
On/Off>Video Signal 
Monitor

Video Signal 
Monitor

Monitoring> 
Marker>Setting

Marker

Monitoring>LCD 
Monitor 
Setting>Color Mode

LCD Monitor Mode

Monitoring>Gamma 
Display 
Assist>Setting

Gamma Display 
Assist

Monitoring> 
Peaking>Setting

Peaking

Monitoring> 
Zebra>Setting

Zebra

Audio>Audio 
Output>Volume

Volume

Technical>Touch 
Operation>Setting

Touch Operation

Technical>Handle 
Zoom>Setting

Handle Zoom

Network>File 
Transfer>Auto 
Upload (Proxy)

Auto Upload 
(Proxy)
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Userメニュー
工場出荷時のメニュー項目および対応する機能は以下のとおりです。

User
メニュー項目 内容
Focus Shooting > Focusの内容。
Auto Exposure Shooting > Auto Exposureの内容。
Noise Suppression Shooting > Noise Suppressionの内容。
Image Stabilization Shooting > Image Stabilizationの内容。
Rec Format Project > Rec Formatの内容。
Assignable Button Project > Assignable Buttonの内容。
Multi Function Dial Project > Multi Function Dialの内容。
All File Project > All Fileの内容。
User File Project > User Fileの内容。
Base Look Paint/Look > Base Lookの内容。
Clip Name Format TC/Media > Clip Name Formatの内容。
Format Media TC/Media > Format Mediaの内容。
De-Squeeze Monitoring > De-Squeezeの内容。
Marker Monitoring > Markerの内容。
LCD Monitor Setting Monitoring > LCD Monitor Settingの内容。
Peaking Monitoring > Peakingの内容。
Zebra Monitoring > Zebraの内容。
Menu Settings Technical > Menu Settingsの内容。
Lens Technical > Lensの内容。
APR Technical > APRの内容。

［ご注意］

UserメニューはEdit Userメニューによってメニュー項目の追加や削除ができます。設定できる項目数は20が上限です。



37 3章　カメラ操作

Edit Userメニュー
UserメニューでEdit User Menuを選択すると、Edit Userメニューが第1階層に表示されます。

Edit User
メニュー項目 細目と設定値 内容
Add Item
Userメニュー項目の追加

Userメニューに第2階層の項目を追加
する。

Customize Reset
Userメニュー項目のリ
セット

Userメニューの登録項目を工場出荷
時の状態に戻す。

編集中に選択した第2階
層の項目

Delete Userメニューに登録した第2階層の項
目を削除する。

Move Userメニューに登録した項目を並べ替
える。

Edit Sub Item Userメニューに登録した第3階層の項
目に属する細目を編集（登録・削除）す
る。
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Shootingメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
Mode ISO / dB ゲイン設定モードを選択する。
ISO/Gain ゲインを設定する。

Customモード時のみ有効です。
ModeがISOのとき

Base LookのSelect S-Cinetone / Standard / 
Still / ITU709 / 709tone

左記以外

Base Sensitivity Low High Low High
ISO/Gain ISO 320 ISO 1250 ISO 800 ISO 3200

ISO 400 ISO 1600 ISO 1000 ISO 4000
ISO 500 ISO 2000 ISO 1250 ISO 5000
ISO 640 ISO 2500 ISO 1600 ISO 6400
ISO 800 ISO 3200 ISO 2000 ISO 8000
ISO 1000 ISO 4000 ISO 2500 ISO 10000
ISO 1250 ISO 5000 ISO 3200 ISO 12800
ISO 1600 ISO 6400 ISO 4000 ISO 16000
ISO 2000 ISO 8000 ISO 5000 ISO 20000
ISO 2500 ISO 10000 ISO 6400 ISO 25600

ModeがdBのとき 
-3dB ～ 0dB～ 18dB（1dB間隔）

Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
Exposure 
Index

Base ISOがISO 800のとき
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Base ISOがISO 3200のとき
800EI / 4.0E
1000EI / 4.3E
1250EI / 4.7E
1600EI / 5.0E
2000EI / 5.3E
2500EI / 5.7E
3200EI / 6.0E
4000EI / 6.3E
5000EI / 6.7E
6400EI / 7.0E
8000EI / 7.3E
10000EI / 7.7E
12800EI / 8.0E

Exposure Indexを設定する。
Cine EIモード時のみ有効です。

Shockless 
Gain

On / Off ショックレスゲイン機能をOn/Offする。

Base 
Sensitivity

High / Low Customモード用の基準感度を設定する。

Base ISO ISO 3200 / ISO 800 Cine EIモード用の基準ISO感度を設定す
る。
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Shooting>ND Filter
NDフィルター透過光量の表現形式を設定します。

メニュー項目 細目と設定値 内容
Display 
Mode

Optical Density / Transmittance NDフィルター透過光量の表現形式を設定
する。選択した表現形式で、表示および制
御を実行する。
Optical Density: 

NDフィルター透過光量を光学濃度（対
数表記）で表示および制御を行う。

Transmittance: 
NDフィルター透過光量を透過率（分数
表示）で表示および制御を行う。

Shooting>Shutter
電子シャッターの動作を設定します。

メニュー項目 細目と設定値 内容
Mode Speed / Angle 電子シャッターのモードを選択する。

秒数でシャッター速度を設定するSpeed
（スピード）モードと開角度でシャッター速
度を設定するAngle（角度）モードを選択す
る。

Shutter 
Speed  
On/Off

On / Off Speedモード選択時の露光時間を、
Shutter Speedの設定値に従うかフル露光
にするかを設定する。

Shooting>Shutter
電子シャッターの動作を設定します。

メニュー項目 細目と設定値 内容
Shutter 
Speed

64F ～ 1/8000
設定値は、選択されている記録フォーマット
のシステム周波数によって異なります。
59.94P： 

64F / 32F / 16F / 8F / 7F / 6F / 5F /  
4F / 3F / 2F / 1.2F(1/50) / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 
1/500 / 1/1000 / 1/2000 / 1/4000 / 
1/8000

50P： 
64F / 32F / 16F / 8F / 7F / 6F / 5F /  
4F / 3F / 2F / 1/50 / 1/60 / 1/100 /  
1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

29.97P： 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 
4F / 3F / 2F / 1/30 / 1/40 / 1/50 / 
1/60 / 1/100 / 1/120 / 1/125 /  
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

25P： 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 
4F / 3F / 2F / 1/25 / 1/33 / 1/50 / 
1/60 / 1/100 / 1/120 / 1/125 /  
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

24P/23.98P： 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 
4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 
1/50 / 1/60 / 1/96 / 1/100 / 1/120 /  
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

Speedモード選択時、シャッタースピード
を設定する。

Shutter 
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /  
3F / 2F / 360.0° / 300.0° / 270.0° /  
240.0° / 216.0° / 210.0° / 180.0° /  
172.8° / 150.0° / 144.0° / 120.0° /  
90.0° / 86.4° / 72.0° / 45.0° / 30.0° / 
22.5° / 11.25° / 5.6°

Angleモード 選択時、開角度を設定する。

ECS On/Off On / Off Extended Clear Scanの設定をOn/Offす
る。
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Shooting>Shutter
電子シャッターの動作を設定します。

メニュー項目 細目と設定値 内容
ECS 
Frequency

23.99 ～ 8000
設定値は、選択されている記録フォーマット
のシステム周波数によって異なります。
初期値は以下のとおりです。
59.94P：60.00
50P：50.00
29.97P：30.00
23.98P：23.99
25P：25.02
24P：24.02

ECSモード 選択時、ECS周波数を設定する。

Shooting>Iris
ボケ調節機能の設定を行います。

メニュー項目 細目と設定値 内容
Bokeh 
Control

On / Off ボケ調節機能をOn/Offする。

Shooting>Auto Exposure
自動露出調整の設定を行います。

メニュー項目 細目と設定値 内容
Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 /  

+1.75 / +1.5 / +1.25 / +1.0 / +0.75 /  
+0.5 / +0.25 / ±0 / –0.25 / –0.5 /  
–0.75 / –1.0 / –1.25 / –1.5 / –1.75 /  
–2.0 / –2.25 / –2.5 / –2.75 / –3.0

自動検出した露出に対する明暗レベルを設
定する。

Mode Backlight / Standard / Spotlight 自動露出調整の動作モードを設定する。
Backlight: 

バックライトモード（中心となる被写体
が逆光のとき、黒沈みを軽減するモー
ド）

Standard: 
標準モード

Spotlight: 
スポットライトモード（中心となる被写
体にスポットライトが当たっていると
き、白潰れを軽減するモード）

Speed －99 ～ +99（±0） 自動露出調整の調整スピードを設定する。
Auto ND 
Filter

On / Off NDフィルター透過光量の自動調整機能を
On/Offする。

Shooting>Auto Exposure
自動露出調整の設定を行います。

メニュー項目 細目と設定値 内容
AGC On / Off AGC（オートゲインコントロール）機能を

On/Offする。
AGC Limit AGC機能の最大ゲインを設定する。

ModeがISOのとき

Base LookのSelect S-Cinetone / Standard / 
Still / ITU709 / 709tone

左記以外

Base Sensitivity Low High Low High
AGC Limit ISO 400 ISO 1600 ISO 1000 ISO 4000

ISO 500 ISO 2000 ISO 1250 ISO 5000
ISO 640 ISO 2500 ISO 1600 ISO 6400
ISO 800 ISO 3200 ISO 2000 ISO 8000
ISO 1000 ISO 4000 ISO 2500 ISO 10000
ISO 1250 ISO 5000 ISO 3200 ISO 12800
ISO 1600 ISO 6400 ISO 4000 ISO 16000
ISO 2000 ISO 8000 ISO 5000 ISO 20000
ISO 2500 ISO 10000 ISO 6400 ISO 25600

ModeがdBのとき 
3dB、6dB、9dB、12dB、15dB、18dB

AGC Point F2.8 / F4 / F5.6 AGC機能がOnのとき、AGCを動作させ始
めるアイリスのF値を設定する。

Auto 
Shutter

On / Off オートシャッターコントロール機能をOn/
Offする。

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 オートシャッター機能の最速シャッタース
ピードを設定する。

A.SHT Point F5.6 / F8 / F11 / F16 オートシャッターを動作させ始めるアイリス
のF値を設定する。

Auto Iris On / Off オートアイリスをOn/Offする。
Clip High 
light

On / Off 高輝度部の検出を無視して、高輝度に対す
る反応を鈍くさせる機能をOn/Offする。

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 被写体の明るさに追従して露出を自動調整
する測光範囲を選択する。（露出を手動調
整しているときは無効）
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Shooting>Auto Exposure
自動露出調整の設定を行います。

メニュー項目 細目と設定値 内容
Detect 
Window 
Indication

On / Off 測光範囲の表示をOn/Offする。

Custom 
Width

40 ～ 999（500） 測光範囲の幅を設定する。

Custom 
Height

70 ～ 999（500） 測光範囲の高さを設定する。

Custom H 
Position

－479 ～ +479（±0） 測光範囲の水平位置を設定する。

Custom V 
Position

－464 ～ +464（±0） 測光範囲の垂直位置を設定する。

Shooting>White
ホワイトバランスの設定を行います。

メニュー項目 細目と設定値 内容

White Select A / B / C / D / E / F / G / H ホワイトメモリーポジションを選択する。
Auto White 
Balance

Execute / Cancel 選択しているホワイトメモリーポジションに
対して、オートホワイトバランスを実行する

（Executeで実行）。
ATW On / Off ATW機能をOn/Offする。

［ご注意］
ホワイトメモリーポジションを切り替えると、
ATW機能はOffになります。

Color Temp 2000K ～ 15000K（3200K） 選択しているホワイトメモリーポジションに
保存するホワイトバランスの色温度を設定
する。

［ご注意］
Color Tempは、R/B Gain操作時に2000Kや
15000Kでクリップされるため、R/B Gain値に応
じた正確なColor Temp値を表示できない場合
があります。

Shooting>White
ホワイトバランスの設定を行います。

メニュー項目 細目と設定値 内容

Tint －99 ～ +99（±0） 選択しているホワイトメモリーポジションに
保存するホワイトバランスのTint値を設定
する。

［ご注意］
Tintは、R/B Gain操作時に±99でクリップされ
るため、R/B Gain値に応じた正確なTint値を表
示できない場合があります。

R Gain －99.0 ～ +99.0（±0.0） 選択しているホワイトメモリーポジションに
保存するホワイトバランスのRゲイン値を設
定する。

B Gain －99.0 ～ +99.0（±0.0） 選択しているホワイトメモリーポジションに
保存するホワイトバランスのBゲイン値を設
定する。

Set to Preset 
Value

撮影モードがCustomモードのとき 
3200K ±00 
4300K ±00 
5600K ±00 
6300K ±00

撮影モードがCine EIモードのとき 
3200K ±00 
4300K ±00 
5500K ±00

選択しているホワイトメモリーポジションに
保存するホワイトバランスの色温度を所定
のプリセット値で設定する。Tint値は±0
にする。

Shooting>White Setting
ホワイトバランスの調整を行います。

メニュー項目 細目と設定値 内容

Shockless 
White

Off / 1 / 2 / 3 ホワイトバランスモード切り替え時のホワイ
トバランス変化速度を設定する。
Off：瞬時に切り替わる。
1 ～ 3：数字が大きいほどゆっくり切り替わ

る。
ATW Speed 1 / 2 / 3 / 4 / 5 ATWモード時の反応速度を設定する。

1：最も反応速度が速い。
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Shooting>Focus
フォーカスの設定を行います。

メニュー項目 細目と設定値 内容
AF 
Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) オートフォーカス中の被写体が移り変わる
際のフォーカス駆動の速さを設定する。

AF Subj. 
Shift Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) オートフォーカス中の被写体の乗り移り感
度を設定する。

Focus Area Wide / Zone / Flexible Spot オートフォーカス、プッシュオートフォーカ
ス（AF）の対象とする領域を設定する（97
ページ）。
Wide： 

映像全域からフォーカスを合わせる位
置を探す。

Zone： 
指定したゾーン内から自動でフォーカス
を合わせる点を探す。

Flexible Spot： 
映像の指定した位置にフォーカスを合
わせる。

Subject 
Recognition 
AF

Human Only AF / Human Priority AF / 
Off

被写体検出AF機能の動作を設定する。
Human Only AF: 

カメラが被写体（人物）を検出したとき、
人物の瞳、顔、頭部、体にフォーカス
を合わせる。人物を検出しない間はオー
トフォーカスが一時停止する（人物限定
AF）。

Human Priority AF: 
カメラが被写体（人物）を検出したとき、
人物の瞳、顔、頭部、体にフォーカス
を合わせる。人物を検出しないときは
オートフォーカスで動作する（人物優先
AF）。

Touch 
Function in 
MF

Tracking AF / Spot Focus マニュアルフォーカス時にタッチパネルを
タップしたときの動作を設定する。

Multi 
Selector 
Function

Subject Sel. Cursor / Pointer マルチセレクター操作によるフォーカス対
象の指定方法を切り替える。

Pointer 
Color

Orange / White / Yellow / Cyan / 
Green / Magenta / Red / Blue

フォーカス対象の指定に使用するポイン
ターの色を設定する。

Shooting>Focus
フォーカスの設定を行います。

メニュー項目 細目と設定値 内容
Pointer 
Border

On / Off フォーカス対象の指定に使用するポイン
ターの縁取りを表示するかどうかを設定す
る。

AF Assist On / Off Onに設定すると、オートフォーカス時、一
時的に手動でフォーカスを合わせることが
できる。

Shooting>S&Q Motion
スロー＆クイックモーションモードの設定を行います（109ページ）。

メニュー項目 細目と設定値 内容

Setting On / Off スロー＆クイックモーションモードをOn/
Offする。
Onのとき、以下の機能が無効になります。
•	 オートアイリス
•	 オートシャッター

Frame Rate 1 ～ 60 / 66 / 72 / 75 / 88 / 90 / 96 / 
100 / 110 / 120 / 150 / 180 / 200 / 
240 fps

スロー＆クイックモーション撮影時のフレー
ムレートを設定する。

［ご注意］
設定値の範囲は、選択されているシステム周波数
やコーデック、ビデオフォーマットによって異なり
ます。

Shooting>LUT On/Off
LUTの設定を行います。

メニュー項目 細目と設定値 内容

SDI/ 
HDMI

LUT On / LUT Off SDIおよびHDMI出力映像にモニター LUT
を適用するか選択する。

［ご注意］
Projectメニュー > Rec Format > Codec（44
ページ）がX-OCNフォーマットのときに設定でき
ます。

SDI LUT On / LUT Off SDI出力映像にモニター LUTを適用するか
選択する。

［ご注意］
Projectメニュー > Rec Format > Codec（44
ページ）がX-OCNフォーマット以外のときに設定
できます。
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Shooting>LUT On/Off
LUTの設定を行います。

メニュー項目 細目と設定値 内容

LCD/
Proxy/
Stream

LUT On / LUT Off LCD、ProxyおよびStreamの出力映像に
モニター LUTを適用するか選択する。

［ご注意］
Projectメニュー > Rec Format > Codec（44
ページ）がX-OCNフォーマットのときに設定でき
ます。

LCD/
HDMI/Px/
Stream

LUT On / LUT Off LCD、HDMI、ProxyおよびStreamの出
力映像にモニター LUTを適用するか選択す
る。

［ご注意］
Projectメニュー > Rec Format > Codec（44
ページ）がX-OCNフォーマット以外のときに設定
できます。

Shooting>Noise Suppression
ノイズサプレスの設定を行います。

［メモ］
Setting(Custom)とLevel(Custom)の設定値はそれぞれTarget Displayの設定に反映されます（72ページ）。

メニュー項目 細目と設定値 内容
Setting 
(Custom)

On / Off Customモード時のノイズサプレス機能を
On/Offする。

Level 
(Custom)

Low / Mid / High Customモード時のノイズサプレスのレベ
ルを設定する。

Setting 
(Cine EI)

On / Off Cine EIモード時のノイズサプレス機能を
On/Offする。

Level 
(Cine EI)

Low / Mid / High Cine EIモード時のノイズサプレスのレベル
を設定する。

Shooting>Flicker Reduce
フリッカー補正の設定を行います。

メニュー項目 細目と設定値 内容
Mode Auto / On / Off フリッカー補正モードを設定する。
Frequency 50Hz / 60Hz フリッカーの原因となる照明の電源周波数

を設定する。

Shooting>Image Stabilization
手ブレ補正の設定を行います（105ページ）。

メニュー項目 細目と設定値 内容
PL 
Stabilization

High / Low / Off 手ブレ補正機能を設定する。

［ご注意］
PLマウントアダプター装着時のみ設定できます。

SteadyShot Active / Standard / Off 手ブレ補正機能を設定する。

［ご注意］
•	 PLマウントアダプター非装着時のみ設定でき

ます。
•	 手ブレ補正スイッチ付きレンズを装着していて、

レンズ側のスイッチがOFFの場合、レンズ側が
優先となるため、本機では設定を切り替える
ことができません。

Stabilization 
Adjustment

Auto / Manual 装着しているレンズによって、最適な手ブレ
補正機能を設定する。
Auto: 

レンズから取得した情報をもとに自動
で手ブレ補正する。

Manual: 
Focal Lengthで設定した焦点距離で
手ブレ補正する（8mm ～ 1000mm）。

Focal 
Length

8mm / 9mm / 10mm / 11mm /  
12mm / 13mm / 14mm / 15mm /  
16mm / 17mm / 18mm / 19mm /  
20mm / 21mm / 24mm / 25mm / 
28mm / 30mm / 32mm / 35mm / 
40mm / 45mm / 50mm / 55mm / 
60mm / 70mm / 75mm / 80mm / 
85mm / 90mm / 100mm / 105mm / 
120mm / 135mm / 150mm / 180mm / 
200mm / 210mm / 250mm / 300mm / 
350mm / 400mm / 450mm /  
500mm / 600mm / 800mm / 1000mm

手ブレ補正調整がManualのとき、カメラ
内の手ブレ補正機能の焦点距離情報を設
定する。

［ご注意］
•	 レンズから焦点距離などの情報が取得できな

いときは、手ブレ補正が正しく動作しません。
Stabilization AdjustmentをManualにして、
装着しているレンズに合わせてFocal Length
を設定してください。その場合、手ブレ補正ア
イコンの下に、設定している手ブレ補正焦点
距離の値が表示されます。

•	 レンズSEL16F28（別売）にコンバーターレンズ
を装着している場合などには、Stabilization 
AdjustmentをManualにして、Focal 
Lengthを設定してください。
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Projectメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Project>Base Setting
基本設定を行います。

メニュー項目 細目と設定値 内容
Shooting 
Mode

Custom / Cine EI 撮影モードを設定する（87ページ）。

Target 
Display

SDR(BT.709) / HDR(HLG) Customモード時の記録/出力の色域を設
定する。

Project>Rec Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 システム周波数を選択する。
Imager Scan 
Mode

FF 8.6K 17:9 / FF 8.6K 16:9 /  
FFc 6K 17:9 / FFc 6K 16:9 / FF 5.8K 6:5 / 
FFc 3.8K 16:9 / S35 5.8K 17:9 /  
S35 5.8K 16:9 / S35 4.3K 4:3 /  
S35c 4K 17:9 / S35c 3.8K 16:9 /  
S35 1.9K 16:9

イメージャーサイズを選択する。

［メモ］
•	 8Kを記録したいときは、システム周波数を

29.97以下に設定してください。
•	 FF 5.8K 6:5 / S35 4.3K 4:3またはシステム

周波数が24でFF 8.6K 16:9 / FFc 6K 16:9 / 
FFc 3.8K 16:9 / S35 5.8K 16:9 / S35c 3.8K 
16:9 / S35 1.9K 16:9のときは、Codecが
X-OCNになります。

Codec X-OCN(LT) / XAVC H-I HQ /  
XAVC H-I SQ / XAVC H-L / XAVC-I / 
XAVC-L

クリップの記録・再生コーデックを設定す
る。

［メモ］
•	 8Kを記録したいときは、X-OCNまたはXAVC 

Hを選択してください。
•	 X-OCNはCine EIモード時のみ選択できます。

Project>Rec Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Video 
Format

FrequencyとCodecの設定に応じて変わる。 画像サイズ・ビットレートを設定する。

［メモ］
X-OCNの画像サイズはImager Scanモードに従
います。XAVC Hは8Kのみに対応しています。

Frequency Codec 選択肢
59.94 X-OCN(LT) ―

XAVC-I 4096x2160P
3840x2160P
1920x1080P

XAVC-L 3840x2160P
1920x1080P

50 X-OCN(LT) ―
XAVC-I 4096x2160P

3840x2160P
1920x1080P

XAVC-L 3840x2160P
1920x1080P

29.97 X-OCN(LT) ―
XAVC H-I 
HQ

8192x4320P
7680x4320P

XAVC H-I 
SQ

8192x4320P
7680x4320P

XAVC H-L 7680x4320P
XAVC-I 4096x2160P

3840x2160P
1920x1080P

XAVC-L 3840x2160P
1920x1080P
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Project>Rec Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Video 
Format

25 X-OCN(LT) ―
XAVC H-I 
HQ

8192x4320P
7680x4320P

XAVC H-I 
SQ

8192x4320P
7680x4320P

XAVC H-L 7680x4320P
XAVC-I 4096x2160P

3840x2160P
1920x1080P

XAVC-L 3840x2160P
1920x1080P

23.98 X-OCN(LT) ―
XAVC H-I 
HQ

8192x4320P
7680x4320P

XAVC H-I 
SQ

8192x4320P
7680x4320P

XAVC H-L 7680x4320P
XAVC-I 4096x2160P

3840x2160P
1920x1080P

XAVC-L 3840x2160P
1920x1080P

24 X-OCN(LT) ―
XAVC H-I 
HQ

8192x4320P

XAVC H-I 
SQ

8192x4320P

XAVC-I 4096x2160P

Project>Cine EI Setting
Cine EIモードの設定を行います。

メニュー項目 細目と設定値 内容
Color Gamut S-Gamut3/SLog3 /  

S-Gamut3.Cine/SLog3
Cine EIモード時の色域を設定する。

Project>Cine EI Setting
Cine EIモードの設定を行います。

メニュー項目 細目と設定値 内容
Embed LUT 
File

On / Off 3D LUTファイル（CUBEファイル）のメタデー
タ記録をOn/Offする。

Project>HDR Setting
HDRモードの設定を行います。

メニュー項目 細目と設定値 内容
LCD Monitor 
SDR Preview

Off / On HDRモード時でガンマ表示アシストが有効
なときLCDモニター映像を簡易的にHDRか
らSDRに変換した映像で表示する機能を
On/Offする。

［メモ］
OnのときはLCDモニター映像にSDR Gainが適
用されます。

SDR Gain 0dB ～－15dB（－6dB） HDRモード時でLCD Monitor SDR 
PreviewがOnのとき、LCDモニターに適用
されるSDR Gainの値を設定する。

Project>Simul Rec
同時記録の設定を行います（111ページ）。

メニュー項目 細目と設定値 内容
Setting On / Off 本線同時記録機能のOn/Offと記録先メ

ディアを一括設定する。

Project>Proxy Rec
プロキシ記録モードの設定を行います。

メニュー項目 細目と設定値 内容
Setting On / Off プロキシ記録モードをOn/Offする。
Audio 
Channel

CH1/CH2 / CH3/CH4 プロキシデータに記録するオーディオチャ
ンネルを選択する。

Project>Interval Rec
インターバルレックの設定を行います（110ページ）。

メニュー項目 細目と設定値 内容
Setting On / Off インターバルレックモードをOn/Offする。

（この設定をOnにすると、他の特殊記録
モードの設定がOffになる。）
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Project>Interval Rec
インターバルレックの設定を行います（110ページ）。

メニュー項目 細目と設定値 内容
Interval 
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /  
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /  
20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Interval Recの設定がOnの場合に、イン
ターバル撮影時の録画間隔（インターバル）
を設定する。

Number of 
Frames

1frame / 2frames / 3frames /  
6frames / 9frames / 12frames
選択されているビデオフォーマットのフレー
ム周波数によって設定値が異なります。
59.94P/50P： 
2frames / 6frames / 12frames

29.97P/25P/24P/23.98P： 
1frame / 3frames / 6frames / 
9frames

Interval Recの設定がOnの場合に、イン
ターバル撮影時の1回の記録フレーム数を
設定する。

Pre-Lighting Off / 2 s / 5 s / 10 s インターバルレック撮影開始時にビデオラ
イトを点灯させる場合は何秒前に点灯させ
るかを選択する。

［メモ］
HVL-LBPC（別売）使用時のみ有効な設定です。

Project>Picture Cache Rec
ピクチャーキャッシュレックモードの設定を行います（110ページ）。

メニュー項目 細目と設定値 内容
Setting On / Off ピクチャーキャッシュレックモードをOn/

Offする。
Cache Size Short / Medium / Long / Max ピクチャーキャッシュメモリーに画像を蓄

積する時間（キャッシュレック開始時にさか
のぼる時間）を設定する。

Cache Rec 
Time

ピクチャーキャッシュメモリーに画像を蓄
積する時間（キャッシュレック開始時にさか
のぼる時間）を表示する。

Project>SDI/HDMI Rec Control
SDI/HDMI記録制御の設定を行います。

メニュー項目 細目と設定値 内容
Setting Off / SDI/HDMI Remote I/F / Parallel 

Rec
SDI/HDMI出力信号による外部接続機器の
記録/停止制御を設定する。
Off： 

リモート制御しない。
SDI/HDMI Remote I/F： 

本機にメディアを挿入していない状態
で、外部接続機器の記録/停止制御が
可能。本機のメディアとフレーム精度で
同期しない。

Parallel Rec： 
本機にメディアを挿入している状態で、
外部接続機器の記録/停止制御が可
能。本機のメディアとフレーム精度で同
期する。

［ご注意］
•	 HDMI出力信号による制御を行う場合は、フ

ルメニューのTC/Mediaメニュー >HDMI TC 
OutのSetting（54ページ）をOnに設定して
ください。

•	 	映像出力フォーマットでMonitor FHDを選択
しているときは、Parallel Recを選択できませ
ん。
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Project>Assignable Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1> ～ <11>、
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / 
Push AGC / ND Filter Position / Auto 
ND Filter / Push Auto ND / Iris / Auto 
Iris / Push Auto Iris / Bokeh Control / 
Auto Shutter / Auto Exposure Level / 
Backlight / Spotlight / Auto White 
Balance / ATW / ATW Hold / AF 
Speed/Sens. / Focus Setting / Subject 
Recognition AF / Push AF/Push MF / 
Focus Hold / LCD Focus Magnifier / 
Output Focus Magnifier / S&Q Motion / 
LUT On/Off / LUT On/Off / High/
Low Key / Image Stabilization / Crop 
Select / Rec / Picture Cache Rec / Rec 
Review / Clip Flag OK / Clip Flag NG / 
Clip Flag Keep / Color Bars / CALL / 
DURATION/TC/U-BIT / Display / Lens 
Info / Video Signal Monitor / Marker / 
LCD Monitor Adjust / LCD Monitor 
Mode / Gamma Display Assist / 
Peaking / Zebra / Volume / Clips / 
Touch Operation / Handle Zoom / Auto 
Upload (Proxy) / Direct Menu / User 
Menu / Menu

アサイナブルボタンに機能を割り当てる。
Base ISO/Sensitivity： 

イメージセンサーの基準感度の切り替え
AGC： 

AGC機能のOn/Off切り替え
Push AGC： 

ボタンを押している間、AGC機能を有
効にする

ND Filter Position： 
NDフィルターの切り替え

Auto ND Filter： 
オートNDフィルターのOn/Off即時切
り替え

Push Auto ND： 
ボタンを押している間、オートNDフィ
ルター機能を有効にする

Iris： 
アイリスポジションの設定値を選択 
映像監視モードのときは長押しでオー
ト／マニュアルアイリス設定の設定値を
選択

Auto Iris： 
オートアイリス機能のOn/Off切り替え

Push Auto Iris： 
ボタンを押している間、オートアイリス
機能を有効にする

Bokeh Control： 
ボケ調節モードのOn/Off切り替え

Auto Shutter： 
オートシャッター機能のOn/Off切り替え

Auto Exposure Level： 
Auto Exposure Levelのダイレクトメ
ニューを開始／終了する

Backlight： 
Backlight/Standard切り替え

Spotlight： 
Spotlight/Standard切り替え

Auto White Balance： 
Auto White Balanceを実行する

ATW： 
ATW機能のOn/Off切り替え

Project>Assignable Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1> ～ <11>、
Focus Hold 
Button

ATW Hold： 
ATW機能の動作を一時ホールド

AF Speed/Sens.: 
AFトランジション速度の設定とAF乗り
移り感度の設定の切り替え

Focus Setting： 
フォーカスエリアの設定を行う

Subject Recognition AF： 
Subject Recognition AFの設定の切
り替え

Push AF/Push MF： 
フォーカスモードがMF時、ボタンを押
している間はAFになる 
フォーカスモードがAF時、ボタンを押
している間はMFになる

Focus Hold： 
フォーカスモードがAF時、ボタンを押
している間フォーカスを固定する

LCD Focus Magnifier：
Output Focus Magnifier： 

LCDモニターまたは外部出力のピント
拡大の倍率の切り替え

［メモ］
フルメニューのMonitoringメニュー > 
Focus MagnifierのFocus Mag Button 
Target（58ページ）がLCD Monitorの場
合は、LCD Focus Magnifierを選択でき
ます。Outputの場合は、Output Focus 
Magnifierを選択できます。

S&Q Motion： 
スロー＆クイックモーション機能のOn/
Off切り替え 
長押しで撮影時のフレームレートの設
定

LUT On/Off： 
Shootingメニュー > LUT On/Off > 
SDIまたはSDI/HDMIの設定の切
り替え
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Project>Assignable Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1> ～ <11>、
Focus Hold 
Button

LUT On/Off： 
Shootingメニュー > LUT On/Off > 
LCD/HDMI/Px/Streamまたは
LCD/Proxy/Streamの設定の切り
替え

High/Low Key： 
High Key（高輝度の白飛び確認画面）/
Low Key（低輝度の暗部の確認画面）/
Off （通常画面）の切り替え

Image Stabilization： 
手ブレ補正機能の動作の切り替え

Crop Select： 
イメージャースキャンモードの設定を行う

Rec： 
記録の開始または停止

Picture Cache Rec： 
ピクチャーキャッシュレックモードの
On/Off切り替え

Rec Review： 
レックレビューのOn/Off切り替え

Clip Flag OK： 
Add OKを実行する 
2回続けて押すとDelete Clip Flagを実
行する

Clip Flag NG： 
Add NGを実行する 
2回続けて押すとDelete Clip Flagを実
行する

Clip Flag Keep： 
Add Keepを実行する 
2回続けて押すとDelete Clip Flagを実
行する

Color Bars： 
カラーバーのOn/Off切り替え

CALL： 
ボタンを押している間、本機に接続し
たリモートコントロールパネルにコール
信号を送信する。

DURATION/TC/U-BIT： 
Time Code/Users Bit/Duration切り
替え

Project>Assignable Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1> ～ <11>、
Focus Hold 
Button

Display： 
画面表示のOn/Off切り替え

Lens Info： 
被写界深度表示の切り替え

Video Signal Monitor： 
映像信号モニター（波形モニターなど）
の表示切り替え

Marker： 
マーカー機能のOn/Off切り替え

LCD Monitor Adjust： 
LCDモニターの明るさ調節用レベル
バーの表示

LCD Monitor Mode： 
LCDモニターのカラー /モノクロ切り替
え

Gamma Display Assist： 
ガンマ表示アシスト機能の切り替え

Peaking： 
ピーキング機能のOn/Off切り替え 
長押しでピーキングレベルを設定する

Zebra： 
ゼブラ機能のOn/Off切り替え

Volume： 
ヘッドホン端子および本体内蔵スピー
カーのモニター音声レベルを調整する

Clips： 
クリップ一覧画面の開始/終了

Touch Operation: 
タッチ操作のOn/Off切り替え

Handle Zoom： 
ハンドルズーム動作の切り替え

Auto Upload (Proxy)： 
プロキシクリップの自動転送のOn/Off
切り替え

Direct Menu： 
ダイレクトメニューの開始/終了

User Menu： 
Userメニューの開始/終了

Menu： 
フルメニューの開始/終了
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Project>Assignable Dial
アサイナブルダイヤルへの機能割り当て、回転方向の設定を行います。

メニュー項目 細目と設定値 内容
Grip/
Remote Dial

Off / ISO/Gain/EI / ND Filter / IRIS / 
Auto Exposure Level / Audio Input 
Level / Multi Function Dial

別売のグリップリモコンまたはRM-30BPの
アサイナブルダイヤルに機能を割り当てる。
ISO/Gain/EI： 

ゲインまたはEIを調節する
ND Filter： 

NDフィルターを調節する
IRIS： 

アイリスを調節する
Auto Exposure Level： 

自動露出レベルを調節する
Audio Input Level： 

録音レベルを調節する
Multi Function Dial： 

マルチファンクションダイヤルとして動
作する

Grip Dial 
Direction

Normal / Opposite 別売のグリップリモコンまたはRM-30BPの
アサイナブルダイヤルの回転方向を設定す
る。
Normal：順方向に回転する
Opposite：逆方向に回転する

Project>Multi Function Dial
マルチファンクションダイヤルへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
Default 
Function

Off / ISO/Gain/EI / IRIS / Auto 
Exposure Level / Audio Input Level 

マルチファンクションダイヤルのデフォルト
機能を割り当てる。
IRIS： 

アイリスを調節する
ISO/Gain/EI： 

ゲインまたはEIを調節する
Auto Exposure Level： 

自動露出レベルを調節する
Audio Input Level： 

録音レベルを調節する

Project>User File
ユーザーファイルの操作に関する設定を行います。

メニュー項目 細目と設定値 内容
Load from 
UTILITY SD

Execute / Cancel ユーザーファイルの設定をSDカードから読
み込む。
Execute：実行

Save to 
UTILITY SD

Execute / Cancel ユーザーファイルの設定をSDカードに保存
する。
Execute：実行

File ID ユーザーファイルのFile ID表示と編集を行
う画面を表示する。

Load 
Customize 
Data

On / Off Load from UTILITY SDの実行時にUser
メニューの構成カスタマイズ情報を読み込
むかどうかを設定する。

Load White 
Data

On / Off Load from UTILITY SDの実行時にホワイ
トバランス情報を読み込むかどうかを設定
する。

Project>All File
Allファイルに関する設定を行います。

メニュー項目 細目と設定値 内容
Load from 
UTILITY SD

Execute / Cancel Allファイルの設定をSDカードから読み込
む。
Execute：実行

Load from 
Cloud(Private)

Execute / Cancel クラウドサービス「C3 Portal」（個人）にアッ
プロードしたAllファイルを読み込む。
Execute：実行

Load from 
Cloud(Share)

Execute / Cancel クラウドサービス「C3 Portal」（共通）にアッ
プロードしたAllファイルを読み込む。
Execute：実行

Save to 
UTILITY SD

Execute / Cancel Allファイルの設定をSDカードに保存する。
Execute：実行

Save to 
Cloud(Private)

Execute / Cancel Allファイルの設定をクラウドサービス「C3 
Portal」（個人）に保存する。
Execute：実行

Save to 
Cloud(Share)

Execute / Cancel Allファイルの設定をクラウドサービス「C3 
Portal」（共通）に保存する。
Execute：実行

File ID ファイルに名前を付ける。
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Project>All File
Allファイルに関する設定を行います。

メニュー項目 細目と設定値 内容
Load 
Network 
Data

On / Off Load from UTILITY SD、Load from 
Cloud(Private)およびLoad from 
Cloud(Share)の実行時に、Networkメ
ニューの設定情報を読み込むかどうかを設
定する。
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Paint/Lookメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Paint/Look>Scene File
Sceneファイルに関する設定を行います。

メニュー項目 細目と設定値 内容
Recall 内蔵メモリーに保存されているSceneファイ

ルを読み込み、現在の画質設定に適用する。
Store 現在の画質設定状態をSceneファイルとし

て内蔵メモリーに保存する。
Delete 内蔵メモリーに保存されているSceneファイ

ルを削除する。
Preset Recall Shooting ModeがCustomで、Target 

DisplayがSDR(BT.709)のとき
S-Cinetone / Standard / Still / 
ITU709 / 709tone

Shooting ModeがCustomで、Target 
DisplayがHDR(HLG)のとき

HLG Live / HLG Mild / HLG Natural

プリセット画質（書き換え不可）を現在の画
質設定に適用する。

Paint/Look>Base Look
基本ルックに関する設定を行います。

メニュー項目 細目と設定値 内容
Select Shooting ModeがCustomで、Target 

DisplayがSDR(BT.709)のとき
S-Cinetone / Standard / Still / 
ITU709 / 709tone / User1 ～ User16

Shooting ModeがCustomで、Target 
DisplayがHDR(HLG)のとき

HLG Live / HLG Mild / HLG Natural /  
User1 ～ User16

Shooting ModeがCine EIのとき
709(800%) / S-Log3 / s709 /  
Warm / Cool / Vintage / Teal and 
Orange / ACESproxy / ACEScct / 
ACES 1.0 Output-Rec.709 /  
User1 ～ User16

基本ルックを選択する。

［ご注意］
フルメニューのProjectメニュー > Cine EI 
SettingのColor Gamut（45ページ）が
S-Gamut3/SLog3のときに、以下の基本ルック
を選択できます。
•	 ACESproxy
•	 ACEScct
•	 ACES 1.0 Output-Rec.709

Delete 選択した基本ルックを削除する。
Delete All すべての基本ルックを削除する。
Import from 
Utility SD

Execute / Cancel SDカードから基本ルックファイルを読み込
む。
Execute：実行

Paint/Look>Base Look
基本ルックに関する設定を行います。

メニュー項目 細目と設定値 内容
Import from 
Cloud(Private)

Execute / Cancel クラウドサービス「C3 Portal」（個人）にアッ
プロードした基本ルックファイルを読み込
む。
Execute：実行

Import from 
Cloud(Share)

Execute / Cancel クラウドサービス「C3 Portal」（共通）にアッ
プロードした基本ルックファイルを読み込
む。
Execute：実行

Input S-Gamut3/SLog3 /  
S-Gamut3.Cine/SLog3

Selectで選択している基本ルックの入力
Gamutを設定する。

Output Full BT.709 / Full BT.2020 /  
Video BT.709 / Video BT.2020

Selectで選択している基本ルックの出力色
域を設定する。

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 
5/3EV / 2EV

Selectで選択している基本ルックの露出基
準値を設定する。

Paint/Look>Reset Paint Settings
基本ルック以外のPaint/Lookメニューの設定値をリセットします。

メニュー項目 細目と設定値 内容
Reset 
without Base 
Look

Execute / Cancel 基本ルック以外のPaint/Lookメニューの設
定値のリセットを実行する。
Execute：実行

Paint/Look>Black
ブラックの設定を行います。

メニュー項目 細目と設定値 内容
Master 
Black

－99.0 ～ +99.0（±0.0） マスターブラックレベルを設定する。

R Black －99.0 ～ +99.0（±0.0） Rブラックレベルを設定する。
B Black －99.0 ～ +99.0（±0.0） Bブラックレベルを設定する。

Paint/Look>Knee
ニー補正の設定を行います。

メニュー項目 細目と設定値 内容

Setting Target DisplayがSDR(BT.709)のとき
On / Off

Target DisplayがHDR(HLG)のとき
On / Off

ニー補正機能をOn/Offする。

［メモ］
Base Look設定のSelectがStandard、
ITU709、709tone、HLG Live、HLG Mildまた
はHLG Naturalのときのみ有効です。
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Paint/Look>Knee
ニー補正の設定を行います。

メニュー項目 細目と設定値 内容

Auto Knee Target DisplayがSDR(BT.709)のとき
On / Off

Target DisplayがHDR(HLG)のとき
On / Off

オートニー機能をOn/Offする。

［メモ］
ニー補正のSettingがOnで、Base Look設定の
SelectがStandard、ITU709または709toneの
ときのみ有効です。 

Point 75% ～ 109%（90%） ニーポイントを設定する。
Slope －99 ～＋99（±0） ニースロープを設定する。

Paint/Look>Detail
ディテール調整の設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off ディテール機能をOn/Offする。
Level －7 ～＋7（±0） ディテールレベルを設定する。
H/V Ratio －2 ～＋2（±0） 垂直（V）/水平（H）ディテールのバランスを

設定する。
B/W 
Balance

Type1 / Type2 / Type3 / Type4 / Type5 下側（B）/上側（W）ディテールのバランスを
設定する。

Limit 0～ 7 ディテールのリミットレベルを設定する。
Crispening 0～ 7 クリスプニングレベルを設定する。
High Light 
Detail

0～ 4 高輝度部分のディテールレベルを設定す
る。

Paint/Look>Matrix
マトリクス補正の設定を行います。

メニュー項目 細目と設定値 内容
User Matrix On / Off ユーザーマトリクス補正機能をOn/Offす

る。

Paint/Look>Matrix
マトリクス補正の設定を行います。

メニュー項目 細目と設定値 内容
Saturation On / Off ユーザーマトリクスレベルを映像へ反映す

るかどうかを設定する。

［メモ］
この設定は、リモートコントロールパネルのサチュ
レーション調整機能に連動しており、リモートコ
ントロールパネルのサチュレーションのOn/Off
操作で切り替えできます。また、本設定がOnの
とき、リモートコントロールパネルのサチュレー
ションレベルの調整操作で、User Matrix Level

（彩度）を調整できます。 
本機能は、User Matrix機能を使って実現してい
るため、本設定を有効にするにはUser Matrixを
Onにする必要があります。User MatrixをOnに
すると、User Matrix Level以外のUser Matrix
の調整項目も映像に反映されるようになります。

User Matrix 
Level

－99 ～＋99（±0） 映像全域の色の濃さ（サチュレーション）を
調整する。

User Matrix 
Phase

－99 ～＋99（±0） 映像全域の色合い（フェーズ）を調整する。

User Matrix 
R-G

－99 ～＋99（±0） R-Gのユーザーマトリクスを任意に設定す
る。

User Matrix 
R-B

－99 ～＋99（±0） R-Bのユーザーマトリクスを任意に設定す
る。

User Matrix 
G-R

－99 ～＋99（±0） G-Rのユーザーマトリクスを任意に設定す
る。

User Matrix 
G-B

－99 ～＋99（±0） G-Bのユーザーマトリクスを任意に設定す
る。

User Matrix 
B-R

－99 ～＋99（±0） B-Rのユーザーマトリクスを任意に設定す
る。

User Matrix 
B-G

－99 ～＋99（±0） B-Gのユーザーマトリクスを任意に設定す
る。
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Paint/Look>Multi Matrix
マルチマトリクス補正の設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off Multi Matrix補正機能をOn/Offする。
Area 
Indication

On / Off Multi Matrixを設定中に補正対象となって
いる色軸が分かるように、対象領域を見分
ける表示機能をOn/Offする。
On： 

Axisで指定されている色の領域以外を
白黒で表示する

Off： 
通常表示

［メモ］
•	 マルチマトリクス補正の各設定画面を表示して

いるときにDISPLAYボタン（5ページ）を
押すと、On/Offを切り替えることができます。
また、Area Indication ControlがMenu & 
RCPに設定されているときは、リモートコント
ロールパネルからOn/Offを切り替えることが
できます。

•	 記録動作中、および、ピクチャーキャッシュレッ
ク機能がOnのときは、本設定はOff固定とな
ります。

•	 Multi Matrixの設定メニューから他の画面に
移動すると、本設定は自動的にOffになります。

［ご注意］
•	 対象領域を見分ける表示機能をOnにしている

ときは、表示されている映像が記録映像や出
力映像にも出力されます。

•	 ピクチャーキャッシュレック機能がOnのとき
は、Area Indicationの設定を変更できませ
ん。

Area 
Indication 
Control

Menu Only / Menu & RCP Area IndicationのOn/Off設定の操作対
象を設定する。
Menu Only： 

本機からのみArea IndicationのOn/
Offを設定可能

Menu & RCP： 
本機とリモートコントロールパネルから
Area IndicationのOn/Offを設定可
能

Paint/Look>Multi Matrix
マルチマトリクス補正の設定を行います。

メニュー項目 細目と設定値 内容

Reset Execute / Cancel 各色軸の色相（ヒュー）と飽和度（サチュレー
ション）の設定値をすべて初期値にする。

Axis B / B+ / MG－ / MG / MG+ / R / R+ /  
YL－ / YL / YL+ / G－ / G / G+ / CY /  
CY+ / B－

調整対象の色軸を選択する。

Hue －99 ～＋99（±0） Axisで選択した調整対象の色軸の色相
（ヒュー）を設定する。

Saturation －99 ～＋99（±0） Axisで選択した調整対象の色軸の飽和度
（サチュレーション）を設定する。
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TC/Mediaメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

TC/Media>Timecode
タイムコードの設定を行います。

メニュー項目 細目と設定値 内容

Mode Preset / Regen / Clock タイムコードの歩進モードを設定する。
Preset（プリセット）： 

設定された値から歩進する。
Regen（リジェネ）： 

前のクリップのタイムコードに続けて歩
進する。

Clock（クロック）： 
内蔵時計をタイムコードとして使用す
る。

Run Rec Run / Free Run Rec Run：記録時のみ歩進する。
Free Run：記録に関係なく常に歩進する。

Setting タイムコードを任意の値に設定する。
SET：決定

Reset Execute / Cancel タイムコードを00:00:00:00にリセットす
る。
Execute：実行

TC Format DF / NDF タイムコードのフォーマットを設定する。
DF：ドロップフレーム
NDF：ノンドロップフレーム

TC/Media>TC Display
タイムデータ表示の設定を行います。

メニュー項目 細目と設定値 内容

Display 
Select

Timecode / Users Bit / Duration タイムデータの表示を切り替える。

TC/Media>Users Bit
ユーザービットに関する設定を行います。

メニュー項目 細目と設定値 内容

Mode Fix / Time ユーザービットのモードを設定する。
Fix：ユーザービットに任意の固定値を使用

する。
Time：ユーザービットに現在の時分秒を使

用する。
Setting ユーザービットを任意の値に設定する。

TC/Media>HDMI TC Out
HDMI利用時のタイムコード出力に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off HDMIを利用して、他の業務用機器にタイ
ムコードを出力するかどうかを設定する。

TC/Media>Genlock
ゲンロックに関する設定を行います。

メニュー項目 細目と設定値 内容
Reference 
Lock Type

Internal / External(HD) / External(HD) 
Shift / External(SD) / External(SD) Shift

ゲンロックの動作状態を表示する。
Internal： 

ゲンロックせず内部クロックで映像を
出力している状態であることを示す。

External(HD)： 
HDリファレンス信号にゲンロックしてい
ることを示す。

External(HD) Shift： 
HDリファレンス信号に対してSync 
Shift Valueの位相差でゲンロックして
いることを示す。

External(SD)： 
SDリファレンス信号にゲンロックしてい
ることを示す。

External(SD) Shift： 
SDリファレンス信号に対してSync 
Shift Valueの位相差でゲンロックして
いることを示す。

Sync Shift 調整範囲上限のステップ数は、選択されてい
る記録フォーマットのシステム周波数によっ
て異なります。
59.94：

0 ～ 72071 (+16683.102μs)
50：

0 ～ 86399 (+19999.769μs)
29.97：

0 ～ 144143 (+33366.435μs)
25：

0 ～ 172799 (+39999.769μs)
24：

0 ～ 179999 (+41666.435μs)
23.98：

0 ～ 180179 (+41708.102μs)

ゲンロック入力信号の位相をステップ単位
で調整する（116ページ）。
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TC/Media>Genlock
ゲンロックに関する設定を行います。

メニュー項目 細目と設定値 内容
Sync Shift 
Value

+xxxxx.xxx μs Sync Shiftで設定した位相シフト時間を表
示する。

TC/Media>Clip Name Format
クリップの名称やフォルダに関する設定を行います。

メニュー項目 細目と設定値 内容

Camera ID A ～ Z クリップ名の生成時のカメラIDを設定する。
Reel 
Number

001 ～ 999 クリップ名の生成時のReel Numberの数
字部分を設定する。

Camera 
Position

C / L / R クリップ名の生成時のShot Numberの先
頭文字部分を選択する。

XAVC Root 
Folder 
Name

XDROOT / Cam ID + Reel# 記録メディアのVolumeラベル名および
Rootフォルダ名を設定する。

TC/Media>Update Media
メモリーカード内の管理ファイルを更新します。

メニュー項目 細目と設定値 内容

Media(A) Execute / Cancel スロットAのメモリーカード内の管理ファイ
ルを更新する。
Execute：実行

Media(B) Execute / Cancel スロットBのメモリーカード内の管理ファイ
ルを更新する。
Execute：実行

TC/Media>Format Media
メモリーカードを初期化します。

メニュー項目 細目と設定値 内容

Media(A) Full Format / Cancel スロットAのメモリーカードを初期化する。
Media(B) Full Format / Cancel スロットBのメモリーカードを初期化する。
Utility SD Full Format / Quick Format / Cancel SDカードを初期化する。
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Monitoringメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Monitoring>Output Format
出力フォーマットの設定を行います。

メニュー項目 細目と設定値 内容

SDI1 設定項目について詳しくは、「出力のフォー
マットと制限」（121ページ）をご覧くださ
い。

SDIとHDMI出力の解像度設定をする。
SDI2
HDMI
REF HD Sync 同期信号出力のフォーマットを表示する。

（HD Syncのみ）

Monitoring>De-Squeeze
デスクイーズの設定を行います。

メニュー項目 細目と設定値 内容

Ratio Off(1.0x) / 1.3x / 1.5x / 1.8x / 2.0x アナモフィックレンズでの撮影時に、指定
した出力系統に表示する映像のデスクイー
ズ倍率を選択する。

SDI (Monitor 
FHD)

On / Off Monitor FHD設定時に、SDI出力映像のデ
スクイーズ表示を行うかどうかを設定する。

HDMI (FHD 
Output)

On / Off FHD出力画サイズのHDMI出力映像のデス
クイーズ表示を行うかどうかを設定する。

LCD Monitor On / Off LCDモニター出力映像のデスクイーズ表示
を行うかどうかを設定する。

Monitoring>Output Display
画面表示の出力設定を行います。

メニュー項目 細目と設定値 内容

SDI On / Off SDI出力信号へのメニューやステータスな
ど、画面表示の重畳を設定する。

HDMI On / Off HDMI出力信号へのメニューやステータス
など、画面表示の重畳を設定する。

Monitoring>Display On/Off
画面表示項目の設定を行います。

メニュー項目 細目と設定値 内容

Focus Mode On / Off LCDモニターに表示する項目を選択する。
Focus 
Position

On / Off

Network 
Status

On / Off

File Transfer 
Status

On / Off

Rec/Play 
Status

Always On / On / Off

SDI/HDMI 
Rec Control

On / Off

Tally On / Off
Battery 
Remain

On / Off

Zoom 
Position

On / Off

Image 
Stabilization

On / Off

Media 
Status

On / Off

Lens Info On / Off
Look Name On / Off
UWP RF 
Level

On / Off

Focus Area 
Indicator

On / Off

Subject 
Recognition 
Frame

On / Off

Tracking AF 
Pointer

On / Off

Clip Name On / Off
Video Level 
Warning

On / Off

Timecode On / Off
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Monitoring>Display On/Off
画面表示項目の設定を行います。

メニュー項目 細目と設定値 内容

Gamma 
Display 
Assist

On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Imager Scan 
Mode

On / Off

Frame Rate On / Off
Rec Format On / Off
Rec Look On / Off
Level Gauge On / Off
Audio Level 
Meter

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

ND Filter On / Off
Iris On / Off
ISO/Gain/EI On / Off
Base ISO/
Sensitivity

On / Off

Shutter On / Off
White 
Balance

On / Off

Clip Number On / Off
Notice 
Message

On / Off

Monitoring>Marker
マーカー表示の設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off すべてのマーカー表示をまとめてOn/Offす
る。

Monitoring>Marker
マーカー表示の設定を行います。

メニュー項目 細目と設定値 内容

Color White / Yellow / Cyan / Green / 
Magenta / Red / Blue

マーカーの信号色を選択する。

Center 
Marker

1 / 2 / 3 / 4 / Off センターマーカーを選択する。

Safety Zone On / Off セーフティーゾーンマーカーをOn/Offする。
Safety Area 80% / 90% / 92.5% / 95% セーフティーゾーンマーカーの大きさ（画面

全体に対する比率）を選択する。
Aspect 
Marker

Line / Mask / Off アスペクトマーカーの比を選択する。

Aspect 
Mask

0 ～ 15（12） マーカー外側のビデオ信号のレベルを設定
する。

Aspect 
Safety Zone

On / Off アスペクトセーフティーゾーンマーカーを
On/Offする。

Aspect 
Safety Area

80% / 90% / 92.5% / 95% アスペクトセーフティーゾーンマーカーの大
きさ（画面全体に対する比率）を選択する。

Aspect 
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 
17:9 / 1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / 
Custom

アスペクトマーカーを表示するときのモード
を設定する。

Custom 
Aspect 
Ratio

任意の値を入力する（01.00:01.00） アスペクト比を任意の値に設定する。

［ご注意］
Aspect SelectでCustomを選択した場合に、こ
の設定が有効になります。

Guide 
Frame

On / Off ガイドフレーム表示をOn/Offする。

100% 
Marker

On / Off 100%マーカーをOn/Offする。

User Box On / Off ユーザーボックスマーカーの表示をOn/Off
する。

User Box 
Width

3 ～ 479（240） ユーザーボックスマーカーの幅（中心から左
右端までの距離）を設定する。

User Box 
Height

3 ～ 269（135） ユーザーボックスマーカーの高さ（中心から
上下端までの距離）を設定する。

User Box H 
Position

－476 ～ +476（0） ユーザーボックスマーカーの中心の水平位
置を設定する。

User Box V 
Position

－266 ～ +266（0） ユーザーボックスマーカーの中心の垂直位
置を設定する。
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Monitoring>LCD Monitor Setting
ビューファインダーの設定を行います。

メニュー項目 細目と設定値 内容

Brightness 1 ～ 15（8） ビューファインダー映像の明るさを調整す
る。

Color Mode Color / B&W E-E表示/記録時のビューファインダーの表
示モードを選択する。

Monitoring>Gamma Display Assist
ガンマ表示アシストの設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off Cine EIモードでBase LookがS-Log3時
（初期値：Off）、またはCustomモードで
Target DisplayがHDR(HLG)時（初期値：
On）のガンマ表示アシスト機能をOn/Off
する。

Monitoring>Peaking
ピーキングの設定を行います

メニュー項目 細目と設定値 内容

Setting On / Off ピーキング機能をOn/Offする。
Type Normal / Color ピーキングの種類を選択する。
Normal 
Peaking 
Level

High / Mid / Low ノーマルピーキングのレベルを設定する。

Color 
Peaking 
Level

High / Mid / Low カラーピーキングの信号レベルを設定する。

Color B&W / Red / Yellow / Blue カラーピーキングの信号色を選択する。
Color Edge 
Type

Rising Edge / Falling Edge / Both カラーピーキングのエッジ検出方式を設定
する。

Monitoring>Zebra
ゼブラパターンの設定を行います。

メニュー項目 細目と設定値 内容

Setting Off / Zebra1 / Zebra2 ゼブラ表示の種類（Off、ゼブラ1、ゼブラ2）
を選択する。

Zebra1 Level 0% ～ 109%（70%） ゼブラ1を表示するレベルを設定する。
Zebra1 
Aperture 
Level

2% ～ 20%（10%） ゼブラ1のアパーチャーレベルを設定する。

Monitoring>Zebra
ゼブラパターンの設定を行います。

メニュー項目 細目と設定値 内容

Zebra2 Level 0% ～ 109%（100%） ゼブラ2を表示するレベルを設定する。

Monitoring>Focus Magnifier
ピント拡大の設定を行います。

メニュー項目 細目と設定値 内容

Focus Mag 
Button 
Target

LCD Monitor / Output アサイナブルボタンで操作するピント拡大
対象を設定する。
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Audioメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

「ブロックダイヤグラム」（140ページ）をあわせてご覧ください。

Audio>Audio Input
音声入力の設定を行います。

メニュー項目 細目と設定値 内容

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 記録CH1に対する入力元を切り替える。

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe 
CH2

記録CH2に対する入力元を切り替える。

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 記録CH3に対する入力元を切り替える。

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

記録CH4に対する入力元を切り替える。

INPUT1 MIC 
Reference

－80dB / －70dB / －60dB / －50dB /  
－40dB / －30dB

INPUT1からのXLRマイク入力に対するリ
ファレンスレベルを設定する。

INPUT2 MIC 
Reference

－80dB / －70dB / －60dB / －50dB /  
－40dB / －30dB

INPUT2からのXLRマイク入力に対するリ
ファレンスレベルを設定する。

Line Input 
Reference

+4dB / 0dB / －3dB / EBUL INPUT1/INPUT2スイッチの設定がLINEの
場合の基準入力レベルを選択する。

Reference 
Level

－20dB /－18dB / －16dB / －12dB / 
EBUL

基準入力レベルの1 kHz信号の記録レベル
を選択する。

CH1 Wind 
Filter

On / Off 記録CH1に対する風音低減フィルターを設
定する。

CH2 Wind 
Filter

On / Off 記録CH2に対する風音低減フィルターを設
定する。

CH3 Wind 
Filter

On / Off 記録CH3に対する風音低減フィルターを設
定する。

CH4 Wind 
Filter

On / Off 記録CH4に対する風音低減フィルターを設
定する。

CH3 Level 
Control

Auto / Manual 記録CH3の音声入力レベル調整を自動にす
るか、手動にするかを設定する。

［ご注意］
CH3 Input Select、CH4 Input Selectがどちら
もInternal MICに設定されている場合は、本設
定に連動してCH4の自動・手動も切り替わります。

Audio>Audio Input
音声入力の設定を行います。

メニュー項目 細目と設定値 内容

CH4 Level 
Control

Auto / Manual 記録CH4の音声入力レベル調整を自動にす
るか、手動にするかを設定する。

［ご注意］
CH3 Input Select、CH4 Input Selectがどちら
もInternal MICに設定されている場合は、CH3 
Level Controlの設定に連動してCH4の自動・手
動も切り替わります。

CH3 Input 
Level

0 ～ 99（49） 記録CH3の入力レベルを設定する。

CH4 Input 
Level

0 ～ 99（49） 記録CH4の入力レベルを設定する。

Audio Input 
Level

0 ～ 99 音声入力レベルを設定する。
CH1 Level ～ CH4 Levelの設定に従って、
マスターボリュームとして使用できます。

Limiter 
Mode

Off / －6dB / －9dB / －12dB / －15dB / 
－17dB

オーディオ入力レベルの手動調節時の大き
な信号に対するリミッター特性を選択する。

CH1&2 AGC 
Mode

Mono / Stereo 記録CH1と記録CH2の自動レベル調整モー
ドを設定する。Stereoに設定されていると
きは、CH間でAGCが連動する。

CH3&4 AGC 
Mode

Mono / Stereo 記録CH3と記録CH4の自動レベル調整モー
ドを設定する。Stereoに設定されていると
きは、CH間でAGCが連動する。

AGC Spec －6dB / －9dB / －12dB / －15dB /  
－17dB

AGC特性を選択する。

1kHz Tone 
on Color 
Bars

On / Off カラーバー表示中の1 kHzの基準音声信号
をOn/Offする。

［ご注意］
Onに設定すると、CH3 Input Select、CH4 
Input SelectがOffの場合でも、1 kHzの基準音
声信号を記録CH3、記録CH4に乗せます。
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Audio>Audio Input
音声入力の設定を行います。

メニュー項目 細目と設定値 内容

CH1 Level XLRアダプター入力なし
Audio Input Level / Side / 
Level+Side

XLRアダプター入力あり（106ページ）
Audio Input Level / Through

記録CH1の音声入力レベル調整の組み合わ
せを設定する。

［ご注意］
Sideは本機側面のAUDIO LEVEL（CH1）ダイヤ
ルを指します。Level+Sideを設定したときは
Audio Input Level設定の割合とダイヤル設定の
割合を掛け合わせた割合が録音レベルになります

（140ページ）。

CH2 Level XLRアダプター入力なし
Audio Input Level / Side / 
Level+Side

XLRアダプター入力あり（106ページ）
Audio Input Level / Through

記録CH2の音声入力レベル調整の組み合わ
せを設定する。

［ご注意］
Sideは本機側面のAUDIO LEVEL（CH2）ダイヤ
ルを指します。Level+Sideを設定したときは
Audio Input Level設定の割合とダイヤル設定の
割合を掛け合わせた割合が録音レベルになります

（140ページ）。

CH3 Level XLRアダプター入力なし
Audio Input Level / CH3 Input 
Level / Level+CH3 Input Level

XLRアダプター入力あり（106ページ）
Audio Input Level / Through

記録CH3の音声入力レベル調整の組み合
わせを設定する。

CH4 Level XLRアダプター入力なし
Audio Input Level / CH4 Input 
Level / Level+CH4 Input Level

XLRアダプター入力あり（106ページ）
Audio Input Level / Through

記録CH4の音声入力レベル調整の組み合
わせを設定する。

Audio>Audio Output
音声出力の設定を行います。

メニュー項目 細目と設定値 内容

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

ヘッドホン端子および内蔵スピーカーに出
力する音声チャンネルを選択する。

［ご注意］
複数チャンネルの音声を同時出力する設定値を
選択した場合は、音割れしないように各チャンネ
ルの出力レベルを下げて音声が出力されます。

Volume 0～ 50 ヘッドホン端子および内蔵スピーカーのモ
ニター音声レベルを調整する。

Headphone 
Out

Mono / Stereo ヘッドホン端子をモノラル（Mono）出力に
するか、ステレオ（Stereo）出力にするかを
選択する。

Alarm Level 0 ～ 7（4） 警告音の音量を調整する。
HDMI 
Output CH

CH1/CH2 / CH3/CH4 HDMIに出力される音声チャンネルの組み
合わせを設定する。

SDI Out CH 
(Monitor 
FHD)

CH1/CH2 / CH3/CH4 SDI出力フォーマットがMonitor FHDのと
きに、SDIに出力される音声チャンネルの
組み合わせを設定する。
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Clip Operationsメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Clip Operations
メニュー項目 細目と設定値 内容

Display Clip 
Properties

クリップ詳細情報画面を開く。

Clip Operations>Set Clip Flag
クリップフラグの編集を行います。

メニュー項目 細目と設定値 内容

Add OK OKフラグを付ける。
Add NG NGフラグを付ける。
Add KEEP Keepフラグを付ける。
Delete Clip 
Flag

すべてのフラグを外す。

Clip Operations>Lock/Unlock Clip
クリップの保護設定を行います。

メニュー項目 細目と設定値 内容

Select Clip 保護/保護解除するクリップを選択して実
行する。

Lock All 
Clips

すべてのクリップを保護する。

Unlock All 
Clips

すべてのクリップを保護解除する。

Clip Operations>Transfer Clip
クリップを転送します。

［ご注意］
NetworkメニューのNetwork Setupでパスワードを設定していない場合、Transfer Clipは設定できません。

メニュー項目 細目と設定値 内容

Select Clip 任意のクリップを転送する。
All Clips クリップを一括転送する。

［ご注意］
転送できるクリップの上限は200件です。

Clip Operations>Transfer Clip (Proxy)
プロキシクリップを転送します。

［ご注意］
NetworkメニューのNetwork Setupでパスワードを設定していない場合、Transfer Clip (Proxy)は設定できませ
ん。

メニュー項目 細目と設定値 内容

Select Clip 任意のクリップに対応しているプロキシク
リップを転送する。

All Clips クリップに対応するプロキシクリップを一
括転送する。

［ご注意］
転送できるクリップの上限は200件です。

Clip Operations>Filter Clips
表示するクリップの設定を行います。

メニュー項目 細目と設定値 内容

OK OKフラグのついたクリップのみを表示する。
NG NGフラグのついたクリップのみを表示する。
KEEP Keepフラグのついたクリップのみを表示す

る。
None フラグのついていないクリップのみを表示

する。
All フラグのありなしによらず、すべてのクリッ

プを表示する。

Clip Operations>Customize View
クリップ一覧画面の表示を切り替えます。

メニュー項目 細目と設定値 内容

Clips 
Caption

Clip Name / Date Time / Time Code / 
Duration / Sequential Number

クリップ画像直下の表示内容を切り替え
る。
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Technicalメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Technical>Color Bars
カラーバーの設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off カラーバーをOn/Offする。

［メモ］
イメージャースキャンモードがFF 5.8K 6:5/S35 
4.3K 4:3のときはOnにできません。

Type ARIB / 100% / 75% / SMPTE カラーバーの種類を選択する。

Technical>ND Dial
ND VARIABLEダイヤルの操作に関する設定を行います。

メニュー項目 細目と設定値 内容

CLEAR with 
Dial

On / Off ND VARIABLEダイヤルの操作でNDの状
態遷移（CLEAROn）を可能にするかどう
か設定する。

Technical>Rec/Tally
記録/タリーランプの設定を行います。

メニュー項目 細目と設定値 内容

Rec/Tally 
Lamp

On / Off 記録/タリーランプをOn/Offする。

Tally Control REMOTE / External / Internal Tally/Call制御情報を受け付ける対象を選
択する。
REMOTE： 

REMOTE端子（6ページ）に接続さ
れている機器からのTally制御

External： 
外部機器からのTally/Call制御

Internal： 
カメラの設定および状態による制御

Rec Start/
Stop Beep

0 ～ 50 記録開始、終了時のビープ音の音量を調整
する。

Technical>LOCK Switch Settings
ロックスイッチの設定を行います。

メニュー項目 細目と設定値 内容

with Rec 
Button

On / Off REC（記録開始／記録停止）ボタンをロック
の対象にするか非対象にするかを設定す
る。

Technical>LOCK Switch Settings
ロックスイッチの設定を行います。

メニュー項目 細目と設定値 内容

with Hand 
Grip Remote

On / Off グリップリモコンによる操作をロックの対象
にするか非対象にするかを設定する。

with LCD 
Monitor

On / Off LCDモニターのボタンをロックの対象にする
か非対象にするかを設定する。

Technical>Touch Operation
タッチ操作に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off タッチ操作をOn/Offする。

Technical>Rec Review
レックレビューの設定を行います。

メニュー項目 細目と設定値 内容

Setting 3 s / 10 s / Clip レックレビューで直前に記録したクリップを
再生する時間を選択する。

Technical>Zoom
ズームの設定を行います。

メニュー項目 細目と設定値 内容

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

ズームの種類を設定する。
Optical Zoom Only： 

レンズを動かすことにより、光学的な
ズームを行う

On(Clear Image Zoom)： 
画質劣化が少ない、電子的なズームを
行う

Technical>Handle Zoom
別売のMIシュー搭載ハンドルにあるハンドルズームの設定を行います。

メニュー項目 細目と設定値 内容

Setting Off / Low / High / Variable ハンドルズームスピードを設定する。
High 1 ～ 8（8） ハンドルズームスピードHigh選択時、ハン

ドルズームレバーを押したときのズームス
ピードを設定する。
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Technical>Handle Zoom
別売のMIシュー搭載ハンドルにあるハンドルズームの設定を行います。

メニュー項目 細目と設定値 内容

Low 1 ～ 8（3） ハンドルズームスピードLow選択時、ハンド
ルズームレバーを押したときのズームスピー
ドを設定する。

［ご注意］
ズームスピードが低速のときにズーミングにむら
が出ることがあります。

Technical>Menu Settings
メニューに関する設定を行います。

メニュー項目 細目と設定値 内容

User Menu 
Only

On / Off メニューを表示したときに、Userメニュー
だけを表示するか（On）、メニューリストを
表示するか（Off）を設定する。

User Menu 
with Lock

On / Off メニュー表示にロックをかけて、Userメ
ニューだけの表示にするかどうかを設定す
る。

［ご注意］
通常のメニュー表示操作では表示されません。メ
ニュー表示の操作方法は、34ページをご覧く
ださい。

Technical>Menu Page On/Off
ステータス画面の表示に関する設定を行います。

メニュー項目 細目と設定値 内容

Project On / Off プロジェクトステータス画面の表示をOn/
Offする。

Audio On / Off オーディオステータス画面の表示をOn/
Offする。

Monitoring On / Off モニタリングステータス画面の表示をOn/
Offする。

Assignable 
Button

On / Off アサイナブルボタンステータス画面の表示
をOn/Offする。

Information On / Off インフォメーション画面の表示をOn/Offす
る。

Media On / Off メディアステータス画面の表示をOn/Off
する。

Technical>Menu Page On/Off
ステータス画面の表示に関する設定を行います。

メニュー項目 細目と設定値 内容

Network On / Off ネットワークステータス画面の表示をOn/
Offする。

File Transfer On / Off ファイル転送ステータス画面の表示をOn/
Offする。

Technical>RCP
リモートコントロールパネルに関する設定を行います

メニュー項目 細目と設定値 内容

CNS Mode Off / Bridge リモートコントロールパネルとのBridge
モード接続を許可するかどうかを設定す
る。

Technical>Fan Control
ファン制御モードの設定を行います。

メニュー項目 細目と設定値 内容

Setting Auto / Minimum / Off in Rec 本機のファン制御モードを設定する。

［ご注意］
Off in Recを選択していても、本機の内部温度
が一定温度を超えるとファンが回転します。

Technical>Lens
レンズに関する設定を行います。

メニュー項目 細目と設定値 内容

PL-Mt 
Interface 
Position

Top / Side / Off PLマウントレンズのインターフェース位置を設定す
る。

PL-Mt 
Voltage

10 V → 24 V / 24V PLマウントレンズへの通電方式を設定する。

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) ズームリングの操作方向を設定する。

［ご注意］
ズームリングの操作方向切り替えに対応したEマ
ウントレンズ使用時のみ設定できます。
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Technical>Lens
レンズに関する設定を行います。

メニュー項目 細目と設定値 内容

Shading 
Compensation

Auto / Auto(Low) / Off 対応レンズが装着されている場合に自動周
辺光量補正を設定する。

［ご注意］
•	 レンズによっては、Shading Compensation

を設定しても周辺光量が補正しきれない場合
があります。

•	 レンズによっては、AutoとAuto(Low)で補正
効果に差が出ないことがあります。

Chroma 
Aberration 
Comp.

Auto / Off 対応レンズが装着されている場合に自動倍
率色収差補正を設定する。

Distortion 
Comp.

Auto / Off 自動歪曲収差補正を設定する。

［ご注意］
Shootingメニュー > Image Stabilizationの
SteadyShot（43ページ）をActive に設定す
ると、Distortion Comp.はAutoになります。

Breathing 
Compensation

Auto / Off レンズのブリージング補正を設定する。

Distance 
Display

Meter / Feet レンズ情報とフォーカスポジションの表示
単位を設定する。

Zoom 
Position 
Display

Focal Length / Number / Bar ズーム位置の表示形式を設定する。

［ご注意］
情報表示モードのときは、Zoom Position 
DisplayがBarに設定されていてもNumberの表
示になります。

Technical>Video Light Set
ビデオライトの点灯方式を設定します。HVL-LBPC（別売）使用時のみ有効な設定です。

メニュー項目 細目と設定値 内容

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby マルチインターフェースシューに取り付ける
ビデオライトの点灯方式を設定する。
Power Link： 

本機の電源の入/切に連動してビデオラ
イトが点灯/消灯する。

Rec Link： 
本機の録画開始/終了に連動してビデ
オライトが点灯/消灯する。

Rec Link + Stby： 
本機の録画開始/終了に連動してビデ
オライトが点灯/スタンバイ点灯する。

Technical>APR
APRを実行します。

メニュー項目 細目と設定値 内容

APR Execute / Cancel APR（Auto Pixel Restoration：イメージ
センサーの自動調整）を実行する。
Execute：実行

［ご注意］
確実な遮光をするために、キャップを取り付けて、
さらに黒い布で周囲を覆ってください。

Technical>Camera Battery Alarm
バッテリーの電圧低下警告の設定を行います。

メニュー項目 細目と設定値 内容

Near 
End:Info 
Battery

5% ～ 100%（5%刻み） インフォバッテリー使用時にバッテリー残
量表示が点滅するしきい値を設定する。

End:Info 
Battery

0% ～ 5% インフォバッテリー使用時に「Battery End」
を表示するしきい値を設定する。

Near 
End:Sony 
Battery

11.5V ～ 17.0V（0.1V刻み） ソニー製の非インフォバッテリー使用時に
バッテリー残量表示が点滅するしきい値を
設定する。

End:Sony 
Battery

11.0V ～ 12.5V（0.1V刻み） ソニー製の非インフォバッテリー使用時に
「Battery End」を表示するしきい値を設定
する。
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Technical>Camera Battery Alarm
バッテリーの電圧低下警告の設定を行います。

メニュー項目 細目と設定値 内容

Near 
End:Other 
Battery

11.5V ～ 17.0V（11.8V）（0.1V刻み） ソニー製以外のバッテリー使用時にバッテ
リー残量表示が点滅するしきい値を設定す
る。

End:Other 
Battery

11.0V ～ 14.0V（0.1V刻み） ソニー製以外のバッテリー使用時に
「Battery End」を表示するしきい値を設定
する。

Detected 
Battery

Sony Info Battery / Sony Battery / 
Other Battery / DC IN

バッテリーの種類を自動判別した結果を表
示する。

Technical>Camera DC IN Alarm
入力電圧警告の設定を行います。

メニュー項目 細目と設定値 内容

DC Low 
Voltage1

11.5V ～ 17.0V（0.1V刻み） DC INへの入力電圧の低下警告を表示する
電圧を設定する。

DC Low 
Voltage2

11.0V ～ 14.0V（0.1V刻み） DC INへの入力電圧の不足警告を表示する
電圧を設定する。
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Networkメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Network>Network Setup
ネットワークに関する設定を行います。

メニュー項目 細目と設定値 内容

Setup for 
Mobile App

ネットワーク設定支援ツールを起動する。

User Name アクセス認証のためのユーザー名を設定す
る。

Input 
Password

アクセス認証のためのパスワードを設定す
る。

［ご注意］
セキュリティの観点から、パスワードには他人に
推測されにくく充分な長さのある文字列を設定
し、厳重に保管することを推奨します。

Generate 
Password

Execute / Cancel アクセス認証のためのパスワードを自動生
成する。
Execute：実行

Show 
Authentication

アクセス認証のユーザー名パスワードをテ
キストとQRコードで表示する。

LAN Type 
Select

WLAN (AP Mode) / WLAN (ST Mode) / 
Wired LAN / Off

LANの接続方法を設定する。

Network>Wireless LAN
ワイヤレスLAN接続に関する設定を行います。

メニュー項目 細目と設定値 内容

WPS Execute / Cancel WPS（Wi-Fi Protected Setup）による接
続設定を開始する。
Execute：実行

［ご注意］
セキュリティ設定されていない機器とWPSで接
続設定することはできません。

MAC 
Address

本機のワイヤレスLANインターフェースの
MACアドレスを表示する。

Network>AP Mode Settings
アクセスポイントモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Channel Auto(5GHz) / Auto / CH1 / CH2 / CH3 /  
CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

アクセスポイントモードのチャンネルを設
定する。

Channel 
Bandwidth(5GHz)

Transfer Speed Priority /  
Stability Priority

アクセスポイントモードを5GHz帯で動作
させた場合のチャンネルの帯域幅を設定す
る。

Camera SSID 
& Password

アクセスポイントモードのSSIDとパスワー
ドを表示する。

Regenerate 
Password

Execute / Cancel アクセスポイントモードのパスワードを再生
成する。
Execute：実行

IP Address アクセスポイントモードのIPアドレスを表示
する。

Subnet 
Mask

アクセスポイントモードのサブネットマスク
を表示する。
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Network>ST Mode Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Camera 
Remote 
Control

Enable / Disable ステーションモードで本機とワイヤレス
LAN接続されている操作用デバイスからの
リモートコントロールを許可するかどうかを
設定する。

Connected 
Network

接続中のワイヤレスLANネットワーク（アク
セスポイント）を表示する。

SSID 接続先アクセスポイントのSSIDを表示す
る。

Security 接続先アクセスポイントのセキュリティ種
別を表示する。

Password 接続先アクセスポイントのパスワードを表
示する。
セキュリティがWPA2またはWPA3時：

*******
セキュリティがNone時：空欄

DHCP DHCPの有効（On）、無効（Off）を表示する。
IP Address 本機のIPアドレスを表示する。
Subnet Mask サブネットマスクを表示する。
Gateway デフォルトゲートウェイを表示する。
DNS Auto DNS自動取得のON/OFFを表示する。
Primary DNS Server プライマリー DNSサーバーを表示する。
Secondary DNS Server セカンダリー DNSサーバーを表示する。

Network>ST Mode Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Scan 
Networks

ワイヤレスLANネットワーク（アクセスポイ
ント）を検出し、リスト表示する。
リストから接続先を選択し、接続する。

SSID 接続先アクセスポイントのSSIDを表示す
る。

Security 接続先アクセスポイントのセキュリティ種
別を表示する。

Password 接続先アクセスポイントのパスワードを入
力する。

［ご注意］
WPA2の場合、入力可能な文字数は8文字～ 63
文字です。WPA3の場合、入力可能な文字数は
8文字～ 128文字です。また、入力可能な文字は
以下です。
英字（大文字・小文字）、数字、記号（- . @ _ ( ) ! 
" # $ % & ' * + , / : ; < = > ? [ \ ] ^ ` { | } ~）

DHCP 
On / Off

DHCPの有効（On）、無効（Off）を設定する。

IP Address DHCPがOffのときに本機のIPアドレスを入
力する。

Subnet Mask DHCPがOffのときにサブネットマスクを入
力する。

Gateway DHCPがOffのときにデフォルトゲートウェ
イを入力する。

DNS Auto 
On / Off

DNS自動取得をOn/Offする。

Primary DNS Server DNS AutoがOffのときにプライマリー
DNSサーバーを入力する。

Secondary DNS Server DNS AutoがOffのときにセカンダリー
DNSサーバーを入力する。
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Network>ST Mode Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Manual 
Register

アクセスポイントと手動接続する。
SSID 接続先アクセスポイントのSSIDを入力す

る。

［ご注意］
入力可能な文字数は1文字～ 32文字です。また、
入力可能な文字は以下です。
英字（大文字・小文字）、数字、記号（- . @ _ ( ) ! 
" # $ % & ' * + , / : ; < = > ? [ \ ] ^ ` { | } ~）

Security 
None / WPA2 / WPA3

接続先アクセスポイントのセキュリティ種
別を設定する。

［ご注意］
•	 本機は、セキュリティ設定がWPA3-SAE、

WPA2-PSK (AES)、または、セキュリティ設
定なしのアクセスポイントに接続することが
可能です。セキュアな無線LAN接続を実現す
るために、セキュリティ設定がWPA3または
WPA2のアクセスポイントを使用することを、
強く推奨します。

•	 セキュリティ方式は初期状態でWPA2が選択
されています。

•	 セキュリティ設定なしのアクセスポイントに接
続すると、ハッキングや悪意ある第三者からの
アクセス、脆弱性への攻撃を受ける可能性が
あります。特別な理由がある場合以外は、セ
キュリティ設定なしでの使用は推奨しません。

•	 無線LANではセキュリティの設定をすることが
非常に重要です。セキュリティ対策を施さな
かった場合、あるいは無線LANの使用上やむ
を得ない事情により、セキュリティの問題が発
生してしまった場合、弊社ではこれによって生
じたあらゆる損害に対する責任を負いかねま
す。

Network>ST Mode Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Manual 
Register

Password 接続先アクセスポイントのパスワードを入
力する。

［ご注意］
WPA2の場合、入力可能な文字数は8文字～ 63
文字です。WPA3の場合、入力可能な文字数は
8文字～ 128文字です。また、入力可能な文字は
以下です。
英字（大文字・小文字）、数字、記号（- . @ _ ( ) ! 
" # $ % & ' * + , / : ; < = > ? [ \ ] ^ ` { | } ~）

DHCP 
On / Off

DHCPの有効（On）、無効（Off）を設定する。

IP Address DHCPがOffのときに本機のIPアドレスを入
力する。

Subnet Mask DHCPがOffのときにサブネットマスクを入
力する。

Gateway DHCPがOffのときにデフォルトのゲート
ウェイを入力する。

DNS Auto 
On / Off

DNS自動取得をOn/Offする。

Primary DNS Server DNS AutoがOffのときにプライマリー 
DNSサーバーを入力する。

Secondary DNS Server DNS AutoがOffのときにセカンダリー 
DNSサーバーを入力する。
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Network>Wired LAN
有線LAN接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Camera 
Remote 
Control

Enable / Disable 本機と有線LAN接続されている操作用デバ
イスからのリモートコントロールを許可する
かどうかを設定する。

Detail 
Settings

有線LAN接続の詳細設定を行う。
DHCP 
On / Off

DHCPの有効（On）、無効（Off）を設定する。

IP Address DHCPがOffのときに本機のIPアドレスを入
力する。

Subnet Mask DHCPがOffのときにサブネットマスクを入
力する。

Gateway DHCPがOffのときにデフォルトのゲート
ウェイを入力する。

DNS Auto 
On / Off

DNS自動取得をOn/Offする。

Primary DNS Server DNS AutoがOffのときにプライマリー 
DNSサーバーを入力する。

Secondary DNS Server DNS AutoがOffのときにセカンダリー 
DNSサーバーを入力する。

MAC 
Address

本機に搭載されている有線LANのMACア
ドレスを表示する。

Network>USB Tethering
USBテザリングの使用に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off スマートフォン接続の有効（On）、無効（Off）
を設定する。

Camera 
Remote 
Control

Enable / Disable スマートフォンアプリであるMonitor & 
ControlやCreators' App for enterprise
など、USBテザリング経由でのリモートコ
ントロールの可否を設定する。

Device 
Name

スマートフォンのDevice Nameを表示す
る。

IP Address 本機のIPアドレスを表示する。
Subnet 
Mask

サブネットマスクを表示する。

Network>File Transfer
ファイルの転送に関する設定を行います。

メニュー項目 細目と設定値 内容

Auto Upload On / Off オリジナルクリップの自動転送をOn/Offす
る。

［ご注意］
Projectメニュー >Simul RecのSetting（45
ページ）がOnに設定されている場合は、スロット
Bのメディア上に記録されるクリップは、自動転
送の対象にはなりません。

Auto Upload 
(Proxy)

On / Off On：
プロキシクリップの自動転送を有効に
する。

Off：
プロキシクリップの自動転送を無効に
する。

Default 
Upload 
Server

ファイルの転送先サーバーを選択する。こ
こで選択したサーバーは、オリジナルクリッ
プやプロキシクリップの自動転送先、およ
びクリップ一覧画面からのファイル転送先
のサーバーになる。
Server Settings 1 ～ 3で設定したDisplay 
Nameを表示する。

Clear 
Completed 
Jobs

Execute / Cancel 転送完了済みのジョブをリストからクリア
する。
Execute：実行

Clear All 
Jobs

Execute / Cancel すべての転送ジョブをリストからクリアす
る。
Execute：実行

View Job 
List

転送ジョブ一覧を表示する。
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Network>File Transfer
ファイルの転送に関する設定を行います。

メニュー項目 細目と設定値 内容

Server 
Settings1

Display Name 転送先設定のメニュー上の表示名を入力す
る。

Service 
FTP

サーバーの種類を表示する。

Host Name 転送先サーバーのホスト名を設定する。
Port（1 ～ 65535（21）） 転送先サーバーのポート番号を設定する。
User Name 転送先サーバー接続の認証用ユーザー名を

設定する。
Password 転送先サーバー接続の認証パスワードを設

定する。
Passive Mode 

On / Off (Active Mode)
PASVモードをOn/Offする。

Destination Directory 転送先のディレクトリー名を入力する。
Using Secure Protocol 

On / Off
セキュアなFTP転送（FTPSのExplicit 
Mode：FTPES）を行うか（On）、行わない
か（Off）を設定する。

Root Certificate 
Load / Clear / None

セキュアなFTP転送ためのルート証明書の
読み込み、削除を設定する。

Root Certificate Status 
Loaded / No Certificate

セキュアなFTP転送ためのルート証明書の
読み込み状態を表示する。

Reset 
Execute / Cancel

Server Settingsの設定を初期値に戻す。
Execute：実行

Server 
Settings2

Server Settings 1と同じ

Server 
Settings3

Server Settings 1と同じ

Network>Network Reset
ネットワークの設定をリセットします。

メニュー項目 細目と設定値 内容

Reset Execute / Cancel ネットワークの設定をリセットする。
Execute：実行
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Maintenanceメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Maintenance>Language
表示する言語を設定します。

メニュー項目 細目と設定値 内容

Select 表示する言語を設定する。
SET：実行

Maintenance>Clock Set
内蔵時計に関する設定を行います。

メニュー項目 細目と設定値 内容

Time Zone UTC -12:00 ～ UTC +14:00 UTCからの時差を30分単位で設定する。
Date Mode YYMMDD / MMDDYY / DDMMYY 年月日の表示方式を選択する。

YYMMDD：年月日の順
MMDDYY：月日年の順
DDMMYY：日月年の順

12h/24h 12h / 24h 時刻の表示形式を選択する。
12h：12時間表示
24h：24時間表示

Date 現在の日付を設定する。
SET：決定

Time 現在の時刻を設定する。
SET：決定

Maintenance>All Reset
工場出荷時の状態にリセットします。

メニュー項目 細目と設定値 内容

Reset Execute / Cancel 工場出荷時の状態へのリセットを実行す
る。
Execute：実行

［ご注意］
Paint/LookメニューのBase LookのImport 
from Utility SD、Import from Cloud(Private)
およびImport from Cloud(Share)（51ペー
ジ）でインポートした3D LUTファイルは削除され
ません。インポートした3D LUTファイルを削除
する場合は、Paint/LookメニューのBase Look
のDelete All （51ページ）を実行してくださ
い。

Maintenance>All Reset
工場出荷時の状態にリセットします。

メニュー項目 細目と設定値 内容

Reset 
without 
Network

Execute / Cancel Networkメニュー以下の設定を除いたメ
ニュー設定値を工場出荷状態にリセットす
る。

Reset to 
Factory 
Defaults

Execute / Cancel すべての設定やファイルを削除し、工場出荷状態
に戻す。

Maintenance>Hours Meter
積算時間を表示します。

メニュー項目 細目と設定値 内容

Hours
（System）

積算使用時間（リセット不可）を表示する。

Hours
（Reset）

積算使用時間（リセット可）を表示する。

Reset Execute / Cancel Hours（Reset）表示を0にリセットする。
Execute：実行

Maintenance>Version
バージョンを表示します。

メニュー項目 細目と設定値 内容

Version 
Number

Vx.xx 本機のソフトウェアバージョンを表示する。

Version Up Execute / Cancel
バージョン更新がある場合は「」が表示され
ます。

本機をバージョンアップ*する。
Execute：実行
*	 バージョンアップは本機のソフトウェアをアッ

プデートする機能です。

Lens Version 
Number

Vxx Eマウントレンズのソフトウェアバージョン番
号を表示する。



72 3章　カメラ操作

撮影モードごとの画質に関する設定状態の保存について
画質に関する設定項目は、現在の設定状態が保持されますが、項目によって以下の撮影モードごとに保存される項目と共通で保存される項目があります。個別に保存されている項目は、撮影モードを切り替
えると、切り替え後の撮影モードで保持されている設定状態が適用されます。
•	 Cine EIモード
•	 CustomモードのSDR(BT.709)
•	 CustomモードのHDR(HLG)
画質に関する各設定について撮影モードごとの保存状態は以下のようになっています。
：保存（撮影モード間でまたがっている場合は共通の内容）
－：該当撮影モードでは無効

設定項目 撮影モード
Cine EIモード Customモード

SDR(BT.709) HDR(HLG)
Shootingメニュー ISO/Gain/EI ISO/Gain －  1)

Exposure Index  －
Base Sensitivity － 

Base ISO  －
White 

White Setting 

LUT On/Off  －
Noise Suppression Setting(Custom) －  

Level(Custom) －  

Setting(Cine EI)  －
Level(Cine EI)  －

Paint/Lookメニュー Base Look Select   

Input2) 

Output2) 

AE Level Offset2) 

Black －  

Knee Auto Knee －  

上記以外 －  

Detail －  

Matrix －  

Multi Matrix －  

1)	 ISO感度については、CustomモードのSDR(BT.709)、HDR(HLG)で設定値が個別に保存される場合があります。
2)	設定値はBase Lookごとに保持されており、各撮影モードには依存しません。
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設定データの保存と読み込み
設定データ

フルメニューの設定内容を、SDカードに保存す
ることができます。また、Allファイルをクラウド
サービスに保存することができます。このデータ
を使って適切なセットアップ状態をすばやく再現
できます。
設定データは、次のように分類されて保存され
ます。

User File（ユーザーファイル）
カスタマイズしたUserメニューの設定項目と設定
データを保存します。
SDカードに64個まで保存することができます。
このファイルを本機のメモリーに読み込むことに
より、Userメニューをカスタマイズした状態に
セットアップすることができます。

All File（ALLファイル）
全メニューの設定データを保存します。SDカー
ドに64個まで保存することができます。C3 
Portal（クラウドサービス）には、個人60個まで
と共通60個までの計120個まで保存することが
できます。

［ご注意］
Allファイルに保存される内容については「ファイルに保存さ
れる項目」（132ページ）をご覧ください。

ユーザーファイル、ALLファイ
ルを保存する

SDカードに保存する

1	 SDカードをUtility SDカードスロット（4
ページ）に差し込む。

2	 ユーザーファイルの場合は、フルメニュー
のProjectメニュー >User FileのSave to 
UTILITY SD（49ページ）で、Executeを
選択する。
ALLファイルの場合は、フルメニュー
のProjectメニュー >All FileのSave to 
UTILITY SD（49ページ）で、Executeを
選択する。
ファイルの保存先画面が表示されます。

3	 保存先画面のNo Fileの行を選択する。
File IDが記載されている行を選択すると、
そのファイルに上書きされます。
保存する際に付けられるFile IDはメニューで
変更できます。設定方法については「File ID
を変更するには」（74ページ）をご覧くだ
さい。

4	 確認画面のExecuteを選択する。

Allファイルをクラウドサービスに保存
する

1	 本機をスマートフォンアプリ「Creators' App 
for enterprise」に接続する（86ページ）。

2	 フルメニューのProjectメニュー >All File
のSave to Cloud(Private)またはSave to 
Cloud(Share)（49ページ）で、Execute
を選択する。
ファイルの保存先画面が表示されます。

3	 保存先画面のNo Fileの行を選択する。
File IDが記載されている行を選択すると、
そのファイルに上書きされます。
保存する際に付けられるFile IDはメニューで
変更できます。設定方法については「File ID
を変更するには」（74ページ）をご覧くだ
さい。

4	 確認画面のExecuteを選択する。

ユーザーファイル、ALLファイ
ルを読み込む

［ご注意］
ユーザーファイルを読み込んだ際に各設定間での整合性を
担保するために、ユーザーファイルに関する設定以外の設
定値が自動的に変化する場合があります。

SDカードから読み込む

1	 ファイルを保存したSDカードをUtility SD
カードスロット（4ページ）に差し込む。

2	 ユーザーファイルの場合は、フルメニューの
Projectメニュー >User FileのLoad from 
UTILITY SD（49ページ）で、Executeを
選択する。
ALLファイルの場合は、フルメニューの
Projectメニュー >All FileのLoad from 
UTILITY SD（49ページ）で、Executeを
選択する。
ファイルの一覧画面が表示されます。

3	 読み込むファイルを選択する。
確認画面が表示されます。

4	 Executeを選択する。

［ご注意］
•	 設定データを読み込むと、本機は自動的に再起動され

ます。
•	 フルメニューのProjectメニュー >All FileのLoad 

Network DataがOffの場合は、Networkメニューの
設定項目を除いたALLファイルを読み込みます。

Allファイルをクラウドサービスから読
み込む

1	 本機をスマートフォンアプリ「Creators' App 
for enterprise」に接続する（86ページ）。

2	 フルメニューのProjectメニュー >All File
のLoad from Cloud(Private)またはLoad 
from Cloud(Share)（49ページ）で、
Executeを選択する。
ファイルの一覧画面が表示されます。

3	 読み込むファイルを選択する。
確認画面が表示されます。
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4	 Executeを選択する。

［ご注意］
•	 設定データを読み込むと、本機は自動的に再起動され

ます。
•	 フルメニューのProjectメニュー >All FileのLoad 

Network DataがOffの場合は、Networkメニューの
設定項目を除いたALLファイルを読み込みます。

File IDを変更するには

1	 ユーザーファイルの場合は、フルメニュー
のProjectメニューのUser Fileで、File ID

（49ページ）を選択する。
ALLファイルの場合は、フルメニューの
ProjectメニューのAll Fileで、File ID（49
ページ）を選択する。
File IDの編集画面が表示されます。

2	 マルチセレクター（9ページ）またはマル
チファンクションダイヤル（4ページ）で
文字を選択し、マルチセレクターの決定ボタ
ンまたはマルチファンクションダイヤルを押
す。

3	 手順2を繰り返す。

4	 文字の入力が終了したら、Doneを選択する。
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クリップ操作
CLIPSボタン（4ページ）を押すと、メモリーカードに収録されているクリップが、クリップ一覧画面に表示されます。
クリップ一覧画面で選択したクリップを再生することができます。クリップ一覧画面ではフルメニューのClip Operationsメニューを使用してクリップの操作や詳細情報の確認などが可能です。情報表示モード
のときは、LCDモニターで再生操作をすることができます（再生操作画面）。
CLIPSボタンを押すと、クリップ一覧画面を終了し、撮影画面に戻ります。

［ご注意］
•	 クリップ一覧画面には、現在選択している記録フォーマットで収録されたクリップのみが表示されます。収録したはずのクリップが表示されないときは、記録フォーマットをご確認ください。また、メディアのフォーマット（初期化）などを行う際には

ご注意ください。
•	 クリップ一覧画面を開いている状態で、フルメニューでパスワード関連の設定を開くと、外部モニターにメニューページが表示されますのでご注意ください。

クリップ一覧画面

画面下部には、カーソル位置のクリップの情報が表示されます。

4 6

7

53

1

2

現在選択されているメモリー
カードをハイライト表示

（プロテクトされている場合
は右にロックマーク表示）

カーソル（黄色）

クリップ番号／クリップ総数

1.	 サムネイル（縮小画）
各クリップの代表画像です。記録時にはクリップの
先頭フレームが自動的に代表画に設定されます。
サムネイルの下にはクリップ／フレーム情報が表
示されます。フルメニューのClip Operations
メニュー >Customize View（61ページ）の
Clips Captionで表示内容を変更できます。また、
クリップの状態がアイコンで表示されます。

アイコン 意味
（再生不可） 再生できないクリップ

［ご注意］
X-OCN(LT)フォーマットでは代表画像は表示されず、

「X-OCN」の文字が表示されます。

2.	クリップ名
選択されているクリップのクリップ名が表示され
ます。

3.	 記録時のビデオフォーマット
選択したクリップのファイルフォーマットが表示さ
れます。

4.	特殊記録撮影情報
特殊記録モードで記録されたクリップの場合の
み、そのモードが表示されます。
スロー＆クイックモーション記録されたクリップ
の場合は、右側にフレームレートが表示されます。

5.	 作成日時

6.	クリップの収録時間（Duration）

7.	 タイムコード
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再生操作画面

LCDモニターが情報表示モードの場合は、クリップ一覧画面で再生するクリップを選択すると、再生
操作画面が表示されます。機能表示部はタッチ操作に対応しています。

機能表示部

1 2 3

4 5 6

ITEMボタン4 ITEMボタン5 ITEMボタン6

ITEMボタン3ITEMボタン2ITEMボタン1

［ご注意］
1 ～ 6に表示される各項目はITEMボタン1 ～ 6にそれぞれ
対応しています。ITEMボタンを押すと、対応する項目の操
作ができます。

1.	 F Revボタン
逆方向に高速再生します。
押した回数に応じて3段変速します。

2.	 Play/Pauseボタン
クリップの再生または再生を一時停止します。

3.	 F Fwdボタン
順方向に高速再生します。
押した回数に応じて3段変速します。

4.	Prevボタン
逆方向にクリップの頭出しをします。

5.	 Stop/Clipsボタン
再生を停止し、クリップ一覧画面に戻ります。

6.	Nextボタン
順方向にクリップの頭出しをします。

ステータス表示部

1 2 3

7 6 58910

412
11

13

1.	 タイムデータ表示
再生位置のタイムコードが表示されます。

2.	フレームレート表示
再生クリップのフレームレートが表示されます。

3.	 電源電圧／バッテリー残量表示
電源電圧またはバッテリー残量が表示されます。

4.	  音声レベルメーター
再生音声レベルが表示されます。

5.	 特殊記録
再生クリップの特殊記録情報が表示されます。	

6.	画像解像度表示
画像解像度が表示されます。

7.	 コーデック名表示
コーデック名が表示されます。

8.	画像サイズ表示
画サイズが表示されます。

9.	クリップ番号／クリップ総数表示
再生中のクリップ番号／再生可能なクリップ総数
が表示されます。

10.	クリップ名表示
クリップ名が表示されます。

11.	 メディア表示
再生しているメディアが表示されます。
メモリーカードがプロテクトされている場合は、
右に （プロテクト）アイコンが表示されます。

12.	警告／エラーアイコン
警告またはエラーがあるときに表示されます。
メニューを表示させると、警告またはエラーの内
容が確認できます。外部モニターに画面表示を
重畳している場合は、外部モニターでも確認でき
ます。

13.	再生動作状態表示
再生動作状態が表示されます。
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Clip Operationsメニューの
操作方法

MENUボタンを長押ししてClip Operationsを選
択すると、Clip Operationsメニュー（61ペー
ジ）が表示されます。
マルチセレクター（5ページ）またはマルチファ
ンクションダイヤル（4ページ）を操作して機
能を選択し、マルチセレクターの決定ボタンまた
はマルチファンクションダイヤルを押してくださ
い。
BACKボタン（4ページ）を押すと、操作前の
画面に戻ります。

［ご注意］
メニューを表示させたときの状態によって選択できない項
目があります。

クリップの詳細情報画面を表示する

Clip OperationsメニューのDisplay Clip 
Properties（61ページ）を選択すると、クリッ
プの詳細情報画面を表示されます。
マルチセレクターの左ボタン／右ボタンを押すと、
前後のクリップへ移動することができます。

クリップフラグを付ける

クリップにクリップフラグ（OK、NG、KPマーク）
を付けると、クリップフラグを基準にクリップを
絞り込んで表示することができます。
クリップフラグを付けたいクリップを選択し、フ
ルメニューのClip OperationsメニューのSet 
Clip Flag（61ページ）からクリップフラグを選
びます。

設定値 付加されるクリップフラグ
Add OK OK

設定値 付加されるクリップフラグ
Add NG NG
Add KEEP KP

フィルタードクリップ一覧画面を表示
する

フルメニューのClip Operationsメニューの
Filter Clips（61ページ）で表示したいフラグ
を選ぶと、指定したフラグの付いているクリップ
のみを表示することができます。
すべてのクリップを表示するには、Allを選んでく
ださい。

［メモ］
DISPLAYボタンでフィルターを順に切り替えることもでき
ます。

クリップ一覧画面の情報を変更する

サムネイルの下に表示されるクリップ／フレーム
情報を変更します。
フルメニューのClip Operationsメニューの
Customize View>Clips Captionから、表示し
たい内容を選びます。
Clip Name：	

クリップ名
Date Time：	

作成日時または最終変更日時
Time Code：	

タイムコード
Duration：	

収録時間
Sequential Number：	

サムネイル番号
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再生
本機が記録停止中（Stby）のときは、記録したク
リップを再生することができます。

1	 再生するメモリーカードを入れる。

2	 CLIPSボタン（4ページ）を押す。
LCDモニターに再生アクティブなメディアの
クリップ一覧画面が表示されます。

3	 マルチセレクター（5ページ）またはマル
チファンクションダイヤル（4ページ）を
操作して、再生を開始したいクリップにカー
ソルを合わせる。

4	 マルチセレクターの決定ボタンまたはマルチ
ファンクションダイヤルを押す。
選択したクリップの先頭から再生が始まりま
す。

［ご注意］
本機は連続再生をしません。

再生操作について

再生操作は次のボタンで行います。
マルチセレクターの決定ボタンまたはマルチファ

ンクションダイヤル押し：再生を一時停止し
ます。 もう一度押すと再生に戻ります。

マルチセレクターの左ボタン／右ボタン押し：ク
リップの先頭または前後のクリップに移動し
ます。

マルチセレクターの左ボタン／右ボタン長押し：
高速再生します。 長押しをやめると標準再
生に戻ります。

BACK ボタン：再生を停止し、記録停止状態にし
ます。撮影画面またはホーム画面が表示され
ます。

再生操作画面のボタンで操作するには
LCDモニターが情報表示モードの場合は、再生
操作画面のボタンでも操作できます。
Play/Pauseボタン：再生を一時停止します。も
う一度押すと再生モードに戻ります。
Prev ／ Nextボタン：クリップの先頭または前後
のクリップに移動します。
F Fwdボタン／ F Revボタン：高速再生します。

Play/Pauseボタンを押すと標準再生に戻り
ます。

Stop/Clipsボタン：再生を停止し、クリップ一覧
画面になります。

［メモ］
タッチ操作で直接操作することもできます。

音声を聞く

標準再生モードでは、記録されている音声を内
蔵スピーカー（4ページ）またはヘッドホンで
モニターできます。
ヘッドホン端子（4ページ）にヘッドホンをつ
なぐと、内蔵スピーカーはオフになります。
モニターするチャンネルの選択および音量の調
整は、フルメニューのAudioメニュー > Audio 
OutputのMonitor CHおよびVolume（60
ページ）で行います。

頭出しする

クリップの先頭から再生するには再生画面の
Prevボタンを押して頭出しします。
PrevボタンまたはNextボタンを複数回押すこと
で、クリップを飛ばして頭出しすることができま
す。

メモリーカードを切り換える

メモリーカードが2枚装着されているときは、ク
リップ一覧画面でSLOT SELECTボタン（4
ページ）を押して切り換えます。

［ご注意］
再生中にメモリーカードを切り換えることはできません。ま
たスロットAからスロットBへの連続再生はできません。
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デバイスとLAN接続する
本機のLAN機能を使用して、スマートフォンやタ
ブレットなどの操作用デバイスと本機をLAN接続
することができます。
LAN接続されたデバイスと本機の間では、

「Monitor & Control」アプリケーションを用い
て、以下が可能です。
•	 リモート操作 

本機とLAN接続されたスマートフォンやタブ
レットから本機をリモート操作することができ
ます。

	 ［ご注意］
不正なアクセスが検出された場合、カメラが通信を受け
付けない状態になることがあります。その際は再度初め
から接続し直してください。

•	 ファイル転送 
本機のメモリーカードに記録したプロキシク
リップ（低解像度）やオリジナルクリップ（高解
像度）を、LAN経由でサーバーに転送すること
ができます。

•	 映像をモニタリング 
本機のカメラ映像や再生映像を、「Monitor & 
Control」アプリケーションを使ってデバイスで
モニタリングすることができます。

	 ［ご注意］
•	 本機はワイヤレスLANと有線LANを同時に使用でき

ません。
•	 本機はネットワーク機器（例えばルーター、スイッチン

グ・ハブ）ではありません。DoS攻撃（サービス妨害攻
撃）などのネットワーク経由での攻撃に対して、適切
な設定と管理を行うことができるネットワークに本機
を接続することを強く推奨します。

•	 本機のネットワークへの接続には、適切な設定と管
理が行われたルーターを介した接続、もしくは同機
能を有したLANポートへの接続をしてください。こ
のような接続をしない場合（例えばFree Wi-Fiなど）、
セキュリティ上の問題を生じる可能性があります。ルー
ターは適切な設定をすることにより、ネットワーク内
の機器へのDoS攻撃または機器の機能喪失に対する
十分な保護を提供します。何か異常を感じた場合は、

すぐにカメラをネットワーク接続から遮断してくださ
い。

「Monitor & Control」アプリケーショ
ン

デバイスの画面で本機の映像をモニタリングしな
がら、リモート操作や本機の設定をすることが
できるアプリケーションを用意しています。

	˜「Monitor & Control」アプリケーションについては、
お買い上げ店またはソニーのサービス窓口にご確認く
ださい。

ユーザー名とパスワードを設
定する

ネットワーク機能をご利用の際は、まず本機に
ユーザー名とパスワードを設定してください。

1	 フルメニューのNetworkメニュー
>Network SetupのUser Name（66ペー
ジ）を設定する。

2	 フルメニューのNetworkメニュー
>Network SetupのInput Password

（66ページ）を設定する。

	 ［メモ］
•	 パスワードを自動生成することもできます。Input 

Passwordの代わりにGenerate Passwordを実
行します。

•	 Show Authenticationでユーザー名やパスワード
を、文字やQRコードで見ることができます。

	 ［ご注意］
QRコードやパスワードを他者に盗み見られないよ
う、ご注意ください。特に映像出力フォーマットが
Monitor FHDの場合やHDMI出力の場合は、クリッ
プ一覧画面を開いている状態で、フルメニューでQR
コードやパスワードを表示すると、外部モニターにも
メニューページが表示されますのでご注意ください。

ワイヤレスLANアクセスポ
イントモード（Access Point
モード）で接続する

本機をアクセスポイントとして操作用デバイスと
ワイヤレスLAN 接続します。

スマートフォン／タブレット

WPS機能搭載のデバイスで接続する

デバイスがWPSをサポートしている場合には、
WPSでの接続が可能です。

1	 フルメニューのNetworkメニュー
>Network SetupのLAN Type Selectで、
WLAN (AP Mode)を選択する。

2	 フルメニューのNetworkメニュー
>Wireless LANのWPSを実行する。

3	 デバイスのNetwork設定／ Wi-Fi設定を開
き、Wi-FiをOnにする。

4	 デバイスのWi-Fi NetworkのSSID一覧か
ら、本機のSSIDを選択し、詳細Optionを
表示し、WPS Push Buttonを選択して接
続する。

	 ［ご注意］
•	 使用する機器によっては、操作が異なる場合があ

ります。
•	 本機のSSIDおよびPasswordは、フルメニュー

のNetworkメニュー >AP Mode Settingsの
Camera SSID & Password（66ページ）で表示
してご確認ください。

5	 Monitor & Controlアプリケーションで接
続する。

	 ［メモ］
本機に接続するための情報は、フルメニューの
Networkメニュー >Network SetupのShow 
Authentication（66ページ）で確認できます。
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デバイスでSSID、Passwordを入力し
て接続する

デバイス側で本機のSSIDとPasswordを入力し
て接続します。

1	 フルメニューのNetworkメニュー
>Network SetupのLAN Type Selectで、
WLAN (AP Mode)を選択する。

2	 デバイスのNetwork設定／ Wi-Fi設定を開
き、Wi-FiをOnにする。

3	 デバイスのWi-Fi NetworkのSSID一覧か
ら、本機のSSIDを選択し、Passwordを入
力して接続する。
本機のSSIDおよびPasswordは、Network
メニューのAP Mode SettingsのCamera 
SSID & Password（66ページ）でご確認
ください。

	 ［ご注意］
使用する機器によっては、操作が異なる場合があり
ます。

4	 Monitor & Controlアプリケーションで接
続する。

	 ［メモ］
本機に接続するための情報は、フルメニューの
Networkメニュー >Network SetupのShow 
Authentication（66ページ）で確認できます。

ワイヤレスLANステーション
モード（Stationモード）で接
続する

本機をクライアントとして既存のワイヤレスLAN
のアクセスポイントに接続します。操作用デバイ
スとはアクセスポイント経由で接続します。
接続したアクセスポイントの履歴は、過去10件
まで記憶されます。
接続履歴はALLファイルに保存されますが、アク
セスのパスワードは保存されないため、ALLファ
イル読み込み後の再接続の際にはパスワードの
入力が必要となります。

スマートフォン／
タブレット

アクセスポイント

コンピューター

WPS機能を使ってアクセスポイントに
接続する

アクセスポイントがWPS機能対応の場合は、簡
単な設定で接続することができます。

1	 アクセスポイントの電源を入れる。

2	 本機の電源を入れる。

3	 フルメニューのNetworkメニュー
>Network SetupのLAN Type Selectで、
WLAN (ST Mode)を選択する。

4	 フルメニューのNetworkメニュー >ST 
Mode SettingsのCamera Remote 
Control（67ページ）で、Enableを選択
する。

	 ［メモ］
Enableにするとスマートフォンからの操作が有効に
なります。

5	 フルメニューのNetworkメニュー
>Wireless LANのWPSを実行する。

6	 アクセスポイントのWPS ボタンを押す。
WPS ボタンの操作については、アクセスポ
イントの取扱説明書をご覧ください。
接続が完了すると、LCDモニターのネット
ワーク状態表示のアイコンが強度1以上で点
灯します。

	 ［ご注意］
接続に失敗した場合は手順1からやり直してください。

7	 デバイスをアクセスポイントに接続する。
接続のしかたについては、各機器の取扱説
明書をご覧ください。

8	 デバイスでMonitor & Controlアプリケー
ションを実行し、本機を選ぶ。

	 ［メモ］
本機に接続するための情報は、フルメニューの
Networkメニュー >Network SetupのShow 
Authentication（66ページ）で確認できます。

アクセスポイント自動検出機能を使っ
て接続する

1	「WPS機能を使ってアクセスポイントに接続
する」（80ページ）の手順1 ～ 4を行う。

2	 フルメニューのNetworkメニュー >ST 
Mode SettingsのScan Networks（67
ページ）で、Executeを選択する。
本機が接続先の検出を開始します。
接続先の候補が見つかると一覧表示されま
す。

3	 一覧から接続先を選択する。
ネットワーク（アクセスポイント）詳細設定画
面が表示されます。SSIDには選択した接続
先が表示されます。

4	 Passwordを選択し、パスワード入力画面
で接続先のアクセスポイントのパスワードを
入力する。
接続履歴にあるSSIDを選択すると、パスワー
ドを含んだ設定値が自動的に設定されます。
パスワードを設定したら、ネットワーク（アク
セスポイント）詳細設定画面に戻ります。
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5	 以下の接続設定を行う。
•	 DHCP 

DHCPを設定します。 
Onにすると、自動的に本機にIPアドレス
を割り当てます。 
手動で本機のIPアドレスを入力する場合
は、Offにします。

•	 IP Address 
本機のIPアドレスを入力します。 
DHCPがOffのときに有効です。

•	 Subnet Mask 
サブネットマスクを入力します。 
DHCPがOffのときに有効です。

•	 Gateway 
ゲートウェイを入力します。 
DHCPがOffのときに有効です。

•	 DNS Auto 
DNS自動取得設定をします。 
Onにすると、自動的にDNSサーバーのア
ドレスを取得します。DHCPがOnのとき
に有効です。

•	 Primary DNS Server 
プライマリー DNSサーバーを入力します。 
DNS AutoがOffのときに有効です。

•	 Secondary DNS Server 
セカンダリー DNSサーバーを入力します。 
DNS AutoがOffのときに有効です。

6	 設定が完了したらConnectを選択し、アク
セスポイントに接続する。

7	 デバイスをアクセスポイントに接続する。
接続のしかたについては、各機器の取扱説
明書をご覧ください。

8	 デバイスでMonitor & Controlアプリケー
ションを実行し、本機を選ぶ。

	 ［メモ］
本機に接続するための情報は、フルメニューの
Networkメニュー >Network SetupのShow 
Authentication（66ページ）で確認できます。

アクセスポイントの情報を手動で入力
して接続する

1	「WPS機能を使ってアクセスポイントに接続
する」（80ページ）の手順1 ～ 4を行う。

2	 フルメニューのNetworkメニュー >ST 
Mode SettingsのManual Register（68
ページ）を選択する。
ネットワーク（アクセスポイント）詳細設定画
面が表示されます。

3	 以下の接続設定を行う。
•	 SSID 

接続先のアクセスポイントのSSIDを入力
します。

•	 Security 
暗号化方式を選択します。

［ご注意］
•	 本機は、セキュリティ設定がWPA3-SAE、

WPA2-PSK (AES)、または、セキュリティ設定
なしのアクセスポイントに接続することが可能
です。セキュアな無線LAN接続を実現するため
に、セキュリティ設定がWPA3またはWPA2の
アクセスポイントを使用することを、強く推奨し
ます。

•	 セキュリティ方式は初期状態でWPA2が選択さ
れています。

•	 セキュリティ設定なしのアクセスポイントに接続
すると、ハッキングや悪意ある第三者からのア
クセス、脆弱性への攻撃を受ける可能性があり

ます。特別な理由がある場合以外は、セキュリ
ティ設定なしでの使用は推奨しません。

•	 無線LANではセキュリティの設定をすることが
非常に重要です。セキュリティ対策を施さなかっ
た場合、あるいは無線LANの使用上やむを得な
い事情により、セキュリティの問題が発生してし
まった場合、弊社ではこれによって生じたあらゆ
る損害に対する責任を負いかねます。

•	 Password 
接続先のアクセスポイントのパスワードを
入力します。

•	 DHCP 
DHCPを設定します。 
Onにすると、自動的に本機にIPアドレス
を割り当てます。 
手動で本機のIPアドレスを入力する場合
は、Offにします。

•	 IP Address 
本機のIPアドレスを入力します。 
DHCPがOffのときに有効です。

•	 Subnet Mask 
サブネットマスクを入力します。 
DHCPがOffのときに有効です。

•	 Gateway 
ゲートウェイのアドレスを入力します。 
DHCPがOffのときに有効です。

•	 DNS Auto 
DNS自動取得設定をします。 
Onにすると、自動的にDNSサーバーのア
ドレスを取得します。DHCPがOnのとき
に有効です。

•	 Primary DNS Server 
プライマリー DNSサーバーのアドレスを入
力します。 
DNS AutoがOffのときに有効です。

•	 Secondary DNS Server 
セカンダリー DNSサーバーのアドレスを入

力します。 
DNS AutoがOffのときに有効です。

4	 設定が完了したらConnectを選択し、アク
セスポイントに接続する。

5	 デバイスをアクセスポイントに接続する。
接続のしかたについては、各機器の取扱説
明書をご覧ください。

6	 デバイスでMonitor & Controlアプリケー
ションを実行し、本機を選ぶ。

	 ［メモ］
本機に接続するための情報は、フルメニューの
Networkメニュー >Network SetupのShow 
Authentication（66ページ）で確認できます。
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インターネットに接続する
本機は、USBテザリング、ワイヤレスLAN、有
線LANでインターネットに接続することができま
す。
あらかじめ本機にユーザー名とパスワードを設定
してください（79ページ）。

USBテザリングを使用して接
続する

USBケーブルで本機とスマートフォンを接続し、
スマートフォンの回線を使用してインターネットに
接続できます。

スマートフォンの通信設定をする

スマートフォンのテザリング通信を有効に設定し
ます。
詳しくは、スマートフォンの取扱説明書をご覧く
ださい。

スマートフォンを本機に取り付ける

本機のUSB-C端子（5ページ）にUSBケーブ
ルを接続し、スマートフォンを接続します。

［ご注意］
•	 スマートフォンの取り付け／取り外しは、本機の電源を

切った状態で行ってください。
•	 USBハブを介してスマートフォンを取り付けた場合、

USBテザリングは使用できません。
•	 テザリングを行うスマートフォンは、信頼できるデバイス

のみを使用してください。セキュリティ上安全ではない
ため、素性が不明なデバイスとの接続は推奨しません。

ネットワークに接続する

1	 本機の電源を入れる。

2	 フルメニューのNetworkメニューのUSB 
Tetheringで、Setting（69ページ）をOn
に設定する。

スマートフォンからの操作を有効にす
る

USBケーブルで接続したスマートフォンで
Monitor & Controlアプリケーションを使用して
本機を遠隔操作できます。

1	 フルメニューのNetworkメニュー >USB 
TetheringのCamera Remote Control

（69ページ）をEnableに設定する。

2	 スマートフォンでMonitor & Controlアプリ
ケーションを実行し、本機を選ぶ。

	 ［メモ］
Monitor & Controlアプリケーションが本機に接続
するための情報は、フルメニューのNetworkメニュー
>Network SetupのShow Authentication（66
ページ）で確認できます。

ワイヤレスLANステーション
モード（Wi-Fi Stationモード）
で接続する

Wi‑Fiルーター（別売）またはスマートフォンの
Wi-Fiテザリングを使用することによって、Wi-Fi
ステーションモードでインターネットに接続する
ことができます。
Wi‑Fiルーターまたはデバイスへは、「ワイヤレス
LANステーションモード（Stationモード）で接続
する」（80ページ）の手順で接続します。

スマートフォン／
タブレット

Wi‑Fiルーター

コンピューター

インターネット

スマートフォン／
タブレット

インターネット

LANケーブルを使用して接続
する

本機のネットワーク端子とWi‑Fiルーター（別売）
をLANケーブルで接続することによって、インター
ネットに接続することができます。

スマートフォン／
タブレット

コンピューター

Wi-Fiルーター

インターネット
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LANケーブルの接続と有線LAN設定

1	 本機のネットワーク端子とWi‑Fiルーターを
LANケーブルで接続する。

2	 本機の電源を入れる。

3	 フルメニューのNetworkメニュー > 
Network SetupのLAN Type Selectで、
Wired LANを選択する。

4	 NetworkメニューのWired LANのDetail 
Settings（69ページ）で、接続設定を行う。
•	 DHCP 

DHCPを設定します。 
Onにすると、自動的に本機にIPアドレス
を割り当てます。 
手動で本機のIPアドレスを入力する場合
は、Offにします。

•	 IP Address 
本機のIPアドレスを入力します。 
DHCPがOffのときに有効です。

•	 Subnet Mask 
サブネットマスクを入力します。 
DHCPがOffのときに有効です。

•	 Gateway 
ゲートウェイのアドレスを入力します。 
DHCPがOffのときに有効です。

•	 DNS Auto 
DNS自動取得設定をします。 
Onにすると、自動的にDNSサーバーのア
ドレスを取得します。DHCPがOnのとき
に有効です。

•	 Primary DNS Server 
プライマリー DNSサーバーのアドレスを入
力します。 
DNS AutoがOffのときに有効です。

•	 Secondary DNS Server 
セカンダリー DNSサーバーのアドレスを入
力します。 
DNS AutoがOffのときに有効です。

5	 設定が完了したらSetを選択し、設定内容を
確定する。

［ご注意］
接続設定を変更した場合、必ずSetを選択してください。
Setを選択しなかった場合は設定した内容が反映されませ
ん。

有線LANを経由したスマートフォンか
らの操作を有効にする

有線LANで接続したWi-Fiルーターの先から、ス
マートフォンでMonitor & Controlアプリケー
ションを使用して本機を遠隔操作できます。

1	 フルメニューのNetworkメニュー > Wired 
LANのCamera Remote Control（69
ページ）をEnableに設定する。

2	 スマートフォンでMonitor & Controlアプリ
ケーションを実行し、本機を選ぶ。

［メモ］
Monitor & Controlアプリケーションが本機に接続す
るための情報は、フルメニューのNetworkメニュー > 
Network SetupのShow Authentication（66ページ）
で確認できます。
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ファイルを転送する
本機に記録したプロキシクリップやオリジナルク
リップを、スマートフォンやアクセスポイント経
由で接続したインターネット上のサーバーやロー
カルネット上のサーバーへ転送することができま
す。

準備する

ネットワークに接続する

「インターネットに接続する」（82ページ）また
は「デバイスとLAN接続する」（79ページ）の
手順に従って、本機をインターネットまたはロー
カルネットワークに接続します。

ファイルの転送先を登録する

あらかじめファイルを転送するサーバーを登録し
ておきます。

1	 フルメニューのNetworkメニューのFile 
Transferで、Server Settings1（または
Server Settings2、Server Settings3）を
選択する。
転送先設定画面が表示されます。

2	 転送先設定画面の各項目を設定する。
Display Name
転送先のリストに表示されるサーバー名を入
力します。
Service
サーバーの種類を表示します。

「FTP」：FTP サーバー
Host Name
サーバーのアドレスを入力します。

Port
サーバーに接続する際のポート番号を入力し
ます。
User Name
ユーザー名を入力します。
Password
パスワードを入力します。
Passive Mode
パッシブモードのON/OFFを行います。
Destination Directory
転送先ディレクトリー名を入力します。

	 ［ご注意］
•	 オリジナルクリップは、転送先として指定したディ

レクトリー内の“Main”フォルダーに転送されます。
•	 編集時、編集不可能な文字は“”で表示されます。

この文字を含むディレクトリー名を編集した場合
の動作は保証されません。 
もし編集してしまった場合は、すべての文字を削除
して入力し直してください。

•	 転送先サーバーで使用できない文字を
Destination Directoryに入力した場合、ファイ
ルはユーザーのホームディレクトリーに転送されま
す。使用できない文字はサーバーによって異なりま
す。

Using Secure Protocol
セキュアなFTP転送を行うかどうかを設定し
ます。
Root Certificate
証明書の読み込みや消去を行います。
•	 Load 

手順3でSetを選択すると、CA証明書を
読み込みます。
*	 読み込む証明書はPEM形式で、Utility SDカー

ドスロットに挿入したSDカードのルートディレク
トリーに“certification.pem”のファイル名で書
き込んでおいてください。

［メモ］
証明書の有効性の確認方式はOCSPです。また、
証明書の構造は以下のとおりです。 
-----BEGIN CERTIFICATE----- 
(Your Root certificate) 
-----END CERTIFICATE-----

•	 Clear 
手順3でSetを選択すると、CA証明書を
クリアします。

•	 None 
読み込み／消去を行いません。

	 ［ご注意］
•	 CA証明書を読み込む際は、本機の時刻を正しく

設定してください。
•	 XAVC-I 4096×2160P/3840×2160P、XAVC 

H-I HQ/SQ、X-OCNで記録中は、Loadは選択で
きません。

•	 低電圧時には、CA証明書をLoad/Clearすること
はできません。

Root Certificate Status
証明書の読み込み状態を表示します。
Reset
Server Settingsの設定を初期値に戻しま
す。

3	 設定が完了したらSetを選択し、設定内容を
確定する。
設定完了後は、必ずSetを選択してください。
Setを選択しなかった場合、設定した内容が
反映されません。

クリップを選んで転送する

本機のメモリーカードに記録したプロキシクリッ
プやオリジナルクリップをサーバーに転送します。

クリップ一覧画面からメモリーカード
のプロキシクリップを転送する

1	 本機とデバイスをLAN接続する（79ペー
ジ）。

2	 フルメニューのClip Operationsメニューの
Transfer Clip (Proxy)で、Select Clipを選
択する。
画面がフルメニューからクリップ一覧画面に
変わります。
転送操作は、クリップ一覧画面またはフィル
タードクリップ一覧画面で行えます。

3	 転送したいクリップを選択し、最後にMENU
ボタンを押す。
転送実行の確認画面が表示されます。

4	 Executeを選択する。
選択したプロキシクリップに対応するファイ
ル群が転送ジョブとして登録され、転送が
開始されます。
転送ジョブへの登録が完了すると、登録結
果画面が表示されます。

5	 OKを選択する。
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クリップを一括転送するには
手順2でSelect Clipではなく、All Clipsを選択
するとプロキシクリップに対応するファイル群が
一括転送されます。

［ご注意］
転送ジョブの上限は200件です。

クリップ一覧画面からメモリーカード
のオリジナルクリップを転送する

［ご注意］
オリジナルクリップは、転送先として指定したディレクト
リー内の“Main”フォルダーに転送されます。

1	 本機とデバイスをLAN接続する（79ペー
ジ）。

2	 フルメニューのClip Operationsメニューの
Transfer Clipで、Select Clipを選択する。
画面がフルメニューからクリップ一覧画面に
変わります。
転送操作は、クリップ一覧画面またはフィル
タードクリップ一覧画面で行えます。

3	 転送したいクリップを選択し、最後にMENU
ボタンを押す。
転送実行の確認画面が表示されます。

4	 Executeを選択する。
選択したクリップに対応するファイル群が転
送ジョブとして登録され、転送が開始されま
す。
転送ジョブへの登録が完了すると、登録結
果画面が表示されます。

5	 OKを選択する。

クリップを一括転送するには
手順2でSelect Clipではなく、All Clipsを選択
するとファイルが一括転送されます。

［ご注意］
転送ジョブの上限は200件です。

ファイル転送の確認をする

フルメニューのNetworkメニューのFile 
TransferでView Job List（69ページ）を選択
すると、ファイル転送の状態を確認することがで
きます。
Monitor & Controlアプリケーションの画面から
ファイル転送の状態を確認することもできます。

［メモ］
フルメニューのNetworkメニューのFile TransferでAuto 
Upload（69ページ）またはAuto Upload (Proxy)

（69ページ）をOnに設定すると、ネットワーク接続状態
の場合、記録終了時にDefault Upload Server（69ペー
ジ）で設定されたサーバーに対して自動的にオリジナルク
リップやプロキシクリップを送信します。オリジナルクリッ
プとプロキシクリップの両方を自動転送設定している場合
には、プロキシクリップが優先して自動転送されます。

［ご注意］
•	 転送ジョブは200件まで登録可能です。
•	 ジョブリストは本機の電源を切っても保持されますが、

電源スイッチをSTANDBYにせずにバッテリーパックを
取り外すなどして電源を切った場合には、最大で10分
間分程度の進捗情報が喪失する可能性があります。

•	 バッテリー電圧低下状態に陥った後に追加されたジョブ
については、ジョブリスト上に保存されません。

•	 ファイル転送中に転送がエラーになると、転送先サー
バーの設定や状態によっては、同じ名前のクリップが転
送できなくなることがあります。その場合は転送先サー
バーの設定や状態を確認してください。

クリップを自動転送する

オリジナルクリップを自動転送する

記録終了時にオリジナルクリップを指定した
サーバーに転送します。この機能を有効にする
には、フルメニューのNetworkメニューのFile 
TransferでAuto Upload（69ページ）をOnに
設定します。

プロキシクリップを自動転送する

記録終了時にプロキシクリップを指定したサー
バーに転送します。この機能を有効にするに
は、フルメニューのNetworkメニューのFile 
TransferでAuto Upload (Proxy) （69ペー
ジ）をOnに設定します。

セキュアなFTP転送を行うに
は

ファイル転送先サーバーとの接続にFTPSの
Explicitモード（FTPES）を使用することで、ファ
イルを暗号化して転送することができます。

セキュアなFTP転送の設定

セキュアなFTP転送を行うには、ファイル転送先
サーバーの設定で、Using Secure Protocolを
ONに設定し、証明書の読み込みを行います。
設定方法については、「ファイルの転送先を登録
する」（84ページ）をご覧ください。
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Creators' App for enterpriseを使用する
本機はスマートフォンアプリ「Creators' App for 
enterprise」と連携して、クラウドサービス「C3 
Portal」へのファイル転送を簡単に行うことがで
きます。
あらかじめC3 Portalのアカウントを取得し、ス
マートフォンにCreators' App for enterpriseを
インストールしてください。
クラウドサービス「C3 Portal」のアカウント取得
については、所属組織の管理者にお問い合わせ
ください。

［ご注意］
•	 お住まいの地域によってはサービスを提供していない場

合があります。
•	 Creators' App for enterpriseの操作方法については、

Creators' App for enterpriseのヘルプをご覧くださ
い。

ファイルをC3 Portalへ転送
する

1	 フルメニューのNetworkメニュー > 
Network Setupで、Setup for Mobile 
App（66ページ）を選択する。
自動変更される項目の確認画面が表示され
ます。
Networkメニューの設定が次のように自動
変更されます。
•	 USB Tethering>Setting：On
•	 USB Tethering>Camera Remote 

Control：Enable
•	 Network Setup>Input Password：未

設定の場合自動生成

2	 設定内容を確認してOKを選択する。

設定が開始されます。設定中は「Now 
changing」のメッセージが表示されます。
設定が正常に終了すると、ビューファイン
ダーに次の画面が表示されます。

アクセス認証の下記の情報を表示します。
ユーザー名、パスワード、フィンガープリント、
カメラのモデル名、シリアル番号

	 ［メモ］
本画面は映像出力へ出力されません。

	 ［ご注意］
パスワードを盗み見られたり、QRコードの画像を流
出させないように注意してください。特に映像出力
フォーマットがMonitor FHDの場合やHDMI出力の
場合は、クリップ一覧画面を開いている状態で、フル
メニューでQRコードやパスワードを表示すると、外
部モニターにもメニューページが表示されますのでご
注意ください。

3	 スマートフォンでCreators' App for 
enterpriseを実行し、クラウドサービスに
サインインする。

4	 本機のUSB-C端子とスマートフォンを、USB
ケーブルで接続する。

5	 スマートフォンの画面でUSBテザリングを有
効にする。
設定方法については、「USBテザリングを使
用して接続する」（82ページ）をご覧くだ
さい。

お使いのスマートフォンにより、操作が異な
ります。スマートフォンの取扱説明書をご確
認ください。

6	 Creators' App for enterpriseの画面の指
示に従って、ビューファインダーに表示され
たQRコードを撮影する。
スマートフォンから本機へファイル転送の設
定情報が送られ、次のメッセージが表示さ
れます。

7	 OKを選択する。
設定の読み込みが開始されます。
設定の読み込みが正常に終了すると、

「Network File loaded.」のメッセージが表
示されます。

［ご注意］
•	 Creators' App for enterpriseは、本機のNetworkメ

ニューのFile Transfer（69ページ）の設定を書き換え
ます。

•	 Root Certificateは自動では設定できません。手動で
設定してください。

オリジナルクリップを転送する

NetworkメニューのFile TransferのAuto 
Upload（69ページ）をOnにすると、オリジナ
ルクリップをC3 Portalへ転送できます。
記録を終了するたびに、C3 Portalのアカウント
に紐づけされた場所へファイルが転送されます。

プロキシクリップを転送する

NetworkメニューのFile TransferのAuto 
Upload (Proxy)（69ページ）をOnにすると、

プロキシクリップをC3 Portalへ転送できます。
記録を終了するたびに、C3 Portalのアカウント
に紐づけされた場所へファイルが転送されます。

任意のクリップを転送する

「クリップを選んで転送する」（84ページ）を
ご覧ください。

［メモ］
•	 本機が送信したファイルは、Creators' App for 

enterpriseでキャッシュされながらC3 Portalへ転送
されます。本機のファイル転送状態表示は、Creators' 
App for enterpriseへの転送状況を示しています。

•	 本機からスマートフォンのCreators' App for 
enterpriseへファイル転送が終了した後は、本機の電
源を切ることができますが、スマートフォンからのファイ
ル転送は継続している場合があります。スマートフォン
の電池残量にはご注意ください。

C3 Portalを使用したその他
の機能

3D LUTファイルを管理する

C3 Portal側で保存された3D LUTファイルを本
機にインポートできます。「クラウドサービスから
インポートする」（92ページ）をご覧ください。

Allファイルを管理する

本機で作成したAllファイルをC3 Portalに
保存したり、読み出したりして利用できます。

「Allファイルをクラウドサービスに保存する」
（73ページ）、「Allファイルをクラウドサービ
スから読み込む」（73ページ）をご覧ください。
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本機の基本動作を設定する
撮影を始める前に、運用形態に合わせて、
Projectステータス画面で基本動作の設定を行
います。

撮影モード

本機では、ポストプロダクション処理を前提とし、
現場では画作りを行わないフィルムカメラと同等
の使いかたができる「Cine EI」と、現場で自在に
映像の作り込みができる「Custom」を切り替えて
使用できます。
ProjectステータスのShooting Mode

（29ページ）で切り替えます。

［メモ］
フルメニューのProjectメニュー >Base Settingの
Shooting Mode（44ページ）でも設定できます。

Cine EI

撮影モードがCine EIのときは、記録信号および
出力信号のベースとなる色域を選択します。ここ
で選択した色域が記録映像およびモニター LUT
をOffに設定した映像出力の色域となります。
フルメニューのProjectメニュー >Cine EI 
SettingのColor Gamut（45ページ）で切り
替えます。
•	 S-Gamut3.Cine/SLog3：デジタルシネマの

色域（DCI-P3）への調整がしやすい色域
•	 S-Gamut3/SLog3：ソニー独自のITU-R 

BT.2020をカバーする広い色域
その他詳細は93ページをご覧ください。

［ご注意］
•	 Cine EIでは以下の制約があります。

•	 自動調節（追尾）できない機能
	‒ ホワイトバランス

	‒ ゲイン
	‒ シャッター

•	 設定変更できない機能
	‒ ISO感度／ゲイン（基準ISO感度に固定）
	‒ Paint/Lookメニューの設定（Base Lookを除く）
	‒ Scene File（無効）

•	 以下の機能はCine EIでのみ使用可能です
（93ページ）。

•	 Exposure Index
•	 モニター LUT

•	 Cine EIでの記録中は、Exposure Indexの設定を固定
にすることをお勧めします。Exposure Indexの設定を
変更してしまうと、ポストプロダクション処理での明る
さ補正が非常に難しくなり、撮影時の状態を再現できな
い恐れがあります。

Custom

撮影モードがCustomのときは、映像規格を選
ぶことができます。
フルメニューのProjectメニュー >Base Setting
のTarget Display（44ページ）で切り替えま
す。
•	 SDR(BT.709)：HD放送の規格に準じた撮影
•	 HDR(HLG)：次世代の4K放送の規格に準じた

撮影
その他詳細は94ページをご覧ください。

システム周波数

ProjectステータスのFrequency/Scan
（29ページ）で切り替えます。設定値によって
は、切り替えを実行すると本機が自動的に再起
動します。

［メモ］
フルメニューのProjectメニュー >Rec Formatの
Frequency（44ページ）でも設定できます。

［ご注意］
記録・再生中にシステム周波数を切り替えることはできま
せん。

イメージャースキャンモード

イメージセンサーの有効画サイズと解像度の設
定を行います。
ProjectステータスのImager Scan

（29ページ）で切り替えます。
•	 FF 8.6K 16:9、FF 8.6K 17:9、FFc 6K 16:9、

FF 5.8K 6:5、FFc 6K 17:9、FFc 3.8K 16:9：
フルサイズで使用します。

•	 S35 5.8K 16:9、S35 5.8K 17:9、S35 4.3K 
4:3、S35c 4K 17:9、S35c 3.8K 16:9、S35 1.9K 
16:9：Super 35mmサイズで使用します。

［メモ］
フルメニューのProjectメニュー >Rec FormatのImager 
Scan Mode（44ページ）でも設定できます。

［ご注意］
記録・再生中にイメージャースキャンモードを切り替えるこ
とはできません。
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有効画サイズについて

本機では、以下の有効画サイズでの撮影が可能です。（単位：ミリメートル）

FF 8.6K 16:9
(35.9x20.2)

FF 8.6K 17:9
(35.9x18.9)

FFc 6K 16:9
(33.6x18.9) 

FFc 6K 17:9
(33.6x17.7) 

S35 1.9K 16:9
S35 5.8K 16:9

(24.0x13.5)

S35 5.8K 17:9
(24.0x12.6)

S35c 4K 17:9
(17.0x9.0)

S35 4.3K 4:3
(23.6x17.7)

FFc 3.8K 16:9
(32.0x18.0)

FF 5.8K 6:5
(24.2x20.2)

S35c 3.8K 16:9
(16.0x9.0)

コーデック

ProjectステータスのCodec（29ページ）で切
り替えます。設定値によっては、切り替えを実行
すると本機が自動的に再起動します。

［メモ］
フルメニューのProjectメニュー >Rec FormatのCodec

（44ページ）でも設定できます。

［ご注意］
•	 記録・再生中にコーデックを切り替えることはできませ

ん。
•	 	X-OCNとXAVCを切り替えたとき、本機は再起動します。
•	 	X-OCNのとき、映像出力信号に制限がかかります。詳

細は121ページをご覧ください。
•	 X-OCNに切り替えるには、撮影モードをCine EIにして

おく必要があります。

ビデオフォーマット

記録するビデオフォーマットの設定を行い
ます。ProjectステータスのVideo Format

（29ページ）で切り替えます。

［メモ］
フルメニューのProjectメニュー >Rec FormatのVideo 
Format（44ページ）でも設定できます。

［ご注意］
•	 	X-OCNのときは設定できません。
•	 記録・再生中にビデオフォーマットを切り替えることは

できません。
•	 ビデオフォーマットの設定によって、SDI OUTおよび

HDMI OUT端子からの信号も制限されます。
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基本操作手順
基本的な撮影は次の手順で行います。

1	 必要な機器が取り付けられ、電源が供給さ
れていることを確認する。

2	 メモリーカードを入れる。

	 ［ご注意］
撮影の前にはクリップのバックアップを取ったあと、
フルメニューのTC/MediaメニューのFormat Media

（55ページ）で記録メディアのフルフォーマットを
行ってください。

3	 電源を入れる。
電源ランプが点灯して、LCDモニターに撮影
画面が表示されます。

4	 REC（記録開始／記録停止）ボタン（4ペー
ジ）を押す。
RECランプが点灯して、記録が始まります。

5	 記録を終了するときは、もう一度REC（記録
開始／記録停止）ボタンを押す。
記録が停止し、本機はSTBY（記録待機）モー
ドになります。

［ご注意］
電源を入れてから数秒以内にREC（記録開始／記録停止）ボ
タンを押すと、RECランプが点灯し録画状態になりますが、
選択している記録フォーマットによっては最初の数秒間はメ
ディアに記録されない場合があります。

メモリーカードを切り替える

メモリーカードが2枚装着されているときは、
SLOT SELECTボタン（4ページ）を押して切り
替えます。
撮影中にメモリーカードA（またはメモリーカード
B）の残量がなくなる直前に、自動的にもう一方
のメモリーカードへの記録に切り替わります（リ
レー記録）。メモリーカードが切り替わるたびに、
記録済みのメモリーカードを新しいメモリーカー
ドに交換することで、中断することなく撮影を続
けられます。

［ご注意］
再生中にメモリーカードを切り替えることはできません。ま
たスロットAとスロットBをまたぐ連続再生はできません。

クリップ（記録データ）
記録を停止すると、開始から停止までの画像・音
声と付随データが、1つの「クリップ」としてメモリー
カードに記録されます。

クリップ名について
本機で記録されるクリップの名前は、フルメ
ニューのTC/MediaメニューのClip Name 
Format（55ページ）で設定された形式でつけ
られます。

クリップの最大時間
1クリップあたり6時間までです。
動画の連続撮影可能時間は、クリップの最大記
録時間と同様です。録画時間がクリップの最大時
間を超える場合、録画を継続したまま自動的に
新しいクリップが作られます。新しいクリップはク
リップ一覧画面で別のクリップとして確認できま
す。

リレー記録では複数のクリップに連続記録します
が、XAVCの場合、約24時間で自動的に停止し
ます。

［ご注意］
•	 記録中のメモリーカードを取り出さないでください。記

録中にメモリーカードを入れ替えるときは、スロットの
ランプが消灯しているスロットのみ行ってください。

•	 記録中のメモリーカードの残量が1分未満のときに、も
う一方のスロットに記録可能なメモリーカードが入って
いると、メッセージ「まもなくスロットを切り替えます」
が表示されます。メモリーカードスロットが切り替わる
と消えます。

•	 メモリーカードの残量が1分未満のときに記録を始める
と、リレー記録ができない場合があります。リレー記録
を正しく行うには、記録開始時にメモリーカードの残量
が1分以上あることを確認してください。

•	 本機を使ってリレー記録した動画は、本機上ではシーム
レス再生できません。

•	 本機を使ってリレー記録した動画を結合するには、ソフ
トウェア「Catalyst Browse」を使用してください。

音声を聞く

記録される音声をヘッドホンでモニターできます。
ヘッドホン端子（4ページ）にヘッドホンをつ
なぐと、記録される音声をモニターできます。また、
再生時（78ページ）は内蔵スピーカー（4
ページ）またはヘッドホンでモニターできます。
モニターする音声の音量の調整は、Audioス
テータスのVolume（29ページ）、またはフル
メニューのAudioメニュー >Audio Outputの
Volume（60ページ）で行います。
モニターするチャンネルの選択は、Audioステー
タスのMonitor CH（29ページ）、またはフル
メニューのAudioメニュー >Audio Outputの
Monitor CH（60ページ）で行います。

タイムデータ

タイムコードを設定する

記録されるタイムコードは、フルメニューのTC/
MediaメニューのTimecode（54ページ）で設
定します。

ユーザービットを設定する

8桁の16進数をユーザービットとして記録映像に
付加できます。ユーザービットを現在時刻に設
定することも可能です。TC/Mediaメニューの
Users Bit（54ページ）で設定します。

タイムデータを表示する

表示するタイムコードは、TC/Mediaメニューの
TC Display（54ページ）のDisplay Selectで
設定します。
DURATION/TC/U-BIT機能が割り当てられたア
サイナブルボタン（108ページ）を押すと、表示
がタイムコード、ユーザービット、経過時間の順
に切り替わります。

タイムコードの入力／出力を切り替え
る

TC/REF IN/OUT切り替えスイッチ（6ページ）
で、タイムコードの入力／出力を切り替えること
ができます。
詳しくは116ページをご覧ください。
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記録内容を確認する（レック
レビュー）

直前に記録したクリップの映像を画面で確認
（レックレビュー）できます。

［ご注意］
記録後にビデオフォーマットを変更したときは、レックレ
ビューはできません。

レックレビューの方法

事前にアサイナブルボタンのいずれかにRec 
Reviewを割り当てておきます。
記録を停止したら、Rec Reviewが割り当てられ
たアサイナブルボタン（108ページ）を押します。
すると、直前に記録したクリップの再生が始まり
ます。
クリップの終わりまで再生すると、レックレビュー
は終了し、STBY（記録待機）モードに戻ります。

レックレビューを中止するには

Rec Reviewが割り当てられたアサイナブルボタ
ンまたはBACKボタンを押します。

レックレビューの設定

TechnicalメニューのRec Review
（62ページ）の設定により、再生開始位置を
次のいずれかに設定できます。
•	 クリップの最後の3秒
•	 クリップの最後の10秒
•	 クリップの先頭から

［メモ］
撮影した複数のクリップから任意のクリップを確認したい
場合は、CLIPSボタンを押してクリップ一覧画面からクリッ
プを選択して再生を開始することができます。
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基本ルックについて
本機の基本ルックは、明るさのトーンやコントラスト（Gamma）と色味（Matrix）の組み合わせによっ
て構成されており、この基本ルックを切り替えることで、外部出力映像および記録信号のルックを変
更できます。
基本ルックには工場出荷状態からあらかじめ定義されているプリセット基本ルックと、PCなどで作成
した3D LUTファイルを用いたユーザー基本ルックの2種類があります。

好みの基本ルックをインポートする

本機は、PCなどで作成した3D LUTファイルを、基本ルックとしてメモリーカードまたはクラウドサー
ビスから最大16個までインポートすることができます。
•	 ファイル形式：Catalyst BrowseやRAW Viewer、Blackmagic Design Pty. Ltd.製DaVinci 

Resolveで生成される17格子または33格子のCUBEファイル（*.cube）

［メモ］
インポートするCUBEファイルのファイルサイズは33格子の場合で1MB程度を想定しています。これを超えるファイルサイズ
のCUBEファイルはインポートできません。
ファイルサイズによってはインポートできても、本機の不揮発メモリー内にオリジナルのCUBEファイルを保存できないこと
があります。この場合、フルメニューのProjectメニュー > Cine EI Setting > Embed LUT File（45ページ）がOnになっ
ていても3D LUTファイルのメタデータ記録はできません。
このような基本ルックの場合は、基本ルックのリスト表示などで、ルック名の先頭に アイコンが表示されます。

対応している3D LUTファイルについて

本機はフルレンジのS-Gamut3.Cine/S-Log3またはS-Gamut3/S-Log3を入力とする3D LUTに対
応しています。入力の設定方法は本機のモードにより異なり、Cine EIモードでは、Projectメニュー > 
Cine EI SettingのColor Gamut（45ページ）で設定します。記録されるS-Log3映像もこの色域に
なります。Customモードでは、Paint/Lookメニュー > Base LookのInput（51ページ）で設定し
ます。

対応している3D LUTの出力タイプは以下の2種類です。
Type 1：変換後の映像領域がフルレンジの3D LUT 

外部出力する前に、本機の内部でフルレンジ信号をビデオレンジ信号にレンジ変換して出力します。
1023

0

1

0

1023

0
10 Bit10 Bit

940

64

入力 S-Log3
レンジ 3D LUT フルレンジ 出力 ビデオ

レンジ
出力 

ビデオ

フルレンジを
ビデオレンジ

に変換

Type 2：変換後の映像領域がビデオレンジの3D LUT 
ビデオレンジ信号がそのまま外部出力されます。

1023

0

1023

0

940

64

940

64

10 Bit 10 Bit

1

0

入力 S-Log3
レンジ

3D LUT 
（レンジ変換）

ビデオ
レンジ 出力 出力 

ビデオ

Catalyst BrowseやRAW Viewerで生成されるCUBEファイルはType 1です。また本機でメタデータ
として記録することのできる3D LUTファイルもこのタイプになります。
Type 2は、外部LUTボックスなどでS-Log3信号を放送などで使用されるビデオ信号へ直接変換する
ときに使用されるものです。
Type 1の3D LUTを使用する場合は、Paint/Lookメニュー > Base LookのOutput（51ページ）で
Full BT.709またはFull BT.2020を選択してください。Type 2の3D LUTを使用する場合は、Video 
BT.709またはVideo BT.2020を選択してください。
出力の色域は、Cine EIモードではBT.709固定、CustomモードではProjectメニュー > Base 
SettingのTarget Display（44ページ）の設定に従います。
基本ルックを選択するときには、インポートした3D LUTの特性に合わせて、Paint/Lookメニュー 
> Base LookのOutput（51ページ）で、Cine EIモードではFull BT.709またはVideo BT.709を、
CustomモードではTarget Display設定に合った色域の3D LUTを選ぶようにしてください。
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メモリーカードからインポートする

3D LUTファイルをメモリーカードからインポート
します。

1	 PCなどで記録メディアの所定のフォルダに、
3D LUTファイルを保存する。
記録メディア フォルダパス
SDカード /PRIVATE/SONY/PRO/

LUT/

2	 3D LUTファイルを保存した記録メディアを、
Utility SDカードスロットに差し込む。

3	 フルメニューのPaint/Lookメニュー >Base 
LookのImport from Utility SD（51ペー
ジ）を選択する。

4	 インポート先を選択する。

5	 インポートする3D LUTファイルを選択する。
画面の指示に従ってください。本機は3D LUT
ファイルを基本ルックとして取り扱います。

6	 フルメニューのPaint/Lookメニュー >Base 
LookのSelect（51ページ）でインポート
した3D LUTファイルを選択する。

7	 インポートした3D LUTファイルの属性に合
わせて、フルメニューのPaint/Lookメニュー
>Base LookのInputとOutput（51ペー
ジ）を設定する。

クラウドサービスからインポートする

3D LUTファイルをクラウドサービスからインポー
トします。

1	 本機をスマートフォンアプリ「Creators' App 
for enterprise」に接続する（86ページ）。

2	 フルメニューのPaint/Lookメニュー >Base 
LookのImport from Cloud(Private)また
はImport from Cloud(Share)（51ペー
ジ）を選択する。

3	 インポート先を選択する。

4	 インポートする3D LUTファイルを選択する。
画面の指示に従ってください。本機は3D LUT
ファイルを基本ルックとして取り扱います。

5	 フルメニューのPaint/Lookメニュー >Base 
LookのSelect（51ページ）でインポート
した3D LUTファイルを選択する。

6	 インポートした3D LUTファイルの属性に合
わせて、フルメニューのPaint/Lookメニュー
>Base LookのInputとOutput（51ペー
ジ）を設定する。

「Monitor & Control」アプリケーショ
ンからインポートする

3D LUTファイルを「Monitor & Control」アプリ
ケーションからインポートします。操作方法につ
いては、「Monitor & Control」アプリケーション
のヘルプをご覧ください。

［ご注意］
「Monitor & Control」アプリケーションから3D LUTファイ
ルをインポートすることにより本機で使用中のBase Look
が変更された場合は、映像が乱れることがあります。

3D LUTファイルの属性を調節する

インポートした基本ルックを使う場合は、Paint/
LookメニューのBase LookのInput、Output、
AE Level Offset（51ページ）で調節してくだ
さい。
設定項目Input、Output、AE Level Offsetは、
Selectで選択された基本ルックに適用されます。
複数の3D LUTファイルをインポートした場合は、
各3D LUTファイルをSelectで選択し、Input、
Output、AE Level Offsetをそれぞれ設定して
ください。
設定したInput、Output、AE Level Offsetは、
3D LUTファイルごとに保存されます。

［ご注意］
•	 3D LUTファイルをインポートしただけでは映像に反映さ

れません。フルメニューのPaint/Lookメニュー >Base 
LookのSelect（51ページ）でインポートした3D LUT
ファイルを読み出してください。

•	 Inputを正しく設定しないと、本来のルックになりませ
ん。

•	 インポートした3D LUTファイルは、Custom/Cine EI
モード共通の基本ルック／ LUT選択肢となりますが、こ
れらのモードに応じた色域・ガンマ変換は行いません。

•	 フルメニューのMaintenanceメニューのAll Resetの
Resetを実行しても3D LUTファイルは削除されません。

基本ルックを削除する

フルメニューのPaint/Lookメニュー >Base 
LookのDelete（51ページ）で、インポートし
た3D LUTファイルを削除できます。
フルメニューのPaint/Lookメニュー >Base 
LookのDelete All（51ページ）で、すべての
3D LUTファイルを削除できます。

［ご注意］
•	 削除する前に、その基本ルックがSceneファイルで使用

されていないことをご確認ください。使用されている基
本ルックを削除した場合、該当するSceneファイルのルッ
クは不適切なものになります。

•	 削除した基本ルックは、Customモードでも使えなくな
ります（93ページ）。

•	 インポートした3D LUTファイルは、フルメニューの
MaintenanceメニューのAll ResetのReset（71ペー
ジ）を実行しても削除されません。
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ポストプロダクションでルックを調節する前提で撮影する
本機のCine EIモードを使い、暗部から明部まで
諧調を均等に記録すると、ポストプロダクション
で局所的に暗部や明部の諧調を復元するなど細
かい調節を行うことができます。
しかし、この記録映像を普通のモニターで見ると、
全体にコントラストが低いため、フォーカスや露
出などの調節が困難です。
本機では、基本ルックをLUTとしてモニター映像
に適用して撮影時の各種調節を補助することが
できます。また、再生映像にLUTを適用して仕上
がりを確認することもできます。
LUTは以下の系統別に適用されます。ただし、
適用されるLUTは1種類です。
•	 X-OCN記録時：

	‒ SDI出力およびHDMI出力（どちらか一方のみ
出力）

	‒ LCDモニターおよびProxy、ストリーミング
•	 X-OCN記録時以外：

	‒ SDI出力
	‒ HDMI出力、LCDモニター、Proxyおよびス
トリーミング

［ご注意］
•	 SDI 1の映像出力フォーマットが4096x2160または

3840x2160の解像度の場合は、SDIの出力映像にLUT
を適用できません。

•	 HDMIの映像出力フォーマットが3840x2160の解像度
の場合は、HDMIの出力映像にLUTを適用できません。

LCDモニター映像にLUTを適
用する

1	 MENUボタンを押してMonitoringステータ
スを表示する。

2	 LCD/Stream行のGamut/Gamma列を選
ぶ。

3	 OnまたはOffを選ぶ。

［ご注意］
•	 LCDモニターのLUT On/Off設定は、X-OCN記録時は

Proxyファイルやストリーミング映像にも作用します。
X-OCN記録時以外は、HDMI出力やProxyファイル、ス
トリーミング映像にも作用します。

•	 ピント拡大中は、ガンマ表示アシストになります。

［メモ］
•	 フルメニューのShootingメニュー >LUT On/Off（42

ページ）でも設定できます。
•	 SDI/HDMIもLCDモニターと同様に設定できます。

LUTを変更する

1	 MENUボタンを押して、Monitoringステー
タスを表示する。

2	 Base Look/LUT欄を選ぶ。

3	 基本ルックのリストから、適用するLUTを選
ぶ。

［メモ］
•	 本機にはプリセットのLUTとして、s709、709(800%)、

S-Log3、Warm、Cool、Vintage、Teal and 
Orange、ACESproxy、ACEScct、ACES 1.0 
Output-Rec.709が用意されています。

•	 3D LUTファイルをインポートして適用することもで
きます。詳しくは、「好みの基本ルックをインポート
する」（91ページ）および「基本ルックを削除する」

（92ページ）をご覧ください。
•	 フルメニューのPaint/Lookメニュー >Base Lookの

Select（51ページ）でも設定できます。

3D LUTファイルをメタデータ
として記録する

撮影時にモニター映像に適用していた3D LUT
ファイル（CUBEファイル）を、クリップにメタデー
タとして記録することができます。
この機能を有効にするには、フルメニューの
Projectメニュー > Cine EI SettingのEmbed 
LUT File（45ページ）をOnに設定します。
記録開始時に選択していた3D LUTファイル

（CUBEファイル）をメタデータとして記録します。
ただし、以下の場合はメタデータとして記録する
ことはできません。
•	 Paint/Lookメニュー > Base LookのOutput
（51ページ）がVideo BT.709またはVideo 
BT.2020に設定されている3D LUTを選択して
いる場合

•	 インポートした3D LUTファイルのサイズが
1.25MBを超えているなどで、3D LUTファイル

（CUBEファイル）をカメラ内に保持できていな
い場合（Base Look選択時、ファイル名の前に

「！」が表示されます。）

•	 保存が可能な3D LUTファイルを選択時に、適
用するLUTデータを変更した直後に記録を開
始した場合

［ご注意］
•	 1つのクリップに記録できるメタデータは1つのみです。
•	 X-OCN記録時は3D LUTファイルをメタデータとして記

録することはできません。
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好みのルックで撮影する
本機のCustomモードでは、基本ルックをベース
にブラックやマトリクスなどの調節を加えてルッ
クを構成します。

基本ルック
ルック ブラック

：

マトリクス

これらの設定をSceneファイルに保存すること
で、内容の異なるルックを簡単に選ぶことができ
ます。
本機は、計6個のプリセットのルックを用意して
います。

ルックを選ぶ

1	 撮影画面でマルチファンクションダイヤルを
押す。

2	 （Sceneファイル）アイコンを選ぶ。
アイコンの数字はファイル番号です。

3	 マルチファンクションダイヤルを押す。

4	 メニューから好みのルックを選択し、マルチ
ファンクションダイヤルを押す。

［メモ］
•	 工場出荷時は、以下がプリセットされています。

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Sceneファイル 1 S-Cinetone HLG Live

Sceneファイル 2 Standard HLG Mild

Sceneファイル 3 Still HLG Natural

Sceneファイル 4 ITU709 未登録

Sceneファイル 5 709tone 未登録

Sceneファイル 6 ～ 16 未登録 未登録

•	 フルメニューのPaint/Lookメニュー >Scene Fileの
Recall（51ページ）でもルックを選択することができ
ます。なお、プリセットのルックはScene FileのPreset 
Recallでも呼び出せます。

ルックをカスタマイズする

プリセットルック以外のルックで撮影したい場合
は、任意の基本ルックを基に、フルメニューの
Paint/LookメニューのBlack、Knee、Detail、
Matrix、Multi Matrixの各設定項目でルックを
カスタマイズすることができます。各設定項目の
詳細は51ページを参照してください。
設定するときは、本機をテレビやモニターにつな
いで、画像を確認しながら調節してください。

［ご注意］
3D LUTファイルをインポートして映像に適用したとき、
Paint/LookメニューのMatrixなどの基本ルック以外の各
設定が変更されていると、3D LUTファイルに定義された
通りのルックになりません。フルメニューのPaint/Lookメ
ニュー >Reset Paint SettingsのReset without Base 
Look（51ページ）で、カスタマイズされた設定値をまと
めてリセットできます。

ルックを保存する

フルメニューのPaint/Lookメニュー >Scene 
FileのStore（51ページ）で、現在のルックを
Sceneファイルとして内部メモリーに保存できま
す。
撮影画面からダイレクトメニューの操作で簡単に
呼び出せるようになります。

［ご注意］
•	 ルックを保存せずにほかのルックを選択すると、保存前

のルックは破棄されます。
•	 フルメニューのMaintenanceメニュー >All Resetの

Reset（71ページ）を実行しても、Sceneファイルは
削除されません。

［メモ］
プリセットのSceneファイルも上書きできます。
プリセットのSceneファイルを復元するには、フルメニュー
のPaint/Lookメニュー >Scene FileのPreset Recall

（51ページ）で復元したいルックを読み出したあと、
Scene FileのStoreでSceneファイルに保存してください。

保存したルックを削除する

フルメニューのPaint/Lookメニュー >Scene 
FileのDelete（51ページ）で、内部メモリーに
保存されているSceneファイルを削除できます。

［メモ］
削除すると、ダイレクトメニューに表示されなくなります。
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ズームを調節する
撮影時の状況に応じて、ズームを調節します。

電動ズームレンズを装着したとき、グリップリモ
コンまたはMIシュー搭載ハンドル（別売）のズーム
レバーでズーム操作ができます。レバーを押し込
む量に応じてズームスピードが変化します。
また本機は、全画素超解像という画像処理技術
によるズーム機能を搭載しています。全画素超解
像ズームを有効にすると、単焦点レンズでもズー
ムができるようになります。電動ズームレンズで
は光学望遠端からさらに寄ることができます。
全画素超解像ズームの最大倍率は、記録解像度
により異なります。
•	 記録解像度QFHD/4Kのとき：1.5倍
•	 記録解像度HDのとき：2倍

［ご注意］
•	 全画素超解像ズームは、イメージャースキャンモード

（87ページ）がS35 5.8K 17:9/S35 5.8K 16:9/S35 
1.9K 16:9のときのみ使用できます。

•	 PLマウントレンズ装着時、レンズの操作で全画素超解像
ズームはできません。

•	 X-OCN記録時、全画素超解像ズームはできません。

ズームの種類を選ぶ

フルメニューのTechnicalメニュー >Zoomの
Zoom Type（62ページ）でズームの種類を設
定します。
装着するレンズの種類によって以下のように異な
ります。

装着する 
レンズ

Zoom Typeの設定
Optical Zoom 
Only

On(Clear Image 
Zoom)

単焦点レン
ズ／手動
ズームレン
ズ

レバーによるズー
ム操作はできな
い。

全画素超解像
ズームができる。

電動ズーム
レンズ

光学ズームのみ 光学ズームと全画
素超解像ズーム
ができる。

［ご注意］
•	 フルメニューのShootingメニュー >S&Q Motionの

Frame Rate（42ページ）が60fpsを超える場合、全
画素超解像ズームは使えません。

•	 レンズのSERVO/MANUAL切り替えスイッチを切り替え
ると、全画素超解像ズームの倍率は1倍にリセットされ
ます。

ハンドルズームを設定する

フルメニューのTechnicalメニューのHandle 
Zoom（62ページ）でMIシュー搭載ハンドル（別
売）のズームレバーの設定を行います。

ズームリングの回転方向を設
定する

一部のEマウントレンズでは、ズームリングの回
転方向を逆にすることができます。
フルメニューのTechnicalメニュー >Lensの
Zoom Ring Direction（63ページ）で設定し
ます。
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フォーカスを調節する
撮影時の状況に応じて、フォーカスを自動または
手動で調節します。

［ご注意］
LCDモニターが情報表示モードのときは、LCDモニター部
のマルチセレクターで外部モニターに表示された画面の操
作はできません。

フォーカスを手動調節する（マ
ニュアルフォーカス）

フォーカスを手動調節するには、FOCUSスイッチ
（4ページ）を「MF」に設定します。
撮影状況に応じて、手動でフォーカス合わせが
できます。
以下のようなときに使います。
•	 水滴の多い被写体
•	 背景とコントラストの弱い被写体
•	 意図的にフォーカスを手前の被写体から奥の

被写体に送るとき

［メモ］
•	 電源を入れて10分以上経過後にフォーカスを合わせる

と、安定した合焦状態を保つことができます。 
また、環境温度が大きく変動した場合、フォーカス合わ
せを再度行うことで最適な撮影状態を維持できます。

•	 手動調節を基本オペレーションとして、オートフォーカス
を補助的に効かせることもできます。
	‒ AF乗り移り感度設定を1(Locked)にする
	‒ FOCUSスイッチを「AF」に設定する
	‒ フォーカスリングを操作する（AF Assist、

99ページ）

タッチ操作でフォーカスを合わせる（ス
ポットフォーカス）

マニュアルフォーカス時、ピントを合わせたい位
置をタッチ操作で指定すると、フォーカスを合わ
せることができます。
スポットフォーカスを使用するには、Shootingメ
ニューのFocusのTouch Function in MF（42
ページ）をSpot Focusに設定します。
ピントを合わせたい位置をタップすると、スポッ
トフォーカスマークが表示されます。

［メモ］
•	 スポットフォーカス中にPush AF/Push MFが割り当て

られたアサイナブルボタン（108ページ）押すとスポット
フォーカスを終了し、そのボタンを押している間はオート
フォーカスになります。ボタンから指を離すと、マニュア
ルフォーカスに戻ります。

•	 レンズ側でマニュアルフォーカスに設定されていると、
スポットフォーカスは動作しません。

•	 ピント拡大中、またはTechnicalメニューのTouch 
Operation（62ページ）がOffのときは、スポット
フォーカスの位置指定操作はできません。

一時的に自動でフォーカスを合わせる
（プッシュオートフォーカス（AF））

マニュアルフォーカス中に、Push AF/Push MF
が割り当てられたアサイナブルボタン（108ペー
ジ）を押すと、そのボタンを押している間はオー
トフォーカスになります。
フルメニューのShootingメニュー >Focusの

Focus Area（42ページ）で設定したフォーカ
スエリア内でフォーカスを合わせます。
ボタンから指を離すと、マニュアルフォーカスに
戻ります。
マニュアルフォーカス中に、ある被写体から別の
被写体にゆっくりとフォーカス送りするような場
合に有効です。

［ご注意］
レンズ側でマニュアルフォーカスに設定されていると、プッ
シュオートフォーカスは動作しません。

拡大表示をしてフォーカスを合わせる
（ピント拡大）

フルメニューのMonitoringメニュー > Focus 
Magnifier（58ページ）でピント拡大を行う出
力先を選択できます。設定に応じて、ピント拡大
で使用するアサイナブルボタンの機能名が変わり
ます。
LCD Focus Magnifierが割り当てられたアサイ
ナブルボタン（108ページ）を押すと、LCDモニ
ターのピント拡大の倍率を切り替えることができ
ます。そのボタンを押すたびに、画面中央が以
下の倍率で拡大されます。

コーデック設定 記録画サイズ 倍率
X-OCN 8K 3倍、6倍

8K以外
X-OCN以外 8K 4倍

8K以外 3倍、6倍

フォーカスが合っているかを確認するときに便利
です。
最大の倍率にした後、もう一度押すと元に戻りま
す。
ピント拡大中にマルチセレクター（5ページ）
で拡大位置を移動できます。マルチセレクターを
押すと中央に戻ります。

また、SDI出力およびHDMI出力の画像も
Output Focus Magnifierが割り当てられたア
サイナブルボタン（108ページ）を押すと、以下
のように拡大されます。

コーデック
設定

記録画サイ
ズ

倍率
SDI (FHD) HDMI(FHD)/

Monitor 
FHD

X-OCN － 2倍、4倍 2倍、4倍
X-OCN以
外

8K － 4倍
8K以外 － 2倍、4倍

［ご注意］
•	 映像出力フォーマットがMonitor FHD以外のSDI出力

と、FHD以外のSDI/HDMI出力では、画像は拡大され
ません。

•	 X-OCN記録以外で、HDMI出力画像のピント拡大を行っ
た場合は、出力画像にLUTを適用することはできません。

•	 拡大位置は本機の電源を切ると画面中央に戻ります。
•	 	X-OCN記録時に、LCDモニター映像をLUT Offでピン

ト拡大した場合は、LUTが適用された映像になることが
あります。

•	 X-OCN記録以外で、HDMI出力画像のピント拡大を行っ
た場合は、Log映像になります。
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フォーカスを自動調節する
（オートフォーカス）

本機は、高速性に優れる位相差AF方式と、高い
精度でフォーカスを合わせることに優れるコント
ラストAF方式を採用しています。
これらの2つのAF方式を組み合わせることで、高
速性・高精度を両立したオートフォーカスを実現
しています。
フォーカスを自動調節するには、本機のFOCUS
スイッチ（4ページ）を「AF」に設定します。レ
ンズにフォーカス切り替えスイッチがある場合は
あらかじめ「AF/MF」または「AF」に設定してくだ
さい。「Full MF」または「MF」の場合、レンズは
本機からのフォーカス指示を受け付けません。

［メモ］
フルメニューのShootingメニュー >FocusのAF Assist

（42ページ）をOnに設定すると、オートフォーカス中で
もレンズのフォーカスリングでフォーカスを動かすことがで
きます。

［ご注意］
•	 オートフォーカスに対応したレンズが必要です。
•	 撮影状況により精度が出ない場合があります。
•	 PLマウントレンズではフォーカスを自動調節できません。
•	 フルメニューのMonitoringメニュー > De-Squeezeの

Ratio（56ページ）がOff(1.0x)以外のときは、オート
フォーカスは使用できません。

オートフォーカスの対象領域／位置を
設定する（フォーカスエリア）

フルメニューのShootingメニュー >Focusの
Focus Area（42ページ）でオートフォーカスの
対象とする領域を設定できます。

Flexible Spot：
映像の指定した位置にフォーカスを合わせます。

選択後、マルチセレクター（5ページ）で位
置を指定します。
マルチセレクターを長押しすると中央の位置に戻
ります。

Zone：
指定したゾーン内から自動でフォーカスを合わせ
る位置を探します。
選択後、マルチセレクター（5ページ）で位
置を指定します。
マルチセレクターを長押しすると中央の位置に戻
ります。

Wide：
映像全域からフォーカスを合わせる位置を探しま
す。枠は表示されません。

［メモ］
フルメニューのMonitoringメニュー >Display On/Offの
Focus Area Indicator（56ページ）で、フォーカスエリ
ア枠表示をOn/Offすることができます。

［ご注意］
フォーカスエリア枠はDISPLAYボタンでは非表示になりま
せん。

フォーカスエリアをすばやく変更する
(フォーカスセット)

アサイナブルボタン（108ページ）にFocus 
Settingを割り当てると、撮影中などにオート
フォーカスの対象領域（フォーカスエリア）の位置
や大きさをすばやく変更することができます。
フォーカスエリアの設定により動作が変わりま
す。

フルメニューのShootingメニュー
>FocusのFocus Area（42ページ）が
Flexible SpotまたはZoneの場合：
Focus Settingを割り当てたアサイナブルボタン
を押すと、マルチセレクター（5ページ）で
フォーカスエリアの位置を変更することができま
す。
位置変更中にマルチセレクターを押すと、フォー
カスエリアの位置が中央に戻ります。
Focus Settingを割り当てたアサイナブルボタン
を長押しするとフォーカスエリアの大きさを変更
することができます。
大きさを変更後、マルチセレクターを押すと
フォーカスエリアの位置を設定します。
設定の変更が終了したら、Focus Settingを割
り当てたアサイナブルボタンを押して元の画面に
戻ります。

フルメニューのShootingメニュー
>FocusのFocus Area（42ページ）が
Wideの場合：
Focus Settingを割り当てたアサイナブルボタン
の長押しによるフォーカスエリアの大きさ変更の
み可能です。種別をFlexible SpotまたはZone
に変更すれば、続けて位置変更も可能です。

［メモ］
フォーカスエリアの位置変更が可能な場合は、フォーカス
エリア枠がオレンジ色で表示されます。

フォーカスエリア枠をタッチ操作で移
動する（タッチフォーカスエリア）

Focus Settingを割り当てたアサイナブルボタン
（108ページ）を押すなどしてフォーカスエリア
の表示をオレンジにしたとき、タッチ操作で移動
できます。
タップした場所をフォーカスエリアの中心とし、
フォーカスエリアの位置を移動します。ドラッグ
すると、フォーカスエリアの位置は指の動きに追
従して移動します（10ページ）。

［メモ］
撮像画面ではFocus Settingを割り当てたアサイナブルボ
タンの操作で、タッチフォーカス操作の有効・無効を切り
替えることができます。
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任意の位置をタップする

タップした位置をフォーカスエリアの中心として
位置を移動する

ドラッグで指先を追従し、フォーカスエリアの
位置を移動する

［ご注意］
•	 	タップまたはドラッグした位置がフォーカスエリアの位

置の設定範囲を超えた場合、フォーカスエリアの位置は
設定範囲内の上下左右端に設定されます。

•	 	以下の場合、この機能は使えません。
	‒ フルメニューのTechnicalメニューのTouch 

Operation（62ページ）がOffの場合
	‒ フォーカスエリア枠がグレーまたは非表示の場合

オートフォーカスの動作の調節をする
（AFトランジション速度、AF乗り移り
感度）

AFトランジション速度
フルメニューのShootingメニュー >FocusのAF 
Transition Speed（42ページ）で、被写体が
移り変わる際のフォーカス駆動の速さを設定す
ることができます。
低速側に設定すると被写体の移り変わり時に
ゆっくりとフォーカス送りし、印象的な映像表現
を可能にします。
高速側に設定すると被写体間のフォーカス送り
がすばやくなります。フレームに入った被写体に
すぐにフォーカスが合うので、すばやいフォーカ
ス合わせが要求されるドキュメンタリー撮影など
に効果的です。

乗り移り中
1(低速)：フォーカスがゆっくり動く
・
・
・
7(高速)：フォーカスがすばやく動く

奥の被写体に合焦している

手前の被写体に合焦

AF乗り移り感度
フルメニューのShootingメニュー >FocusのAF 
Subj. Shift Sens.（42ページ）で、被写体の
乗り移り感度を設定することができます。
粘る側に設定するとフォーカスの合っている被写
体の前に別の被写体が来てもフォーカスが移りに
くくなり、敏感側に設定すると手前に来た被写体
を優先してフォーカスが移りやすくなります。

［メモ］
AF Speed/Sens.を割り当てたアサイナブルボタンを押す
たびに、調整用のレベルバーが以下の順で表示され、AF
トランジション速度とAF乗り移り感度の設定を変更できま
す。
AFトランジション速度AF乗り移り感度非表示・・・
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AF Subj. Shift Sens.: 1（粘る） AF Subj. Shift Sens.: 5（敏感）

別の被写体にフォーカスが移りにくい 別の被写体にフォーカスが移りやすい

手動でフォーカス対象を変更する（AF 
Assist）

フルメニューのShootingメニュー >FocusのAF 
Assist（42ページ）をOnに設定すると、オー
トフォーカス中でもレンズのフォーカスリングを操
作して任意の被写体にフォーカスを合わせること
ができます。
フォーカスリングの操作を止めると、フォーカス
リングで合わせた被写体にオートフォーカスしま
す（AFアシスト状態）。
フルメニューのShootingメニュー >Focus>AF 
Subj. Shift Sens.（42ページ）の設定に関わ
らず、フォーカスリング操作後はフォーカスが乗
り移りにくくなります。
以下の場合、AFアシスト状態は解除されます。
•	 フォーカスリングで合わせた被写体を見失った

とき
•	 マニュアルフォーカスにしたとき
•	 リアルタイムトラッキングAFを開始したとき

［メモ］
•	 Push AF/Push MFが割り当てられたアサイナブルボタ

ン（108ページ）を使うと、AFアシスト状態を素早く解
除できます。

•	 フォーカスリングを操作すると、リアルタイムトラッキン
グAFは終了します。

•	 人物限定AFの場合、フォーカスリングを操作すると一
番近い顔にオートフォーカスします。

一時的に手動でフォーカスを合わせる
（プッシュマニュアルフォーカス）

オートフォーカス中に、Push AF/Push MFが割
り当てられたアサイナブルボタン（108ページ）
を押すと、そのボタンを押している間はマニュア
ルフォーカスになります。
ボタンから指を離すと、オートフォーカスに戻り
ます。
被写体の手前を撮影対象でないものが横切ると
きなどに、一時的にオートフォーカスを止めて手
動でフォーカスを合わせることができます。
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人物を検出して追尾する（被
写体認識AF）

人物を追尾対象として検出し、フォーカスエリア
内にある顔や瞳、頭、体にフォーカスを合わせ
続けることができます。
フォーカスモードがAFモードまたはプッシュオー
トフォーカス中のみ使用できます。
人物を検出すると灰色の被写体認識枠が表示さ
れます。オートフォーカスの対象と判断されると、
枠が白色になり、追尾が開始されます。
よりピンポイントな認識部位（瞳など）が認識さ
れた場合は、その部位が自動的に優先されて認
識枠が表示されます。
複数の人物を検出したときは、主な被写体は自
動的に決定します。

［メモ］
フォーカスエリアがZoneまたはFlexible Spotに設定され
ているときは、設定したフォーカスエリアの範囲に人物が
重なっているときに、認識した被写体の部位（顔や瞳/頭/体）
に認識枠が表示されます。

ShootingメニューのFocusのSubject 
Recognition AF（42ページ）で、被写体認識
AFの動作を設定します。

Human Only AF：
カメラが被写体（人物）を検出したとき、人の顔や
瞳、頭、体にフォーカスを合わせて追尾します。
顔や瞳、頭、体を検出しない間は、AFが一時
停止し、人物限定AF中の  （AF一時停止アイコ
ン）（23ページ）が表示されます。顔や瞳、頭、
体だけにフォーカスを合わせて追尾したいときに
有効なモードです。

Human Priority AF：
カメラが被写体（人物）の顔や瞳、頭、体を検出
したとき、人の顔や瞳、頭、体に優先的にフォー
カスを合わせて追尾します。顔や瞳、頭、体を
検出しないときは、AFモードになります（初期設
定）。

Off：
被写体認識AF機能を無効にします。

［ご注意］
•	 Human Only AFに設定しているときでも、プッシュオー

トフォーカス実行中は、Human Priority AFになります。
•	 FOCUSスイッチが「MF」のときは、被写体認識AFできま

せん（プッシュオートフォーカス実行中を除く）。
•	 Human Only AFに設定した状態で本機の電源を切っ

た場合、次に電源を入れると自動的にHuman Priority 
AFになります。

被写体認識枠を消す

被写体認識枠の表示／非表示は、フルメニュー
のMonitoringメニュー >Display On/Offの
Subject Recognition Frame（56ページ）で
設定できます。

アサイナブルボタンで被写体認識AF
の動作を切り替える

アサイナブルボタン（108ページ）にSubject 
Recognition AFを割り当てると、そのボタンを
押すたびに、被写体認識AFの動作がHuman 
Priority AF、Human Only AF、Offの順に切り
替わります。

ダイレクトメニューで設定する

被写体認識AFの動作は、ダイレクトメニュー
（108ページ）でも切り替えることができます。

被写体を指定して追尾する（リ
アルタイムトラッキングAF）

タッチ操作や被写体認識枠の選択操作で指定し
た被写体にフォーカスを合わせ続けることができ
ます。
被写体を選択すると白色の追尾枠が表示され、
追尾が開始されます。

［メモ］
•	 フォーカスエリアの設定に関わらず、映像領域全体で追

尾します。
•	 ShootingメニューのFocusのTouch Function in MF

（42ページ）をTracking AFに設定すると、フォーカ
スモードがMFモードの場合でもリアルタイムトラッキン
グAFが可能です。

被写体認識AFの動作モードの設定によって、追
尾対象に対して次のように動作します。

Human Only AF、Human Priority 
AF：
指定した被写体にフォーカスを合わせ追尾しま
す。
追尾対象が人物で、顔／瞳／頭／体を検出した
場合は、顔／瞳／頭／体にフォーカスを合わせ
ます。

Off：
指定した被写体にフォーカスを合わせ追尾します。
追尾対象が人物であっても、顔／瞳／頭／体の
検出は行いません。

［ご注意］
レンズ側でマニュアルフォーカスに設定されていると、リア
ルタイムトラッキングAFは動作しません

リアルタイムトラッキングAFを開始す
る

特定の被写体を追尾対象に指定すると、その被
写体に対して追尾が開始されます。

タッチ操作で指定する
次のいずれかの状態のときに、追尾対象とする
被写体をタップします。
•	 フォーカスモードがMFモード、またはプッシュ

マニュアルフォーカス中で、Shootingメニュー
のFocusのTouch Function in MF（42ペー
ジ）がTracking AFのとき

•	 フォーカスモードがAFモード、またはプッシュ
オートフォーカス（AF）中のとき

［ご注意］
TechnicalメニューのTouch Operation（62ページ）が
Offの場合はタッチ操作での指定はできません。
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被写体認識枠の選択操作で指定する
マルチセレクター（5ページ）で被写体選択
カーソル（オレンジ色の下線）を追尾対象にする被
写体に移動して、マルチセレクターを押し込みま
す。

他の被写体認識枠（灰色） 追尾枠

被写体選択カーソル（オレンジ）

［メモ］
•	 リアルタイムトラッキングAF中に追尾対象を変更するこ

ともできます。
•	 リアルタイムトラッキングAF中にLCD Focus Magnifier

を割り当てたアサイナブルボタン（108ページ）を押す
と、追尾状態を継続したままピント拡大が実行されます。
ただし、ピント拡大中は、追尾対象の指定はできません。

［ご注意］
マニュアルフォーカス中は、被写体認識枠の選択操作でト
ラッキングを開始できません。

トラッキングAFポインターで指定する
タッチ操作の代わりにマルチセレクターで画面上
の被写体を自由に選ぶことができます。
ShootingメニューのFocusのMulti Selector 
Function（42ページ）がPointerのとき、マル
チセレクター（9ページ）でトラッキングAFポ
インターを追尾対象にする被写体に移動して、マ
ルチセレクターを押し込みます。

被写体認識枠

トラッキングAFポインター

•	 ShootingメニューのFocusのPointer Color
（42ページ）でトラッキングAFポインターの
色を設定できます。

•	 ShootingメニューのFocusのPointer Border
（42ページ）でトラッキングAFポインターの
縁取りの有無を設定できます。

［メモ］
トラッキングAFポインターの初期位置は表示映像の中央で
す。マルチセレクターを長押しすると初期位置に戻ります。

［ご注意］
リアルタイムトラッキングAF以外の機能でマルチセレク
ター操作が行える状態のとき、トラッキングAFポインター
がグレー表示され、マルチセレクターでトラッキングAFポ
インターを操作できません。

リアルタイムトラッキングAFを終了す
る

タッチ操作で終了する
タッチパネル左上に表示される  （リアルタ
イムトラッキングAF終了）ボタンをタップします。

［メモ］
以下の場合もリアルタイムトラッキングAFが終了します。

	‒ FOCUSスイッチまたはレンズ側でAUTO/MANを切り
替えたとき

	‒ フォーカスモードを変更したとき
	‒ オートフォーカスアシストを実行したとき
	‒ フォーカスエリアの設定や被写体認識AFの動作を変

更したとき

	‒ Push AF/Push MFを割り当てたアサイナブルボタン
を押したとき

	‒ 撮影画面内から追尾対象がなくなり、フォーカスがど
こにも合っていない状態が数秒経過したとき

撮影時のご注意

•	 以下の場合は、状況によってはうまく被写体に
ピントが合わないことがあります。

•	 低照度、逆光時
•	 影がかかった状態
•	 ピントが大きくずれた状態

また、被写体の動きが大きいときなど、瞳を
認識していても、以下の場合は、状況によって
はうまく瞳にピントが合わないことがあります。

•	 目を閉じた状態
•	 瞳に毛などがかかった状態
•	 メガネ（サングラス）をかけた状態

ほかにも、状況によって被写体にピントを合わ
せられない場合があります。

•	 被写体の瞳などの優先したい部位にピントを
合わせることができないときは、被写体の頭
部や体などの認識されたほかの部位に自動で
ピントを合わせることがあります。

•	 被写体の顔などに白色の被写体認識枠が表示
されていても、自動的に被写体の瞳などの優
先したい部位にピントを合わせることがありま
す。

•	 被写体の一部しか画角に入っていないときは
認識しない場合があります。
	‒ 人物や動物の手や足のみが見えている場合
	‒ 被写体の一部が隠れて見えない場合など

•	 状況によっては、被写体以外のものや部位な
どを被写体と誤認識することがあります。
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明るさを調節する
アイリス、ゲイン、シャッタースピードを調節した
り、NDフィルターを使って光量を調節したりして、
明るさを調節できます。自動調節することもでき
ます。
明るさを自動調節するときの目標レベルは、フル
メニューのShootingメニュー >Auto Exposure
のLevel（40ページ）で設定します。アサイナ
ブルボタンやアサイナブルダイヤル（108ページ）
にAuto Exposure Levelを割り当てることもで
きます。

［ご注意］
Cine EIモードではゲインを調節できません。基準感度に固
定されます。また、シャッタースピードによる明るさの自動
調節はできません。アイリスやNDフィルターによる明るさ
の自動調節は可能です。

基準感度を選択する

本機では2種類の基準感度を選択することがで
きます。
Cine EIモードでは、フルメニューのShootingメ
ニュー >ISO/Gain/EIのBase ISO（38ページ）
でISO 3200またはISO 800から選択します。
通常の照明下ではISO 800、低照度の条件では
ISO 3200を選択してください。
Customモードでは、フルメニューのShooting
メニュー >ISO/Gain/EIのBase Sensitivity

（38ページ）でHighまたはLowから選択しま
す。
通常の照明下ではLow、低照度の条件ではHigh
を選択してください。

［メモ］
アサイナブルボタンにBase ISO/Sensitivityを割り当てる
こともできます（108ページ）。

アイリスを調節する

アイリスを調節して、明るさを調節できます。

［ご注意］
PLマウントレンズ装着時、本機やリモートコントロールパネ
ル以外のリモコンからのアイリス制御はできません。リモー
トコントロールパネルからは、手動調節によってのみアイリ
ス制御が可能です。

アイリスを自動調節する

被写体に応じて明るさを調整します。対応するレ
ンズが必要です。

1	 レンズにAuto Irisスイッチがついている場
合、AUTOにする。

2	 Auto Irisのダイレクトメニュー（108ペー
ジ）を表示させ、Autoを選ぶ。

	 ［ご注意］
PLマウントレンズ装着時、Auto IrisはOffになります。

	 ［メモ］
アサイナブルボタンにAuto Irisを割り当てることもで
きます（108ページ）。

アイリスを手動調節する

1	 Auto Irisのダイレクトメニュー（108ペー
ジ）を表示させ、Manualを選ぶ。

2	 Irisのダイレクトメニュー（108ページ）を
表示させ、アイリス値が白背景で表示され
た状態にする。

3	 マルチファンクションダイヤルを回して調節
する。

	 ［メモ］
•	 マルチファンクションダイヤルにIRISを割り当てる

と、マルチファンクションダイヤルを常時IRISとし
て動作させることもできます（108ページ）。

•	 リモコンのアサイナブルダイヤルにIRISを割り当て
ることもできます（108ページ）。

•	 アイリスリングが付いているレンズの場合は、レン
ズのアイリスリングで手動調節できます。

一時的に自動調節する

Push Auto Irisを割り当てたアサイナブルボタン
（108ページ）を押している間、アイリスを自動
調節します。
指を離すと手動アイリスに戻ります。

［ご注意］
•	 レンズのAuto IrisスイッチをMANUALにすると、本機

からのAuto IrisやPush Auto Irisを受け付けなくなりま
す。また、本機からのアイリス手動調節操作も受け付け
なくなります。

•	 ShootingメニューのIrisのBokeh Control（40ペー
ジ）がOnのときは、Push Auto Irisを実行できません。

Exposure Indexを調整する

Cine EIモードではモニター LUTをOffに設定し
た映像出力を本線として記録することを想定して
おり、EI値に合わせてモニター LUT On側の映像
の明るさを変化させることで、ポストプロダクショ
ン処理での増感／減感処理結果を撮影時に確認
することができます。
フルメニューのShootingメニュー >ISO/Gain/
EIのExposure Index（38ページ）でEI値を変
更できます。

［ご注意］
Cine EIでの記録中は、Exposure Indexの設定を固定に
することをお勧めします。Exposure Indexの設定を変更
してしまうと、ポストプロダクション処理での明るさ補正が
非常に難しくなり、撮影時の状態を再現できない恐れがあ
ります。

ゲインを調節する

Customモードではゲインを調節して、明るさを
調節できます。

ゲインを自動調節する

AGCのダイレクトメニュー（108ページ）を表示
させ、Autoを選ぶ。

［メモ］
•	 ShootingメニューのAuto ExposureのAGC（40

ページ）をOnにしても同様の調節が可能です。
•	 アサイナブルボタンにAGCを割り当てることもできます

（108ページ）。

ゲインを手動調節する

アイリスを固定したまま露出調整したいときや、
AGCによるゲインアップを行いたくないときなど
に使用します。

1	 AGCのダイレクトメニュー（108ページ）を
表示させ、Manualを選ぶ。

2	 Gain Valueのダイレクトメニュー（108ペー
ジ）を表示させ、ゲインを設定する。

［メモ］
•	 フルメニューのShootingメニュー >ISO/Gain/EIの

ISO/Gain（38ページ）でゲインのプリセット値を変更
できます。

•	 アサイナブルボタンにPush AGCを割り当てると、その
ボタンを押している間だけAGCをOnにできます。
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［ご注意］
フルメニューのShootingメニュー >IrisのBokeh Control

（40ページ）がOnのときは、Push AGCを実行できませ
ん。

シャッターを調節する

シャッターを調節して、明るさを調節できます。

シャッターを自動調節する

Auto Shutterのダイレクトメニュー（108ペー
ジ）を表示させ、Autoを選ぶと、映像の明るさ
に応じて自動でシャッター速度または開角度を
調整できます。

［メモ］
フルメニューのShootingメニュー >Auto Exposureの
Auto Shutter（40ページ）をOnにしても同様の調節が
可能です。

シャッターを手動調節する

1	 Shutter Speed ValueまたはShutter 
Angle Valueのダイレクトメニュー（108
ページ）を表示させ、シャッター値が白背景
で表示された状態にする。

2	 マルチファンクションダイヤルを回してシャッ
ター値を調節する。

［メモ］
•	 露光時間をフレーム周期に合わせる場合は、手順1で

Offを選択します。
•	 角度で設定したり、周波数で細かく設定することもでき

ます（39ページ）。

光量を調節する（NDフィル
ター）

撮影状況が明るすぎるときは、NDフィルターを
変更して適切な明るさにすることができます。
本機は2つのNDフィルターモードを備えていま
す。2つのモードはND STEP/VARIABLEスイッ
チで切り替えます。

LOCK

MFAF

ND STEP ND VARIABLE

FULL MENU

ND ON

1 2

3

CLEAR

DISP

MENU

BACK

REC

B

C

A

ステップモードで調節する

ND STEP/VARIABLEスイッチ（A）をSTEPの位
置にして、ND FILTER POSITION上下ボタン（B）
で切り替えます。
フルメニューのShootingメニュー > ND Filterの
Display Mode（39ページ）で、NDフィルター
透過光量の表現形式を設定できます。  
•	 	Optical Densityの場合： 

Clear（NDなし）、0.6、0.9、1.2、1.5、1.8、2.1
のいずれかに調節できます。

•	 Transmittanceの場合： 
Clear（NDなし）、1/4、1/8、1/16、1/32、 
1/64、1/128のいずれかに調節できます。

バリアブルモードで調節する

ND STEP/VARIABLEスイッチ（A）をVARIABLE
の位置にします。ND FILTER POSITION上下ボ
タン（B）でCLEARとOnを切り替えます。

光量を自動調節する
オートNDフィルターをOnにすると、NDフィル
ターを使った自動露出調節を行います。

1	 ND FILTER POSITION上下ボタン（B）の＋を
押して、NDフィルターをOnにする。

2	 Auto ND Filterのダイレクトメニュー（108
ページ）を表示させ、Autoを選ぶ。

光量を手動調節する

1	 ND FILTER POSITION上下ボタン（B）の＋を
押して、NDフィルターをOnにする。

2	 Auto ND Filterのダイレクトメニュー（108
ページ）を表示させ、Manualを選ぶ。

3	 ND VARIABLEダイヤル（C）を回してフィル
ターの透過率を調節する。

［メモ］
アサイナブルダイヤルにND Filterを割り当てることもでき
ます（108ページ）。

一時的に自動調節する
Push Auto NDが割り当てられたアサイナブルボ
タン（108ページ）を押している間、オートNDフィ

ルターがOnになります。指を離すとオートNDフィ
ルターがOffに戻ります。
ND FILTER POSITION上下ボタン（B）の＋を押し
て、NDフィルターをOnの状態にしておいてくだ
さい。

［ご注意］
•	 Display Modeを変更すると、NDフィルターの現在の

濃度が変わる場合があります。
•	 撮影中にCLEARをまたいでNDフィルターを切り替えた

とき、画像内にNDフィルターの枠と検出用センサーの
紫光が入り、音声に動作音が入ります。切り替えが完了
後は、センサー光が映り込んだり動作音が入ることはあ
りません。

•	 	ShootingメニューのIrisのBokeh Control（40ペー
ジ）がOnのときは、Push Auto NDを実行できません。

［メモ］
•	 ND VARIABLEダイヤル（C）をND0.6からさらに下に回

すと、CLEARにすることができます。また、CLEARか
らある程度上に回すと、ND0.6にすることができます。
フルメニューのTechnicalメニュー >ND DialのCLEAR 
with Dial（62ページ）で、この動作を無効にすること
ができます。

•	 ND FILTER POSITION上下ボタンの代わりに、ND 
Filter Positionが割り当てられたアサイナブルボタン

（108ページ）を押して設定を変更することもできます。 
ステップモード：Clear0.60.9・・・
Clear・・・ 
バリアブルモード：ClearOnClear・・・

•	 Auto ND Filterが割り当てられたアサイナブルボタン
（108ページ）を押してオートNDフィルターをOn/Off
することもできます。

•	 明るい被写体を撮影するとき、アイリスを極端に絞ると
回折現象が生じフォーカスが甘くなることがあります（ビ
デオカメラでは一般的に起こる現象です）。NDフィルター
を使うことでこの現象を抑え、より良好な撮影結果を得
ることができます。
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自然な色合いに調節する（ホワイトバランス）
撮影状況に応じて調節モードを選択できます。

ATW（自動追尾ホワイトバラ
ンス）

常に適切なホワイトバランスになるように自動的
に調節します。
光源の色温度が変化すると、ホワイトバランスを
自動的に調節し直します。
ホワイトバランスのダイレクトメニュー（108ペー
ジ）を表示させ、ATWをOnにします。
フルメニューのShootingメニュー >White 
SettingのATW Speed（41ページ）で、5段
階の調節速度を選択できます。

［メモ］
•	 	フルメニューのShootingメニュー > WhiteのATW

（41ページ）、またはATWを割り当てたアサイナブル
ボタン（108ページ）でOnにすることもできます。

•	 アサイナブルボタン（108ページ）にATW Hold機能
を割り当てておくと、このボタンを押すことによって、
ATWモードでも一時的にATWを停止させ、ホワイトバ
ランスを固定することができます。

［ご注意］
•	 Cine EIモードのとき、ATWは使えません。
•	 照明や被写体の条件によっては、ATWを使用しても適

切な色に調節できないことがあります。 
例：
	‒ 空、海、地面、草花など単一色の被写体が大部分を

占める場合
	‒ 色温度が非常に高い／非常に低い光源下の被写体

	 ATWの自動追従の時間が遅い場合や、適切な効果が得
られない場合は、オートホワイトバランスを実行してくだ
さい。

ホワイトバランスを手動調節
する

ATW Onのとき： 

ダイレクトメニュー（108ページ）で ア
イコンを選び、W:A ～ W:Hのいずれかを選
ぶ。

ATW Offのとき： 
ダイレクトメニューでW:A ～ W:Hのいずれか
を選ぶ。

•	 W:A：メモリーポジションA
•	 W:B：メモリーポジションB
•	 W:C：メモリーポジションC
•	 W:D：メモリーポジションD
•	 W:E：メモリーポジションE
•	 W:F：メモリーポジションF
•	 W:G：メモリーポジションG
•	 W:H：メモリーポジションH
メモリーポジションA ～ Hの選択は、ホーム画面

（26ページ）で行います。

［メモ］
フルメニューのShootingメニュー > WhiteのWhite 
Select（41ページ）で選択することもできます。

各メモリーポジションはそれぞれ以下の手段で設
定できます。
•	 既定のプリセット値に変更する
•	 任意の色温度・Tintに変更する
•	 オートホワイトバランスを実行する

既定のプリセット値に変更する

ダイレクトメニュー（108ページ）のW:A ～ W:H
のいずれかを選ぶと、以下が表示されます。

Cine EI：
5500K±00
4300K±00
3200K±00
Custom：
6300K±00
5600K±00
4300K±00
3200K±00
選択すると、そのときのメモリーポジションの設
定値が更新されます。

任意の色温度に変更する

1	 Color Temp.またはTintのダイレクトメ
ニュー（108ページ）を表示させ、設定値
が白背景で表示された状態にする。

2	 マルチファンクションダイヤルを回して調節
する。

［メモ］
ホーム画面（26ページ）、またはフルメニューの
Shootingメニュー > WhiteのColor Temp、Tint、
R-Gain、B-Gain（41ページ）で設定することもできます。

オートホワイトバランスを実行する

メモリーポジションA ～ Hに保存するホワイトバ
ランスを自動で設定します。

1	 メモリーポジションA ～ Hのいずれかを選択
する。

2	 被写体の照明光源と同じ条件のところに白
い紙などを置き、ズームアップして画面に白
を映す。

3	 明るさを調節する。
「アイリスを手動調節する」（102ページ）
に従って、アイリスを調節してください。

4	 ダイレクトメニューのW:A ～ W:Hのいずれ
かを選び、AWBを選択する。
•	 自動で調節した結果は手順1で選択したメ

モリーポジション（A ～ Hのいずれか）に保
存されます。

•	 ATWモードで実行した場合、自動調節が
終わると、結果を引き継いでATWを再開
します。ATW Speedの設定に関わらず、
最速でホワイトバランスを合わせたいとき
に使用できます。

［メモ］
ホーム画面（26ページ）、またはフルメニューの
Shootingメニュー > White のAuto White Balance

（41ページ）、またはAuto White Balanceを割り当て
たアサイナブルボタン（108ページ）でも実行できます。

［ご注意］
正常に終了しなかったときは画面に約3秒間エラーメッセー
ジが表示されます。繰り返し調整を試みてもエラーメッセー
ジが表示されるときは、ソニーのサービス担当者にご相談
ください。
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手ブレ補正を使用する
手ブレ補正を有効にすると、撮影時の細かな動
きによる画像のブレを抑えることができます。
また、装着しているレンズによって、自動または
手動で手ブレ補正を行うことができます。

［ご注意］
Monitoringメニュー > De-SqueezeのRatio（56ペー
ジ）がOff(1.0x)以外の場合、手ブレ補正は使用できません。

手ブレ補正を有効にする

PLマウントアダプターの装着の有無によって、設
定項目が異なります。

PLマウントアダプター装着時

フルメニューのShootingメニュー > Image 
StabilizationのPL Stabilization（43ページ）
をHighまたはLowに設定します。
•	 Low：安定した状態での動画撮影時に手ブレ

補正を行います。
•	 High：Low設定より強い手ブレ補正を行いま

す。
手ブレ補正機能を使用しない場合は、PL 
StabilizationをOffに設定します。この場合は、
三脚を使用することをお勧めします。

PLマウントアダプター非装着時

フルメニューのShootingメニュー > Image 
StabilizationのSteadyShot（43ページ）を
ActiveまたはStandardに設定します。
•	 Standard：安定した状態での動画撮影時に手

ブレ補正を行います。
•	 Active：Standard設定より強い手ブレ補正を

行います。

手ブレ補正機能を使用しない場合は、
SteadyShotをOffに設定します。この場合は、
三脚を使用することをお勧めします。

［ご注意］
以下の場合、ActiveまたはHighに設定できません。
•	 Projectメニュー > Rec FormatのCodec（44ページ）

がX-OCNの場合
•	 Shootingメニュー > S&Q Motionの Setting（42

ページ）が Onの場合
•	 フルメニューのProjectメニュー > Rec Formatの

Imager Scan Mode（44ページ）がFF 8.6K 17:9 / 
FF 8.6K 16:9 / S35c 3.8K 16:9 / S35c 4K 17:9 の場合

自動で焦点距離の設定をす
る

レンズから取得した情報をもとに自動で手ブレ補
正の焦点距離の設定を行います。
自動で手ブレ補正の焦点距離の設定を行う場合
は、フルメニューのShootingメニュー > Image 
StabilizationのStabilization Adjustment

（43ページ）をAutoに設定します。

手動で焦点距離の設定をす
る

手動で手ブレ補正の焦点距離の設定を行います。
手動で手ブレ補正の焦点距離の設定を行う場合
は、フルメニューのShootingメニュー > Image 
StabilizationのStabilization Adjustment

（43ページ）をManualに設定し、焦点距離を
設定します。
焦点距離は、フルメニューのShootingメニュー 

> Image StabilizationのFocal Length（43
ページ）で設定します。8mm ～ 1000mmまで
の範囲で焦点距離を設定できます。
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収録する音声を設定する
本機の入力端子やスイッチ、ダイヤルなどを使い、
収録する音声を設定します。

外部音声の入力端子と切り替えスイッ
チ

INPUT 1端子（5ページ）
INPUT 2端子（6ページ）
マルチインターフェースシュー（別売のMIシュー
搭載ハンドル装着時）
INPUT 1スイッチ（LINE/MIC/MIC+48V）（5
ページ）
INPUT 2スイッチ（LINE/MIC/MIC+48V）（6
ページ）

録音レベルの設定用スイッチ

CH1（AUTO/MAN）スイッチ（4ページ）
CH2（AUTO/MAN）スイッチ（4ページ）
AUDIO LEVEL（CH1）ダイヤル（4ページ）
AUDIO LEVEL（CH2）ダイヤル（4ページ）

オーディオステータス画面

音声入力機器を選ぶ

1	 オーディオステータス画面のCH1/CH2/
CH3/CH4のSource（29ページ）、また
はフルメニューのAudioメニュー >Audio 
InputのCH1 Input Select ～ CH4 Input 
Select（59ページ）で音声入力を切り替え
る。

	 ［ご注意］
•	 インターバルレックモード、スロー＆クイックモー

ション撮影では、音声は記録されません。
•	 本機は環境音収録用のナレーションマイクを内蔵

しています。他機器とのタイミング合わせなどにご
利用いただけます。その場合はInternal MICを設
定します。

•	 CH1 Input SelectとCH2 Input Selectが
Internal MICに設定されている場合、CH1とCH2
の録音レベルは共にAUDIO LEVEL(CH1)ダイヤ
ル（4ページ）に連動して調節されます。CH3 
Input SelectとCH4 Input SelectがInternal 
MICに設定されている場合、CH3とCH4の録音レ
ベルは共にCH3 Input Level（59ページ）に連
動して調節されます。

2	 入力する音源を選ぶ。
INPUT 1/INPUT 2端子に接続する機器に
合わせて、INPUT 1/INPUT 2（LINE/MIC/
MIC+48V）スイッチを設定します。

接続機器 スイッチの位置
外部音声機器（ミキサーなど） LINE
ダイナミックマイクや電池内
蔵のマイク

MIC

+48V電源（ファンタム電源）
対応のマイク

MIC+48V

•	 MIC+48Vにしたままで+48V電源に対応
していない機器を接続すると、接続した
機器の故障の原因になります。接続前に
ご確認ください。

•	 接続しない端子の雑音が気になるときは、
INPUT1/INPUT2（LINE/MIC/MIC+48V）
スイッチを「LINE」にしてください。

録音レベルを自動調節する

自動調節するチャンネルのCH1/CH2（AUTO/
MAN）スイッチを「AUTO」にします。
CH3/CH4の場合は、オーディオステータス画
面（29ページ）、またはフルメニューのAudio
メニュー >Audio InputのCH3 Level Control、
CH4 Level ControlをAutoに設定します

（59ページ）。

録音レベルを手動調節する

CH1/CH2の録音レベルを手動調節する場合は、
以下の手順で行います。

1	 調節するチャンネルのCH1/CH2（AUTO/
MAN）スイッチを「MAN」にする。

2	 撮影中またはスタンバイ中に、調節するチャ
ンネルのAUDIO LEVEL（CH1）/（CH2）ダイ
ヤルを回して、音量を調節する。
•	 CH3/CH4の場合は、オーディオステータ

ス画面のCH3/CH4（29ページ）、また
はフルメニューのAudioメニュー >Audio 
InputのCH3 Level ControlまたはCH4 
Level ControlをManualに設定し、CH3 
Input LevelまたはCH4 Input Levelで録
音レベルを調節します。

•	 CH1 ～ CH4を一括してレベル調節するこ
ともできます。Audio Input Levelが割
り当てられたアサイナブルダイヤル（108
ページ）や、オーディオステータス画
面、またはフルメニューのAudioメニュー
>Audio InputのAudio Input Levelで調
節します。

［メモ］
音声入力レベルの確認には、オーディオステータス画面が
便利です（29ページ）。

［ご注意］
•	 Audioメニューの設定の組み合わせによりAudio Input 

Levelの設定が無効になる場合があります。詳細は
140ページの図をご覧ください。

•	 本機では組み合わせによりさまざまな設定ができます。
詳細は140ページの図をご覧ください。

オーディオ入力端子を増設す
る

MIシュー搭載ハンドル（別売）と、XLRアダプター
XLR-K3M（別売）を使うと、同時に4系統のXLR
音声機器を本機に接続することができます。
MIシュー搭載ハンドル（別売）のマルチインター
フェースシューにXLRアダプターを装着して、オー
ディオステータス画面（29ページ）のCH3の
SourceをShoe CH1に、CH4のSourceをShoe 
CH2に設定してください。または、フルメニュー
のAudioメニュー >Audio InputのCH3 Input 
SelectをShoe CH1に、CH4 Input Selectを
Shoe CH2に設定してください。
入力にXLRアダプターを選択したチャンネルで
は、重複する本機の機能は無効になります。
XLRアダプターのスイッチやダイヤルで調節してく
ださい。
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［ご注意］
•	 本機はXLR-K3Mのデジタル2chオーディオインター

フェースに対応しています。
•	 AudioメニューのAudio InputのCH3 LevelやCH4 

LevelをAudio Input Levelに設定した場合は、XLRア
ダプターで調節したレベルに本機のAudio Input Level
が掛け合わされます。 
XLRアダプターのスイッチをAUTOに設定した場合も
Audio Input Levelが有効になります。 
Throughに設定した場合は、XLRアダプターで調節した
レベルで記録されます（141ページ）。



108 5章　撮影

便利な機能
ダイレクトメニュー操作

LCDモニターに撮影画面を表示したとき、画面に
表示された本機の状態や設定を、直接選択して
変更することができます。
設定できる項目は、以下のとおりです。
•	 Auto Focus Mode
•	 Steady Shot
•	 Auto Exposure Mode
•	 Auto Exposure Level
•	 ND Filter Position
•	 Auto ND Filter
•	 ND Filter Value
•	 Auto Iris
•	 Iris Value
•	 AGC
•	 Gain Value
•	 ISO Value
•	 EI Gain
•	 Base ISO/Sensitivity
•	 ECS
•	 Auto Shutter
•	 Shutter Speed Value
•	 Shutter Angle Value
•	 ATW
•	 Auto White Balance
•	 Color Temp.
•	 Tint
•	 Set to Preset Value
•	 Scene File
•	 S&Q Motion Frame Rate

1	 マルチファンクションダイヤル、または
Direct Menuが割り当てられたアサイナブル
ボタンを押す。

ダイレクトメニュー操作のできる項目のいず
れかにオレンジのカーソルが表示されます。

2	 マルチファンクションダイヤルで操作したい
項目にカーソルを合わせ、マルチファンクショ
ンダイヤルを押す。
メニューが表示されるか、または項目が白
背景で表示されます。

3	 マルチファンクションダイヤルで設定を選び、
マルチファンクションダイヤルを押す。
メニューまたは白背景が消えて、新しい設定
がオレンジのカーソルで表示されます。
再びDirect Menuが割り当てられたアサイ
ナブルボタンを押すか、何も操作しないで3
秒経過すると、ダイレクトメニューが終了し
ます。

	 ［メモ］
•	 各種ファンクションボタンを長押しして、直接設定

をする状態にすることもできます。
•	 白背景で表示された状態では、マルチファンクショ

ンダイヤルをアサイナブルダイヤルのように使うこ
とができます。

•	 選択操作はマルチセレクター（5ページ）でも
行えます。

アサイナブルボタン／ダイヤル

本機には、機能を割り当てて使用できる
ASSIGN 1 ～ 3ボタン、ASSIGN 7 ～ 11ボタ
ン（5ページ、5ページ、6ページ、
9ページ）があります。
本体のマルチファンクションダイヤル（4ページ）
とグリップリモコン（別売）のアサイナブルダイヤル
にも機能を割り当てることができます。ASSIGN 4

～ 6ボタンはグリップリモコン（別売）、RM-30BP（別
売）に搭載されています。

ボタンの機能を変更する

フルメニューのProjectメニューのAssignable 
Button（47ページ）を使用します。
割り当てられた機能は、アサイナブルボタンス
テータス画面（30ページ）で確認することがで
きます。

工場出荷時にアサイナブルボタンに割り当
てられている機能
ボタン1	 Off
ボタン2	 Off
ボタン3	 Off
ボタン4	 LCD Focus Magnifier
ボタン5	 Direct Menu
ボタン6	 Off
ボタン7	 Off
ボタン8	 Off
ボタン9	 Off
ボタン10	 Off
ボタン11	 Off
Focus Holdボタン	 Focus Hold

ボタンに割り当てられる機能
•	 Off
•	 Base ISO/Sensitivity
•	 AGC
•	 Push AGC
•	 ND Filter Position
•	 Auto ND Filter
•	 Push Auto ND
•	 Iris（ファンクションボタン）
•	 Auto Iris

•	 Push Auto Iris
•	 Bokeh Control
•	 Auto Shutter
•	 Auto Exposure Level
•	 Backlight
•	 Spotlight
•	 Auto White Balance
•	 ATW
•	 ATW Hold
•	 AF Speed/Sens.
•	 Focus Setting
•	 Subject Recognition AF
•	 Push AF/Push MF
•	 Focus Hold
•	 LCD Focus Magnifier
•	 Output Focus Magnifier
•	 S&Q Motion
•	 LUT On/Off
•	 LUT On/Off
•	 High/Low Key
•	 Image Stabilization
•	 Crop Select
•	 Rec
•	 Picture Cache Rec
•	 Rec Review
•	 Clip Flag OK
•	 Clip Flag NG
•	 Clip Flag Keep
•	 Color Bars
•	 CALL
•	 DURATION/TC/U-BIT
•	 Display
•	 Lens Info
•	 Video Signal Monitor
•	 Marker
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•	 LCD Monitor Adjust
•	 LCD Monitor Mode
•	 Gamma Display Assist
•	 Peaking
•	 Zebra
•	 Volume
•	 Clips
•	 Touch Operation
•	 Handle Zoom
•	 Auto Upload (Proxy)
•	 Direct Menu
•	 User Menu
•	 Menu

ダイヤルの機能を変更する

本体のマルチファンクションダイヤルと、グリップ
リモコン（別売）のアサイナブルダイヤルの機能を
変更することができます。

マルチファンクションダイヤルはProjectメ
ニューのMulti Function Dial（49ページ）の
Default Functionで設定します。
工場出荷時にはIrisが割り当てられています。

マルチファンクションダイヤルに割り当て
られる機能
•	 Off
•	 ISO/Gain/EI
•	 IRIS
•	 Auto Exposure Level
•	 Audio Input Level

［ご注意］
メニューなどを表示しているときは、本設定は無効になり
ます。

アサイナブルダイヤルは、フルメニューのProject
メニューのAssignable Dial（49ページ）で設
定します。
工場出荷時は、いずれもIRISが割り当てられてい
ます。

［メモ］
RM-30BP（別売）のアサイナブルダイヤルは、Grip/
Remote Dialの設定に従います。

アサイナブルダイヤルに割り当てられる機
能
•	 Off
•	 ISO/Gain/EI
•	 ND Filter
•	 IRIS
•	 Auto Exposure Level
•	 Audio Input Level
•	 Multi Function Dial

割り当てられた機能は、アサイナブルボタンス
テータス画面（30ページ）で確認することがで
きます。

スロー＆クイックモーション

フルメニューのProjectメニュー >Rec Formatの
Imager Scan Mode（44ページ）が下記に設
定されているときは、撮像時のフレームレートを
再生時のフレームレートと異なる値に設定するこ
とができます。

イメージャースキャン
モード

フレームレート

FF 8.6K 17:9 1-30
FF 8.6K 16:9
FFc 6K 17:9 1-60
FFc 6K 16:9
FF 5.8K 6:5 1-30
FFc 3.8K 16:9 1-60、66、72、75、

88、90、96、100、
110、120

S35 5.8K 17:9 1-60
S35 5.8K 16:9
S35 4.3K 4:3 1-60
S35c 4K 17:9 1-60、66、72、75、

88、90、96、100、
110、120

S35c 3.8K 16:9

S35 1.9K 16:9 1-60、66、72、75、
88、90、96、100、
110、120、150、180、
200、240

S&Q Motionを割り当てたアサイナブルボタン
（108ページ）を押すと、スロー＆クイックモー
ションモードをOn/Offできます。
ボタンを長押しすると、撮像時のフレームレート
を設定できます。

［メモ］
プロジェクトステータスのRec Function、フルメニューの
ShootingメニューのS&Q Motionでも設定可能です。

［ご注意］
•	 記録中、再生中、クリップ一覧画面表示中は、スロー＆

クイックモーションモードにできません。
•	 スロー＆クイックモーションモードでは、音声は記録で

きません。
•	 スロー＆クイックモーションモードでは、オートアイリス

機能、オートシャッター機能が無効になります。
•	 一部のレンズでは、記録フォーマットとの組み合わせに

よっては、フレームレートの上限に制限がある場合があ
ります。

•	 スロー＆クイックモーションモードでは、オートフォーカ
スに以下の制限があります。
	‒ レンズ機種とシステム周波数、撮像フレームレートに

よる制限

ソニー製
レンズ

システム周波
数

AF可否

SEL16F28 59.94/29.97/ 
23.98

30、60、
120fpsで可

50.00/25.00 25、50、
100fpsで可

24.00 不可
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間欠的に映像を記録する（イ
ンターバルレック機能）

本機のメモリーを利用して間欠的に映像を取り込
み、記録するインターバルレック機能は、主に動
きの少ない被写体を撮影するときに有効です。
記録を開始すると、設定したフレーム数（Number 
of Frames）分の映像を、任意のインターバル

（Interval Time）で自動記録できます。

撮影の間隔（Interval Time）

1回に記録する画像フレーム数
（Number of Frames）

インターバルレックを有効にしているときは、撮
影開始前にビデオライトHVL-LBPC（別売）を自
動的に点灯させ、光量、色温度を安定させた状
態で撮影を行うことができます（プリライティン
グ機能）。

［ご注意］
•	 インターバルレックなどの特殊記録機能を複数同時に使

用できません。
•	 インターバルレック使用中に他の特殊記録機能を有効に

すると、インターバルレックは自動的に解除されます。
•	 ビデオフォーマットなどのシステム設定を変更すると、

インターバルレックモードは自動的に解除されます。
•	 記録中や再生中、クリップ一覧画面表示中にインターバ

ルレックの設定を変更することはできません。

設定するには

プロジェクトステータスのRec Functionで
Interval Recを選択し、Number of Framesと
Interval Timeを設定してください。
ビデオライトHVL-LBPC（別売）を使用する場合
は、必要に応じてProjectメニューのInterval 
RecのPre-Lightingで記録開始前のビデオライ
ト点灯時間を設定してください。

［メモ］
フルメニューのProjectメニューのInterval Rec（45ペー
ジ）でも設定できます。

［ご注意］
•	 HVL-LBPCを使用するには、別売のMIシュー搭載ハン

ドルが必要です。
•	 ビデオライトを記録前に点灯させる場合は、ビデオラ

イトのスイッチをAUTOに設定してください。このとき
TechnicalメニューのVideo Light Set（64ページ）
の設定に従ってビデオライトが自動点灯／消灯します。

•	 ビデオライトのスイッチをONに設定すると、ビデオライ
トは常時点灯します。（ビデオライトは自動点灯／消灯し
ません。）

•	 各設定により消灯時間が5秒以下になる場合は、ビデオ
ライトは消灯しません。

本機の電源を切るとインターバルレックモー
ドは解除されますが、Number of Frames、
Interval Time、Pre-Lightingの設定は保持さ
れます。次回インターバルレックモードで撮影す
るときに再設定する必要はありません。

撮影するには

REC（記録開始／記録停止）ボタンを押すと記
録が開始され、LCDモニター上に「IntRec」と

「IntStby」が交互に表示されます。
プリライティング機能を使用する場合は、記録
が始まる前にビデオライトが点灯します。

撮影を終了するには

記録停止の操作を行います。
撮影を終了すると、その瞬間までメモリーに蓄え
られていた映像がメディアに記録されます。

インターバルレックモードを解除する
には

次のいずれかを実行します。
•	 電源を切る。
•	 記録待機中に、プロジェクトステータスのRec 

FunctionをInterval Rec以外に設定する。
また、本機が再起動した場合もインターバルレッ
クモードは解除されます。

記録中の動作制限

•	 音声は記録されません。
•	 レックレビュー操作は行えません。

本機の電源が切れた場合

•	 本機の電源スイッチをOffにした場合は、その
瞬間までメモリーに蓄えられていた映像を記録
するため、メディアにアクセスしてから、自動
的に電源が切れます。

•	 記録中にバッテリーを取り外したり、DC電源
コードを引き抜いたり、ACアダプター側の電
源を切ったりした場合は、その瞬間以前に撮
影したショット（最大10秒）が記録されないこ
とがあります。バッテリー交換の際は充分ご注
意ください。

数秒前の映像から記録する
（ピクチャーキャッシュレック
機能）

ピクチャーキャッシュレック機能を使用すると、カ
メラが捉えた映像を、指定した時間内蔵キャッシュ
メモリーに蓄えておくことによって、記録開始操作
以前にさかのぼって記録することができます。
プロジェクトステータスのPicture Cache Recで
Onを選択し、キャッシュサイズを設定します。

Cache Sizeの設定 蓄積時間（目安）
Short 5秒
Medium 10秒
Long 20秒
Max 各記録フォーマットでの最

大値

［メモ］
•	 蓄積時間は、撮影フレームレートや記録フォーマットに

より短くなる場合があります。キャッシュサイズ設定画
面右下の表示でご確認ください。

•	 フルメニューのProjectメニューのPicture Cache Rec
（46ページ）でも設定できます。

•	 アサイナブルボタン（108ページ）でPicture Cache 
RecのOn/Offを切り替えることもできます。

［ご注意］
•	 ピクチャーキャッシュレックは、インターバルレック、2

スロット同時記録、プロキシ記録との併用はできません。
ピクチャーキャッシュレックをOnにすると、これらの機
能は強制的にOffになります。

•	 記録中、レックレビュー中は、ピクチャーキャッシュレッ
クモードにできません。

•	 ピクチャーキャッシュレックがOnのときは、タイムコー
ドがRegenやRec Runに設定されていてもFree Run
モードで記録されます（54ページ）。

•	 ピクチャーキャッシュレック中はOutput Formatの設
定を変更できない場合があります。この場合、一度ピク
チャーキャッシュレックをOffにしてから変更操作を行っ
てください。
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ピクチャーキャッシュレックを実行す
る

Picture Cache RecがOnのとき、LCDモニター
上に「Cache」が点灯します。
REC（記録開始／記録停止）ボタンを押すと記録
が開始され、キャッシュメモリーに蓄積されてい
る映像からメモリーカードに書き込まれます。

ピクチャーキャッシュレック機能を解
除するには

プロジェクトステータスのPicture Cache Recを
Offにするか、Picture Cache Rec機能を割り当
てたアサイナブルボタンを押します。

［ご注意］
•	 記録フォーマットや基本ルックが変更されると、それま

で蓄えていた映像をクリアし、新たに蓄積を開始します。
したがって、変更直後に記録を開始しても、フォーマッ
ト変更前の映像はピクチャーキャッシュレックできませ
ん。

•	 メモリーカード挿入直後にピクチャーキャッシュレックの
開始／終了操作を行った場合は、データがカードに記録
されないことがあります。

•	 画像の蓄積は、ピクチャーキャッシュレック機能をOnに
してから開始されます。したがって、Onにする前の映像
はピクチャーキャッシュレックできません。

•	 再生、レックレビュー、クリップ一覧画面表示など、メ
モリーカードにアクセスしている間は映像を蓄えないた
め、この間の映像はピクチャーキャッシュレックできま
せん。

メモリーカードAとメモリー
カードBの両方に記録するに
は（2スロット同時記録）

ProjectステータスのSimul Rec（29ページ）、
またはフルメニューのProjectメニュー >Simul 
RecのSetting（45ページ）をOnにすると、メ
モリーカードAとメモリーカードBの両方に同時に
記録できます。

映像信号モニター

MonitoringメニューのDisplay On/Offの
Video Signal Monitor（57ページ）で、LCD
モニターに表示する映像信号の種類をウェーブ
フォーム、ベクトルスコープ、ヒストグラムのいず
れかに設定できます。
オレンジの線はゼブラレベルの設定値を表しま
す。
Video Signal Monitorを割り当てたアサイナブ
ルボタン（108ページ）でも設定できます。

モニター対象の表示

Cine EIモードのときは、モニター対象を示す情
報として、色域設定（87ページ）またはモニター
LUTの設定（42ページ）が映像信号モニターの
右上に表示されます。

Look

ガンマ表示アシスト機能

Customモード（87ページ）でTarget Display
をHDR(HLG)にしたとき、モニタリングステータ
スのGamma Display Assist*をOnにすると、
LCDモニターをHDR撮影しやすい表示にするこ
とができます。
*	 フルメニューのMonitoringメニュー>Gamma Display 

AssistのSetting（58ページ）でも設定可能。

ガンマ表示アシスト機能有効時にLCD
モニターの表示を選択する

ガンマ表示アシスト機能が有効なときにLCDモニ
ターのHDR映像の表示方法を次の2種類から選
択できます。

HDRの低輝度部分や高輝度部分のコント
ラストを保持して表示する
HDRの表現力を活かし、明るめの露出、または
暗めの露出で撮影した場合にも、黒つぶれや白
飛びを起こさずに映像をLCDモニターに表示でき
ます。その反面、全体のコントラストは少し低く
なります。
この表示方法を使用するには、フルメニュー
のProjectメニュー > HDR SettingのLCD 
Monitor SDR Preview（45ページ）をOffに
します。

HDRからSDRへの変換を想定して簡易変
換されたSDRを表示
いままでのSDRと同様の感覚でのカメラオペレー
ションが可能です。
HDRとSDRのゲイン差をSDR Gainで設定するこ
とで、HDR映像の明るさを設定できます。
この表示方法を使用するには次の設定を行います。

1	 フルメニューのProjectメニュー >HDR 
SettingのLCD Monitor SDR Preview

（45ページ）をOnにする。

2	 フルメニューのProjectメニュー >HDR 
SettingのSDR Gain（45ページ）で、
HDRモード時のSDRゲイン値を調節する。

ブリージング補正

フルメニューのTechnicalメニュー >Lensの
Breathing Compensation（64ページ）で、
Eマウントレンズのブリージング補正を行うかどう
かを設定できます。
ブリージングとは、フォーカス位置が変化すると
画角変動が起こる現象です。
ブリージング補正を実行すると、画角が一定にな
るよう電子的に画像が切り出され、ブリージング
のない撮影が可能になります。

［ご注意］
•	 ブリージング補正を有効にすると、画角と画質がわずか

に変化します。
•	 レンズによっては、ブリージング補正を有効に設定して

いても画角の変化を補正しきれない場合があります。
•	 ブリージング補正に非対応のレンズが装着されている場

合は補正できません。
•	 以下のいずれかの条件では、本機能はOffに固定されま

す。
	‒ Technicalメニュー >LensのDistortion Comp.が

Off
	‒ Shootingメニュー >S&Q MotionのSettingがOn
	‒ Projectメニュー > Rec FormatのImager Scan 

Mode（44ページ）がS35 5.8K 17:9/S35 5.8K 
16:9/S35 1.9K 16:9以外

	‒ Projectメニュー > Rec FormatのCodec（44ペー
ジ）がX-OCN(LT)
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ボケを調節する（ボケ調節機
能）

アイリス操作にNDフィルターやゲインを連動さ
せて、ボケ具合を簡単に調節することができます。

ボケ調節機能のOn/Offを切り替える

本機能は露出の手動調節時のみ有効にすること
ができます。NDフィルターをバリアブルモードに
し、アイリス、ゲイン、シャッター、NDフィルター
を手動調節に設定してください。
フルメニューのShootingメニュー >IrisのBokeh 
Control（40ページ）で、ボケ調節機能のOn/
Offを切り替えることができます。
ボケ調節機能がOnの状態では、NDフィルター

およびゲインの表示に アイコンが表示されま
す。 

［メモ］
Bokeh Controlを割り当てたアサイナブルボタン（108
ページ）で、ボケ調節機能のOn/Offを切り替えることもで
きます。

ボケ具合を調節する

1	 ボケ調節機能をOnにする。

2	 アイリスを開放端にする。

3	 NDフィルターを1/128に設定する。

4	 ゲインを0dBにして、照明で適正露出にする。

5	 フォーカスを合わせる。

6	 アイリスを調整する。
ボケ具合が変化します。

［メモ］
•	 ボケ調節機能がOnの場合は、アイリス調節による露出

変化をNDフィルターおよびゲインが連動し相殺すること
で、ボケ具合を変化させることができます。

•	 ボケ調節はアイリス操作に対して、まずNDフィルターか
ら連動します。NDフィルターが変化できなくなった際に、
ゲインが連動します。

•	 MFのときは一旦アイリスを開けて、ピントを合わせてお
くことをお勧めします。

•	 ボケ調節機能の代わりにオートNDフィルターを使用す
ると、NDフィルターが被写体の明るさの変化に追従し
ます。

ゲイン連動中の表示について

ボケ調節機能がOnのとき、アイリスを調整する
とゲインが変化することがあります。
ゲインが連動して変化した際は、画面上に注意

メッセージが表示され、ゲイン表示の アイコ
ンが点滅します。 

［ご注意］
•	 本機と通信できるEマウントレンズでのみ本機能は有効

です。
•	 本機能はソニー製のEマウントレンズでIrisリングを使っ

た操作で最大限の効果を得られます。
•	 操作スピード、レンズ、撮影設定、被写体によって見え

方が異なり、明るさが変化して見える場合があります。
撮影前のカメラテストを強くお勧めします。

•	 アイリスを絞った後に開くとき、または開いた後に絞る
とき、のように操作方向を変更する際には明るさが変化
する場合があります。その場合は、あらかじめ余分に操
作してから少し戻して明るさを確認してから、撮影を開
始してください。 
例）F8から絞りを開いて背景をぼかしていく撮影をした
い場合、事前にF8よりも余分に絞った後に再度F8まで
開いてから明るさを確認し、撮影を開始してください。

•	 ボケ調節の操作はゆっくり行ってください。操作を速くす
る場合は画の変化を確認しながら徐々にお試しください。

•	 ボケ調節はすべての撮影条件で映像の品位を保証する
ものではありません。

•	 下記の操作を行ったとき、ボケ調節機能がOffになりま
す。
	‒ 本機の電源を切ったとき
	‒ アイリス、ゲイン、シャッター、NDフィルターのいず

れかをAutoにしたとき
	‒ 撮影モードを切り替えたとき
	‒ NDフィルターをクリアまたはステップモードにしたと

き
	‒ レンズを取り外したとき
	‒ 周波数切り替えなど、再起動を行ったとき

デスクイーズ表示設定

シネマスコープサイズの映像コンテンツを制作す
る場合、アナモフィックレンズを使用して撮影し
ます。
使用するアナモフィックレンズの倍率に合わせた
デスクイーズ表示設定をすると、直接被写体を見
たときと同じ縦横比に調整された映像をSDI出力
やHDMI出力したり、LCDモニターに表示したり
することができます。
デスクイーズ表示は、フルメニューの
Monitoringメニュー > De-Squeeze（56ペー
ジ）で設定します。

［ご注意］
デスクイーズ倍率が1.8xまたは2.0xに設定されている場
合、波形モニター（VSM）はデスクイーズ表示での左右非
表示部分も検波します。

高輝度の白飛びまたは低輝
度の暗部を確認する

映像出力やLCDモニター映像を、高輝度の白飛
び確認または低輝度の暗部確認の状態にするこ
とができます。
High Keyを有効にすると、高輝度部分の差異が
見やすくなり、高輝度の白飛びを確認できます。
Low Keyを有効にすると、低輝度部分の差異が
見やすくなり、低輝度の暗部を確認できます。
High/Low Keyを割り当てたアサイナブルボタン
を押すと、High Key表示/Low Key表示/Off（通
常表示）を切り換えることができます。

［ご注意］
•	 SDIの出力フォーマットがMonitor FHD以外に設定さ

れている場合は、SDI出力をLUT Onに設定していると、
High/Low Keyを有効にできません。

•	 Shootingメニュー > LUT On/Off（42ページ）が
LUT Onに設定されている映像に表示されます。

•	 メニュー画面やホーム画面を表示する、Base Lookを
変更するなどの操作を行うと、High/Low Key表示は
Offになります。
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プロキシ記録をする
CFexpressカードに記録するのと同時に、プロ
キシクリップをSDカードに記録することができま
す。

	˜ 使用可能なメモリーカードや、メモリーカードのフォー
マット方法、残容量の確認方法については「残りの記録
可能時間を確認する」（20ページ）をご覧ください。

撮影前の設定

1	 ProjectステータスのProxy Rec（29ペー
ジ）、またはフルメニューのProjectメニュー
のProxy Recで、Setting（45ページ）を
Onにする。

2	 SDカードを、ラベルを上にしてUtility SD
カードスロット（4ページ）に差し込む。

［ご注意］
プロキシ記録は、ピクチャーキャッシュレック、スロー＆ク
イックモーション、インターバルレックと同時にOnにするこ
とはできません。プロキシ記録をOnにすると、これらの機
能は強制的にOffになります。

プロキシ記録で撮影する

撮影前に必要な設定が終わったら、REC（記録開
始／記録停止）ボタンを押すと記録を開始します。

［ご注意］
•	 メモリーカードにアクセス中に本機の電源を切ったりメ

モリーカードを抜いた場合はデータは保証されません。
メモリーカードに記録されたすべてのデータが壊れる可
能性があります。電源を切ったり、メモリーカードを抜
くときは、必ず使用するメモリーカードのアクセスランプ
が消灯していることを確認してから操作してください。

•	 出し入れ時にはメモリーカードの飛び出しにご注意くだ
さい。

撮影を終了するには、記録停止の操作を行いま
す。

プロキシ記録時のオーディオ
チャンネルを設定する

フルメニューのProjectメニュー >Proxy Recの
Audio Channel（45ページ）で、プロキシデー
タに記録するオーディオチャンネルを設定できま
す。

記録されるファイルについて

拡張子は「.mp4」です。
タイムコードも同時に記録されます。

ファイルの保存先について

記録したファイルは、以下のディレクトリーに保
存されます。

記録メディア フォルダパス
SDカード /PRIVATE/PXROOT/Clip

ファイル名について

メモリーカードに記録されるクリップ名+S03とな
ります。
クリップ名については、フルメニューの
TC/MediaメニューのClip Name Format

（55ページ）をご覧ください。

［ご注意］
オリジナルクリップとプロキシクリップの関連付けが切れた
ときは、記録開始時のタイムコードをクリップ名としたプロ
キシクリップが生成されます。
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リモートコントロールパネルを接続する
RCP-1530/3100/3500/3501などのリモートコ
ントロールパネルと本機をLANケーブルで接続す
ると、それらの機器から本機の機能の一部をコ
ントロールできます。

リモートコントロールパネル
を接続する

1	「LANケーブルを使用して接続する」
（82ページ）の手順に従って、有線LAN
ネットワークの設定をする。

2	 フルメニューのNetworkメニュー >Wired 
LANのCamera Remote Control（69
ページ）をEnableにする。

3	 フルメニューのTechnicalメニュー >RCPの
CNS Mode（63ページ）をBridgeに設定
する。

4	 リモートコントロールパネルをBRIDGEモー
ドに設定する。

5	 本機のIPアドレスをリモートコントロールパ
ネルに設定する。
設定方法については、各リモートコントロー
ルパネルの取扱説明書をご覧ください。

6	 本機のネットワーク端子とPoE対応スイッチ
ングハブをLANケーブルで接続し、リモート
コントロールパネルと接続する。

リモートコントロール
パネル

PoE 対応スイッチング
ハブ

7	 本機の電源を入れる。
本機はリモートコントロールモードになり、
リモートコントロールパネルで本機の撮影操
作が可能となります。

［ご注意］
•	 無線LANで接続した場合の動作は保証されません。
•	 インターネット経由で接続することはできません。
•	 他のネットワーク機能と同時に使用することはできませ

ん。

リモートコントロールモード
を解除する

1	 フルメニューのTechnicalメニュー >RCPの
CNS ModeをOffに設定する。

2	 フルメニューのNetworkメニュー >Wired 
LANのCamera Remote Controlを
Disableに設定する。

3	 本機の電源を切り、リモートコントロールパ
ネルを取り外す。

［ご注意］
スマートフォンやタブレットなどの操作用デバイスと本
機をLAN接続する場合は、「デバイスとLAN接続する」

（79ページ）をご確認ください。

6章　外部機器の接続
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外部モニターや記録装置を接続する
記録・再生画像を外部モニターに表示させるとき
は、本機の出力信号を選択し、接続するモニター
に応じた接続ケーブルを使用してください。
VTRなどの記録装置を接続して、本機の出力信
号を記録することもできます。
外部HDMIモニターに各種ステータス情報やメ
ニューなどを表示させることができます。モニター
に出力する信号に応じて、Monitoringステー
タスのInfo. Disp.（29ページ）、またはフルメ
ニューのMonitoringメニューのOutput Display

（56ページ）をOnに設定してください。なお、
映像出力フォーマットがMonitor FHDの場合に
は、HDMIの代わりにSDIモニターにも各種情報
を表示させることができます。

［ご注意］
本機に外部モニターや記録装置などを接続する際には次の
ことにご注意ください。これらを守らないと、本機の内部
回路に大電流が流れ、電気部品が破壊することがあります。
1.	 DCケーブルについて 

外部モニターや記録装置などに接続するDCケーブルは、
GND線のインピーダンスが低いものを使用してくださ
い。

2.	電位差の確認について 
事前にすべての接続機器と本機に電位差がないことを
確認してください。

（1）	外部モニターや記録装置などすべての接続機器と本
機の接続がない状態にする。 
75Ω同軸ケーブルやHDMIケーブルなどは接続しな
い状態で確認してください。

（2）	すべての接続機器と本機のDCケーブルを接続し、各
接続機器および本機の電源をONにする。

（3）	本機と各接続機器との間に電位差がないことをテス
ターなどで確認する。

もし電位差があった場合はいずれかのDCケーブルの
GND線のインピーダンスが高いことが考えられます。
GND線のインピーダンスが低いケーブルに交換するなど
して電位差がなくなるようにしてください。

3.	接続と電源ONの順番について 
各ケーブル接続と電源ONは次の順番で行ってください。

（1）	本機と外部モニターや記録装置などの電源をすべて
OFFにする。

（2）	初めにすべての機器のDCケーブルを接続する。

（3）	75Ω同軸ケーブル、HDMIケーブルなどを接続する。
（4）	すべての接続機器と本機の電源をONにする。

詳しくはソニーのサービス窓口にご相談ください。

SDI OUT 1/2端子（BNC型）

SDI OUT 1端子は、12GまでのSDI信号を出力で
きます。
SDI OUT 2端子は、3GまでのSDI信号を出力で
きます。
Monitoringメニュー（56ページ）で出力フォー
マットを設定します。
接続には市販の75Ω同軸ケーブルを使用してくだ
さい。

［ご注意］
•	 	X-OCN記録時、HDMI出力が有効な状態では、SDI出

力はできません。
•	 	本機と外部機器の間のアースが確実に接地されているこ

とを確認してから、電源を入れてください。（75Ω同軸ケー
ブルを接続した後に、本機と外部機器の電源を入れる
ことをお勧めします。） 
やむを得ず、電源投入状態で外部機器を接続する場合
は、75Ω同軸ケーブルを外部機器に接続した後に、本
機と接続してください。

•	 映像出力フォーマットでMonitor FHDを選択していると
きは、一部のリアルタイムのメタデータは出力されませ
ん。

本機と同時に外部機器で記録を開始
するには

SDI信号出力時は、フルメニューのProjectメ
ニュー >SDI/HDMI Rec Control（46ペー
ジ）のSettingをSDI/HDMI Remote I/Fまたは
Parallel Recに設定すると、SDI OUT端子に接
続した外部機器にRECトリガー信号を出力するこ
とによって、本機と同期した記録が可能になりま
す。

［ご注意］
•	 接続した外部機器がRECトリガー信号に対応していない

場合は動作しません。
•	 メディアが挿入されていないときは、RECトリガー信号

のみ出力されます。
•	 映像出力フォーマットでMonitor FHDを選択していると

きやX-OCN記録時は、Parallel Recを選択できません。

HDMI OUT端子（Type Aコネ
クター）

フルメニューのMonitoringメニュー（56ペー
ジ）で、出力フォーマットを設定します。

本機と同時に外部機器で記録を開始
するには

HDMI信号出力時は、フルメニューのTC/Media
メニュー >HDMI TC OutのSetting（54ペー
ジ）をOnにして、Projectメニュー >SDI/HDMI 
Rec ControlのSetting（46ページ）をSDI/
HDMI Remote I/FまたはParallel Recに設定
すると、HDMI OUT端子に接続した外部機器に
RECトリガー信号を出力することによって、本機
と同期した記録が可能になります。

［ご注意］
•	 接続した外部機器がRECトリガー信号に対応していない

場合は動作しません。
•	 SDI/HDMI Remote I/Fに設定した場合、記録メディア

が挿入されていないときは、RECトリガー信号のみ出力
されます。

•	 X-OCN記録時はParallel Recは選択できません。
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本機のREF IN/REF OUT端子を介して、本機を
複数台使用して撮影するときなど、特定の基準
信号に同期させたり、タイムコードを合わせるこ
とができます。

映像信号の位相を合わせる
（ゲンロック）

本機のTC/REF IN/OUT切り替えスイッチ（6
ページ）をIN側に設定し、REF IN/REF OUT端子

（7ページ）に基準信号を入力することによっ
て、ゲンロックが可能です。
入力できる基準信号は、選択している記録フォー
マットのシステム周波数によって異なります。

記録フォーマットの
システム周波数

入力可能な基準信号

59.94P 1920×1080 59.94i 
720×486 59.94i

50P 1920×1080 50i 
720×576 50i

29.97P 1920×1080 59.94i 
720×486 59.94i

25P 1920×1080 50i 
720×576 50i

24P 1920×1080 48i(24PsF)
1920×1080 24P

23.98P 1920×1080 47.95i 
(23.98PsF)
1920×1080 23.98P

［ご注意］
•	 基準信号が不安定な場合は、ゲンロックできません。
•	 サブキャリアは同期しません。

撮像位相（タイミング）を調整するには

ゲンロック入力信号の位相に対して、撮像位相お
よび映像出力信号の位相を、ステップ単位で最
大約1フレーム期間の範囲で調整できます。

1	 フルメニューのTC/Media > Genlock > 
Sync Shift（54ページ）を選択する。

ゲンロックの位相調整画面が表示されます。

2	 8方向ボタンを押すか、またはマルチファン
クションダイヤルを回してカーソルを移動し、
ステップ値を変更する桁を選択する。

3	 8方向ボタンか、またはマルチファンクショ
ンダイヤルを回してステップ値を入力する。
入力したステップ値を時間値に換算した値
がNew Valueに反映されます。
8方向ボタン、またはマルチファンクショ
ンダイヤルを押すと、New Valueの値が
Currentに反映され、撮像位相および映像
出力信号の位相に反映されます。

入力したステップ値が上限を超えた場合は、
New Valueの値に"Over"が表示されます。
Applyを選択して決定すると、New Value
の値がCurrentに反映され、撮像位相およ
び映像出力信号の位相に反映されます。
Resetを選択すると、初期値に戻すことが
できます。

ステップ値が上限値を超えた状態（New 
Valueの値に"Over"が表示された状態）は、
上限値で設定反映されます。

4	 Setを選択して決定する。

ステップ値が決定され、メニュー画面に遷
移します。

Cancelを押すと、入力する前のステップ値
に戻り、メニュー画面に遷移します。

［ご注意］
•	 ステップ値を撮像位相に反映させる際は、LCDモニター、

SDI出力、HDMI出力に一時的に黒画や「No Sync」が表
示されます。位相調整結果の確認は、出力信号が安定
してから行ってください。

•	 設定したステップ値は、本機の電源を切っても保持され
ます。ゲンロック信号が入力されると、その値が撮像位
相に反映されます。

•	 記録フォーマットのFrequencyまたはImager Scan 
Modeを変更すると、設定したステップ値はリセットさ
れます。必要に応じて、再設定を行ってください。

•	 ステップ値が「0」に設定されている場合は、ゲンロック
入力信号の位相と映像出力信号の位相が一致している
状態です。

•	 映像出力フォーマットがMonitor FHDに設定されてい
る場合、ゲンロック入力信号の位相と映像出力信号の
位相が一致していない場合があります。

•	 映像出力フォーマットがMonitor FHDに設定されてい
る場合、本機の電源を切って、次に電源を入れたときに、
映像出力信号の位相が設定した位相と異なる状態にな
ることがあります。その場合は再度位相を調整してくだ
さい。

•	 映像出力フォーマットがMonitor FHDに設定されてい
る場合、ステップ値を1ステップだけ変更しても映像出
力信号の位相が変わらない場合があります。その場合
は、さらにステップ値を変更してください。

他機のタイムコードにロック
させる

タイムコード供給源となる機器は、タイムコード
出力が更新されるモード（Free RunやClock）に
設定してください。

1	 TC/MediaメニューのTimecode（54
ページ）を次のように設定する。
Mode：Preset
Run：Free Run

外部同期
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2	 DURATION/TC/U-BIT機能が割り当てられ
たアサイナブルボタン（108ページ）を押し
て、画面にタイムコードを表示させる。

3	 TC/REF IN/OUT切り替えスイッチ（6
ページ）がIN側になっていることを確認し、
REF IN/REF OUT端子とTC IN/TC OUT端
子に、それぞれHDまたはSDのリファレンス
ビデオ信号およびそれに同期した基準タイム
コードを供給する。

これで本機のタイムコードジェネレーターが基準
タイムコードにロックし、画面に「EXT-LK」と表
示されます。
ロックしてから約10秒経過した後は、外部から
の基準タイムコードの接続を外しても、外部ロッ
ク状態は保たれます。

［ご注意］
•	 供給する基準タイムコードとリファレンスビデオ信号が、

SMPTEタイムコードの規格を満たした位相関係にある
ことを確認してください。

•	 外部ロックの操作をすると、タイムコードは瞬時に外部
のタイムコードにロックし、外部タイムコードの値と同じ
値がタイムデータ表示部に出ますが、タイムコードジェ
ネレーターが安定するまでの数秒間は、記録を開始しな
いでください。

•	 リファレンスビデオ信号の周波数と本機のフレーム周波
数が同じでないと、正しくロックできず、本機が正常に
動作できません。この場合、タイムコードも外部のタイ
ムコードに正しくロックできません。

•	 接続を外した場合、基準タイムコードに対し1時間で1フ
レームずれる場合があります。

外部ロックを解除するには

TC/MediaメニューのTimecodeの設定を変更
してください。
システム周波数を変更した場合や、特殊記録モー
ド（スロー＆クイックモーションまたはインターバ
ルレック）での記録を開始した場合も、外部ロッ
クは解除されます。

本機のタイムコードに他機の
タイムコードを合わせる

本機のタイムコード設定を、タイムコード出力が
更新されるモード（Free RunやClock）に設定し
てください。

1	 TC/MediaメニューのTimecodeで本機の
タイムコードを設定する（54ページ）。

2	 TC/REF IN/OUT切り替えスイッチ（6
ページ）がOUT側になっていることを確認し、
TC IN/TC OUT端子とREF IN/REF OUT端
子を、同期させたい機器のタイムコード入力
端子、リファレンス信号入力端子に接続する。
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コンピューターでクリップ管理・編集する
USBケーブルを使って接続す
る

カードリーダー（別売）を使う

コンピューターにCFexpress Type Bカードリー
ダーまたはSDカードリーダーをUSBケーブルで接
続すると、カードリーダーのスロットに装着され
たメモリーカードがコンピューターの拡張ドライ
ブとして認識されます。なお、対応したコンピュー
ターの場合、本機のマスストレージモードを使用
するよりも高速に、クリップを取り込むことがで
きます。

本機のマスストレージモードを使う

［ご注意］
フルメニューのNetworkメニュー >USB Tetheringの
SettingがOnの場合は、マスストレージモードを使うこと
ができません。Offに設定してください。

本機をUSBケーブルで接続すると、カードスロッ
トA/Bに装着されたメモリーカードがコンピュー
ターの拡張ドライブとして認識されます。

1	 USB-C端子（5ページ）とコンピューター
をUSBケーブルで接続する。

2	 本機の電源を入れる。
LCDモニターにUSBの接続を有効にするかど
うかを確認するメッセージが表示されます。

	 ［ご注意］
•	 	アクセスランプが赤く点灯しているときは、次の操

作をしないでください。
	‒ 電源を切る。電源コードを抜く。
	‒ メモリーカードを抜く。
	‒ USBケーブルを抜く。

•	 メモリーカードのフォーマットや修復など、実行を
確認するメッセージや実行中のメッセージが表示
されている間は、USB接続確認メッセージは表示
されません。 
フォーマットや修復などの実行が終了後に表示さ
れます。またクリップの詳細情報表示中もUSB接
続確認メッセージは表示されません。処理が終了
するか、クリップ一覧画面に戻ると表示されます。

3	 マルチファンクションダイヤルを回して
Executeを選ぶ。

4	 Windowsの場合、「マイコンピュータ」にリ
ムーバブルディスクとして追加されているこ
とを確認する。
Macの場合、デスクトップにNO NAMEま
たはUntitledフォルダー（フォルダー名は任
意に変更可）が作成されていることを確認す
る。

［ご注意］
•	 アクセスランプが赤く点灯しているときは、次の操作を

しないでください。
	‒ 電源を切る。電源コードを抜く
	‒ メモリーカードを抜く
	‒ USBケーブルを抜く

•	 すべてのコンピューターについて、動作を保証するもの
ではありません。

ノンリニア編集システムを使
う

ノンリニア編集システムには、本機で記録した
フォーマットに対応した編集ソフトウェア（別売）
が必要です。
専用アプリケーションソフトウェアを使って、あ
らかじめコンピューターのHDDに編集したいク
リップを保存しておきます。
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使用上のご注意
安全にご使用いただくために、付属の「ご使用に
なる前に」とあわせてご覧ください。

取り扱い・保管上のご注意

強い衝撃を与えない

内部構造や外観の変形などの損傷を受けること
があります。

動作中は布などで包まないでください

内部の温度が上がり、好ましくありません。

使い終わったら

電源を切ってください。

長時間使わないときは

バッテリーを抜いておいてください。

レンズを太陽光に向けて放置しない

太陽光がレンズを通して内部に焦点を結び、火災
の原因となることがあります。

輸送

•	 メモリーカードは必ず取り出しておいてくださ
い。

•	 トラック、船、航空機など、本機を貨物として
扱う輸送では、お買い上げ時の梱包材をご使
用ください。

お手入れ

外装の汚れは、乾いた柔らかい布で拭き取りま
す。ひどい汚れは、中性洗剤液を少し含ませた
布で拭いた後、カラ拭きします。
アルコール、ベンジン、シンナーなどの薬品類は、
表面が変質したり、塗料がはげることがあります
ので、使わないでください。
エアダスター等の高風圧機器を使ったお手入れ
は光学部位の損傷につながりますのでお控えくだ
さい。

万一、異常が生じたときは

お買い上げ店かソニーのサービス窓口にご相談く
ださい。

ファンについて

ファンは有寿命部品として定期的な交換が必要
です。
常温でのご使用の場合、5年を目安に交換してく
ださい。ただし、交換時期は目安であり、部品
の寿命を保証するものではありません。交換の
際はお買い上げ店にご相談ください。

電解コンデンサについて

電解コンデンサの寿命は約5年です。
（常温で1日に8時間、1カ月で25日間、通常に使
用すると想定した場合）
したがって、使用時間が上記より長い場合は、
その分寿命は短くなります。

バッテリー端子に関するご注
意

機器に搭載されているバッテリー端子（バッテリー
パックやACアダプターとの接点部分）は消耗品で
す。
振動や衝撃によって端子が変形したり、曲がった
り、あるいは長期の屋外での使用などによって表
面が腐食したりすると、本体に電源が供給され
なくなります。
長期間機器を使用していただくために、定期点
検を実施することをお願いします。点検につきま
しては、ソニーのサービス担当者または営業担当
者にご相談ください。

使用場所・保管場所

水平な場所、空調のある場所に保管してください。
次のような場所での使用・保管は避けてください。
•	 極端に寒い所、暑い所（使用温度は0℃～

40℃）。 
真夏、窓を閉め切った自動車内は50℃を越え
ることがあります。

•	 湿気・ほこりの多い所。
•	 雨があたる所。
•	 激しく振動する所。
•	 強い磁気を発生するものの近く。
•	 強力な電波を発生するテレビやラジオの送信

所の近く。
•	 直射日光が長時間当たる場所や暖房器具の近

く。

携帯電話などによる電波障害を防止す
るために

携帯電話などを本機の近くで使用すると、誤動
作を引き起こしたり、映像、音声などに影響を与
えることがあります。
本機の近くでは、携帯電話などの電源はできる
だけ切ってください。

レーザービームについてのご注意

レーザービームはCMOSイメージセンサーに損傷
を与えることがあります。レーザービームを使用
した撮影環境では、CMOSイメージセンサー表
面にレーザービームが照射されないように充分
注意してください。特に医療用などの強力なレー
ザー光の場合は、反射光や散乱光でも損傷を与
えることがあります。
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画面について

•	 画面を太陽に向けたままにすると、画面を傷
めます。屋外でご使用のときは、太陽に向けて
放置しないでください。

•	 画面を強く押したり、ひっかいたり、上に物を
置いたりしないでください。画面にムラが出た
り、パネルの故障の原因になります。

•	 使用中に画面が暖かくなることがありますが、
故障ではありません。

LCD（液晶）画面について

本機のLCD（液晶）パネルは有効画素99.99％以
上の非常に精密度の高い技術で作られています
が、画面上に黒い点が現れたり（画素欠け）、常
時点灯している輝点（赤、青、緑など）や滅点が
ある場合があります。また、LCD（液晶）パネル
の特性上、長期間ご使用の間に画素欠けが生じ
ることもあります。
これらの現象は故障ではありませんので、ご了承
の上本機をお使いください。
なお、これらの点が記録されることはありません。

結露について

本機を寒いところから急に暖かいところに持ち込
んだときなど、機器表面や内部に水滴がつくこと
があります。これを結露といいます。結露が起き
たときは電源を切り、結露がなくなるまで放置し、
結露がなくなってからご使用ください。結露時の

ご使用は機器の故障の原因となる場合がありま
す。

本機搭載のCMOSイメージセ
ンサーの現象

［ご注意］
撮影画面に出る下記の現象は、イメージセンサー特有の現
象で、故障ではありません。

白点

イメージセンサーは非常に精密な技術で作られ
ていますが、宇宙線などの影響により、まれに
画面上に微小な白点が発生する場合があります。
これはイメージセンサーの原理に起因するもので
故障ではありません。
また、下記の場合、白点が見えやすくなります。
•	 高温の環境で使用するとき
•	 ゲイン（感度）を上げたとき

フリッカー

蛍光灯、ナトリウム灯、水銀灯、LEDによる照明
下で撮影すると、画面が明滅したり、色が変化
したように見えることがあります。

画面表示に関するご注意

次のような場合、ビューファインダーおよび出力
の映像が乱れることがあります。

	‒ フォーマットを切り換えたとき
	‒ FPSフレームレートを切り換えたとき
	‒ ゲンロックがかかるとき

ファイルの断片化について

画像が正しく記録・再生されないときは記録メ
ディアをフォーマット（初期化）してください。長
期間、映像の記録・クリップの消去を繰り返して
いると、記録メディア内のファイル が断片化（フ
ラグメンテーション）して、映像が正しく記録・
保存できなくな る場合があります。このような場
合は、クリップのバックアップを取ったあと、メ
ニューの TC/Media > Format Media（55
ページ）で記録メディアのフォーマット（初期化）
を行ってください。

医療機器に近づけない 

本製品（付属品を含む）は磁石を使用しているた
め、ペースメーカー、水頭症治療用圧可変式シャ
ントなどの医療機器に影響を与える恐れがありま
す。本製品をこれらの医療機器をご使用の方に
近づけないでください。これらの医療機器を使
用されている場合、本製品のご使用前に担当医
師にご相談ください。

セキュリティに関するご注意

•	 セキュリティの面から、本機を常に最新のソフ
トウェアバージョンにアップデートすることを強
く推奨します。セキュリティに関するご注意の
詳細については、以下のサイトをご確認くださ
い。 
https://helpguide.sony.net/pro/

network_security_c/v1/h_zz/index.html
•	 通信を行う機器でセキュリティ対策を行わな

かった結果、または、通信仕様上の、やむを
得ない事情により、データ漏洩等、セキュリティ
上の問題が発生した場合、弊社ではそれによっ
て生じたあらゆる損害に対する責任を負いかね
ます。

•	 使用環境によってはネットワーク上の意図せぬ
第三者から製品にアクセスされる可能性があり
ます。本機をネットワークに接続する際には、
セキュアなネットワークであることをご確認の
上ご使用ください。

•	 利用者が気付かないうちに、電波が届くところ
から意図せぬ第三者に通信内容を盗み見られ
てしまうおそれがあります。無線LAN通信を利
用する際は、通信内容を保護するために、適
切なセキュリティ対策をしてください。

•	 本製品のネットワークへの接続には、ルーター
やファイアウォールなどの保護機能を通して接
続をしてください。このような接続をしない場
合、セキュリティ上の問題が生じる可能性があ
ります。

•	 セキュリティの面から、製品をネットワークに
接続してご使用になる際は、ブラウザでコント
ロール画面にアクセスし、アクセス制限設定を
工場出荷時の設定値から変更して設定するこ
とを強く推奨します。（66ページ） 
また、定期的にパスワードを変更することを推
奨します。

•	 設定作業中または設定作業後のブラウザで他
のサイトを閲覧しないでください。ブラウザに
ログインした状態が残りますので、意図しない
第三者の使用や悪意のあるプログラムの実行
を防ぐために、設定作業が完了したら必ずブラ
ウザを終了してください。

https://helpguide.sony.net/pro/network_security_c/v1/h_zz/index.html
https://helpguide.sony.net/pro/network_security_c/v1/h_zz/index.html
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初期設定値は、太文字（例：1920×1080P (Level A)）で示します。

［ご注意］
•	 出力フォーマットの解像度はフルメニューのProjectメニュー >Rec FormatのFrequency、CodecおよびVideo Formatの設定によって制限されます（44ページ）。
•	 再生画像の解像度より大きな解像度が設定されている場合、映像は出力されません。
•	 システム周波数が50/59.94Hz時のMonitor FHD出力は1920X1080P Level-A出力になります。

SDI OUT/HDMI OUT端子の出力フォーマット

システム周波数設定
（Projectメニュー >Rec Formatの
Frequency）

Codec設定
（Projectメニュー >Rec FormatのCodec）

記録解像度設定 出力フォーマット（Monitoringメニュー >Output Format）
SDI1 SDI2 HDMI

50/59.94Hz X-OCN LT （6K 17:9）
（5.8K 17:9）
（4.3K 4:3）
（4K 17:9）

Monitor FHD Monitor FHD －
－ － 4096x2160P
－ － 1920x1080P
－ － 1920x1080i

（6K 16:9）
（5.8K 16:9）
（3.8K 16:9）

Monitor FHD Monitor FHD －
－ － 3840x2160P
－ － 1920x1080P
－ － 1920x1080i

（1.9K 16:9） Monitor FHD Monitor FHD －
－ － 1920x1080P
－ － 1920x1080i

XAVC Intra 4096x2160
（17:9）

Monitor FHD Monitor FHD －
4096x2160P1) 2048x1080P(A)1) 4096x2160P1)

4096x2160P1) 2048x1080P(A)1) 1920x1080P1)

4096x2160P1) 2048x1080P(A)1) 1920x1080i1)

1920x1080P(A) 1920x1080P(A) 1920x1080P
1920x1080P(A) 1920x1080P(A) 1920x1080i
1920x1080P(B) 1920x1080P(B) 1920x1080P
1920x1080P(B) 1920x1080P(B) 1920x1080i
1920x1080i 1920x1080i 1920x1080i

出力のフォーマットと制限
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システム周波数設定
（Projectメニュー >Rec Formatの
Frequency）

Codec設定
（Projectメニュー >Rec FormatのCodec）

記録解像度設定 出力フォーマット（Monitoringメニュー >Output Format）
SDI1 SDI2 HDMI

50/59.94Hz XAVC Intra
XAVC Long

3840x2160
（16:9）

Monitor FHD Monitor FHD －
3840x2160P1) 1920x1080P(A)1) 3840x2160P1)

3840x2160P1) 1920x1080P(A)1) 1920x1080P1)

3840x2160P1) 1920x1080P(A)1) 1920x1080i1)

1920x1080P(A) 1920x1080P(A) 1920x1080P
1920x1080P(A) 1920x1080P(A) 1920x1080i
1920x1080P(B) 1920x1080P(B) 1920x1080P
1920x1080P(B) 1920x1080P(B) 1920x1080i
1920x1080i 1920x1080i 1920x1080i

XAVC Intra
XAVC Long

1920x1080
（16:9）

Monitor FHD Monitor FHD －
1920x1080P(A) 1920x1080P(A) 1920x1080P
1920x1080P(A) 1920x1080P(A) 1920x1080i
1920x1080P(B) 1920x1080P(B) 1920x1080P
1920x1080P(B) 1920x1080P(B) 1920x1080i
1920x1080i 1920x1080i 1920x1080i
－ － 720x576P2)/720x480P3)

25/29.97Hz X-OCN LT （8.6K 17:9）
（6K 17:9）
（5.8K 17:9）
（5.8K 6:5）
（4.3K 4:3）
（4K 17:9）

Monitor FHD Monitor FHD －
－ － 4096x2160P
－ － 1920x1080P

（8.6K 16:9）
（6K 16:9）
（5.8K 16:9）
（3.8K 16:9）

Monitor FHD Monitor FHD －
－ － 3840x2160P
－ － 1920x1080P

（1.9K 16:9） Monitor FHD Monitor FHD －
－ － 1920x1080P

XAVC H-I HQ
XAVC H-I SQ

8192x4320
（17:9）

Monitor FHD Monitor FHD －
1920x1080P 1920x1080P 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080i

XAVC H-I HQ
XAVC H-I SQ
XAVC H-L

7680x4320
（16:9）

Monitor FHD Monitor FHD －
1920x1080P 1920x1080P 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080i
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システム周波数設定
（Projectメニュー >Rec Formatの
Frequency）

Codec設定
（Projectメニュー >Rec FormatのCodec）

記録解像度設定 出力フォーマット（Monitoringメニュー >Output Format）
SDI1 SDI2 HDMI

25/29.97Hz XAVC Intra 4096x2160
（17:9）

Monitor FHD Monitor FHD －
4096x2160P1) 2048x1080P1) 4096x2160P1)

4096x2160P1) 2048x1080P1) 1920x1080P1)

1920x1080P 1920x1080P 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080i

XAVC Intra
XAVC Long

3840x2160
（16:9）

Monitor FHD Monitor FHD －
3840x2160P1) 1920x1080P1) 3840x2160P1)

3840x2160P1) 1920x1080P1) 1920x1080P1)

1920x1080P 1920x1080P 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080i

XAVC Intra
XAVC Long

1920x1080
（16:9）

Monitor FHD Monitor FHD －
1920x1080P 1920x1080P 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080i

23.98Hz X-OCN LT （8.6K 17:9）
（6K 17:9）
（5.8K 17:9）
（5.8K 6:5）
（4.3K 4:3）
（4K 17:9）

Monitor FHD Monitor FHD －
－ － 4096x2160P
－ － 1920x1080P

（8.6K 16:9）
（6K 16:9）
（5.8K 16:9）
（3.8K 16:9）

Monitor FHD Monitor FHD －
－ － 3840x2160P
－ － 1920x1080P

（1.9K 16:9） Monitor FHD Monitor FHD －
－ － 1920x1080P

XAVC H-I HQ
XAVC H-I SQ

8192x4320
（17:9）

Monitor FHD Monitor FHD －
1920x1080P 1920x1080P 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080P

XAVC H-I HQ
XAVC H-I SQ
XAVC H-L

7680x4320
（16:9）

Monitor FHD Monitor FHD －
1920x1080P 1920x1080P 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080P
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システム周波数設定
（Projectメニュー >Rec Formatの
Frequency）

Codec設定
（Projectメニュー >Rec FormatのCodec）

記録解像度設定 出力フォーマット（Monitoringメニュー >Output Format）
SDI1 SDI2 HDMI

23.98Hz XAVC Intra 4096x2160
（17:9）

Monitor FHD Monitor FHD －
4096x2160P1) 2048x1080P1) 4096x2160P1)

4096x2160P1) 2048x1080P1) 1920x1080P1)

1920x1080P 1920x1080P 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080P

XAVC Intra
XAVC Long

3840x2160
（16:9）

Monitor FHD Monitor FHD －
3840x2160P1) 1920x1080P1) 3840x2160P1)

3840x2160P1) 1920x1080P1) 1920x1080P1)

1920x1080P 1920x1080P 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080P

XAVC Intra
XAVC Long

1920x1080
（16:9）

Monitor FHD Monitor FHD －
1920x1080P 1920x1080P 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080P

24Hz X-OCN LT （8.6K 17:9）
（6K 17:9）
（5.8K 17:9）
（5.8K 6:5）
（4.3K 4:3）
（4K 17:9）

Monitor FHD Monitor FHD －
－ － 4096x2160P
－ － 1920x1080P

（8.6K 16:9）
（6K 16:9）
（5.8K 16:9）
（3.8K 16:9）

Monitor FHD Monitor FHD －
－ － 3840x2160P
－ － 1920x1080P

（1.9K 16:9） Monitor FHD Monitor FHD －
－ － 1920x1080P

XAVC H-I HQ
XAVC H-I SQ

8192x4320
（17:9）

Monitor FHD Monitor FHD －
1920x1080P 1920x1080P 1920x1080P

XAVC Intra 4096x2160
（17:9）

Monitor FHD Monitor FHD －
4096x2160P1) 2048x1080P1) 4096x2160P1)

1920x1080P 1920x1080P 1920x1080P

1)	 スロー＆クイックモーション撮影時のフレームレートが66fps以上の場合は選択できません。
2)	システム周波数が50のとき。
3)	システム周波数が59.94のとき。
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クリップ記録・再生時間
ソニー製CFexpress Type BメモリーカードVPG400 960GBを使用した場合の記録・再生時間は以下のとおりです（単位：min）。

［ご注意］
記録・再生時間は、1クリップとして連続記録したときのものです。記録するクリップ数によっては記載の時間より短くなる場合があります。また、使用条件やメモリーの特性などにより、多少の誤差が生じる場合があります。

Imager Scan 
Mode

Frequency Codec
X-OCN (LT) XAVC H-I HQ 

8192x4320
XAVC H-I HQ 
7680x4320

XAVC H-I SQ 
8192x4320

XAVC H-I SQ 
7680x4320

XAVC H-L 
7680x4320

XAVC-I 
4096x2160

XAVC-I 
3840x2160

XAVC-I 
1920x1080

XAVC-L 
3840x2160

XAVC-L 
1920x1080

FF 8.6K 17:9 23.98 74 130 － 194 － － － － － － －
24 74 130 － 193 － － － － － － －
25 71 125 － 186 － － － － － － －
29.97 59 104 － 155 － － － － － － －
50 － － － － － － － － － － －
59.94 － － － － － － － － － － －

FF 8.6K 16:9 23.98 69 － 130 － 194 239 － － － － －
24 69 － － － － － － － － － －
25 66 － 125 － 186 239 － － － － －
29.97 55 － 104 － 155 238 － － － － －
50 － － － － － － － － － － －
59.94 － － － － － － － － － － －

FFc 6K 17:9 23.98 149 － － － － － 494 － － － －
24 149 － － － － － 493 － － － －
25 143 － － － － － 473 － － － －
29.97 119 － － － － － 397 － － － －
50 71 － － － － － 241 － － － －
59.94 60 － － － － － 201 － － － －

FFc 6K 16:9 23.98 140 － － － － － － 494 1207 1145 2121
24 140 － － － － － － － － － －
25 134 － － － － － － 473 985 1140 2106
29.97 112 － － － － － － 397 981 1127 2070
50 67 － － － － － － 241 512 756 1939
59.94 56 － － － － － － 201 510 745 1878

FF 5.8K 6:5 23.98 102 － － － － － － － － － －
24 102 － － － － － － － － － －
25 98 － － － － － － － － － －
29.97 82 － － － － － － － － － －
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Imager Scan 
Mode

Frequency Codec
X-OCN (LT) XAVC H-I HQ 

8192x4320
XAVC H-I HQ 
7680x4320

XAVC H-I SQ 
8192x4320

XAVC H-I SQ 
7680x4320

XAVC H-L 
7680x4320

XAVC-I 
4096x2160

XAVC-I 
3840x2160

XAVC-I 
1920x1080

XAVC-L 
3840x2160

XAVC-L 
1920x1080

FFc 3.8K 16:9 23.98 342 － － － － － － 494 1207 1145 2121
24 341 － － － － － － － － － －
25 328 － － － － － － 473 985 1140 2106
29.97 274 － － － － － － 397 981 1127 2070
50 165 － － － － － － 241 512 756 1939
59.94 137 － － － － － － 201 510 745 1878

S35 5.8K 17:9 23.98 164 － － － － － 494 － － － －
24 164 － － － － － 493 － － － －
25 157 － － － － － 473 － － － －
29.97 131 － － － － － 397 － － － －
50 79 － － － － － 241 － － － －
59.94 65 － － － － － 201 － － － －

S35 5.8K 
16:9

23.98 154 － － － － － － 494 1207 1145 2121
24 154 － － － － － － － － － －
25 147 － － － － － － 473 985 1140 2106
29.97 123 － － － － － － 397 981 1127 2070
50 74 － － － － － － 241 512 756 1939
59.94 61 － － － － － － 201 510 745 1878

S35 4.3K 4:3 23.98 211 － － － － － － － － － －
24 211 － － － － － － － － － －
25 202 － － － － － － － － － －
29.97 169 － － － － － － － － － －
50 101 － － － － － － － － － －
59.94 84 － － － － － － － － － －

S35c 4K 17:9 23.98 321 － － － － － 494 － － － －
24 321 － － － － － 493 － － － －
25 308 － － － － － 473 － － － －
29.97 257 － － － － － 397 － － － －
50 155 － － － － － 241 － － － －
59.94 129 － － － － － 201 － － － －
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Imager Scan 
Mode

Frequency Codec
X-OCN (LT) XAVC H-I HQ 

8192x4320
XAVC H-I HQ 
7680x4320

XAVC H-I SQ 
8192x4320

XAVC H-I SQ 
7680x4320

XAVC H-L 
7680x4320

XAVC-I 
4096x2160

XAVC-I 
3840x2160

XAVC-I 
1920x1080

XAVC-L 
3840x2160

XAVC-L 
1920x1080

S35c 3.8K 
16:9

23.98 342 － － － － － － 494 1207 1145 2121
24 341 － － － － － － － － － －
25 328 － － － － － － 473 985 1140 2106
29.97 274 － － － － － － 397 981 1127 2070
50 165 － － － － － － 241 512 756 1939
59.94 137 － － － － － － 201 510 745 1878

S35 1.9K 16:9 23.98 1250 － － － － － － － 1207 － 2121
24 1249 － － － － － － － － － －

25 1199 － － － － － － － 985 － 2106
29.97 1008 － － － － － － － 981 － 2070
50 614 － － － － － － － 512 － 1939
59.94 514 － － － － － － － 510 － 1878
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トラブル時の対処
電源

症状 原因 対策
電源が入らない。 バッテリーパックからの電源、

DC IN電源のどちらも供給さ
れていない。

バッテリーパックを取り付ける（14ペー
ジ）か、ACアダプターを使用してAC電源
に接続する（14ページ）。

バッテリーパックが完全に消耗
している。

充電済みのバッテリーパックと交換する
（14ページ）。

電源が途中で切れる。 バッテリーパックが消耗してい
る。

充電済みのバッテリーパックと交換する
（14ページ）。

バッテリーパックがすぐ消耗す
る。

温度が極端に低いところで使
用している。

バッテリーパックの特性によるもので、故
障ではありません。

充電が不充分。 バッテリーパックをもう一度充電し直す
（14ページ）。
フル充電してもすぐに消耗する場合は、
バッテリーパックの寿命です。新しいバッ
テリーパックに交換してください。

記録・再生

症状 原因 対策
REC（記録開始／記録停止）ボ
タンを押しても記録が始まら
ない。

メモリーカードの容量がいっ
ぱいになっている。

充分な空き容量のあるメモリーカードに
交換する。

修復が必要なメモリーカード
が入っている。

メモリーカードを修復する（20ページ）。

音声が記録できない。 AUDIO LEVEL（CH1/CH2）ダ
イヤルが最小の位置になって
いる。

AUDIO LEVEL（CH1/CH2）ダイヤルを調
節する（106ページ）。

記録した音声がひずんでいる。 音声レベルが高すぎる。 AUDIO LEVEL（CH1/CH2）ダイヤルを調
節する（106ページ）。

雑音が多い。 音声レベルが低すぎる。 AUDIO LEVEL（CH1/CH2）ダイヤルを調
節する（106ページ）。
外部マイク選択時は、フルメニューの
Audioメニュー > Audio InputのINPUT 
MIC Referenceの設定値も調節する

（59ページ）。

症状 原因 対策
クリップを再生できない。 クリップが編集されている。 コンピューターでフォルダーやファイル名

を変更したり、クリップを加工したりする
と、再生できない場合があります。故障
ではありません。

クリップが他機で記録されて
いる。

他機で記録したクリップは、再生できな
かったり、正しいサイズで表示されなかっ
たりすることがあります。故障ではありま
せん。

外部機器

症状 対策
本機がコンピューターに認識され
ない。

コンピューターからUSBケーブルを抜き、もう一度しっかりと差し込む。
コンピューターからUSBケーブルを抜き、コンピューターを再起動して
から正しい手順でもう一度コンピューターと本機をつなぐ。
USB-C端子またはUSB/マルチ端子のどちらか一方にのみUSBケーブ
ルを差し込んでコンピューターと本機をつなぐ。

クリップがコンピューターに取り込
めない。

コンピューターからUSBケーブルを抜き、本機の電源を入れてから、
もう一度つなぐ。
クリップをコンピューターに取り込むにはアプリケーションソフトウェ
アのダウンロードが必要です（118ページ）。



7章　付録：トラブル時の対処129

ワイヤレスLAN使用時

［ご注意］
本機とワイヤレスLANアクセスポイントまたは端末機器間の障害物や電波状況、壁の材質など、周囲の環境によって通信
可能距離が短くなったり、接続できなくなったりすることがあります。本機の場所を移動するなど、本機とアクセスポイン
トまたは端末機器の距離を近づけて、接続/通信状態を確認してください。

症状 対策
端末機器から本機にアクセスでき
ない

•	 ワイヤレスLANの接続（IPアドレスなど）を確認してください。
•	 アクセスポイントのクライアント間の通信設定が無効になっている

可能性があります。詳しくは、アクセスポイントの取扱説明書をご
覧ください。

ログインできない 登録したユーザー名、パスワードが正しいか確認してください。

インターネット接続

症状 対策
ファイル転送が失敗する サーバーのユーザー名/パスワードが間違っている可能性があります。

正しい値を入力してください。
ファイル転送ができない 電波状態が悪い可能性があります。

移動して再度試してください。

NDフィルター使用時

症状 対策
NDフィルターが動かない。 次の作業により、手動でClearの位置に移動させることができます。

1	 ND STEP/VARIABLEスイッチ（5ページ）をSTEPの位置にして、ND FILTER POSITION上下
ボタン（5ページ）の下ボタンを押してND CLEARランプを点灯させる。

2	 本機の電源を切る。

3	 底面の丸いフタ（2箇所）を外す。

4	 ドライバーを穴（2箇所）に差し込んで左に回す。
•	 左に回すことで、NDフィルターがClear側に動きます。Clearの位置になるまで回し続けてくだ

さい。
•	 φ2.4以下のマイナスドライバーを使用してください。ドライバー挿入部の深さは約3.0 cmです。

ドライバー挿入部 
（フタを外した状態）

［ご注意］
•	 上記の作業は、通常の動作時には行わないでください。NDフィルターが動かなくなった場合のみに行ってください。通

常の動作時に行うと、NDユニットが故障するおそれがあります。
•	 上記の作業を行ったあと、サービスセンターで本機を修理してください。
•	 上記の作業を行ってもエラーメッセージが出たままの場合がありますが、撮影は可能です。
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エラー／警告表示
本機では警告、注意、動作確認などが必要な状況では、LCDモニターのメッセージ表示、記録／タリー
ランプの点滅、および警告音で対応します。
警告音は、ヘッドホン端子に接続したヘッドホンに出力します。

エラー表示

次のような表示が出た場合は、本機は動作を停止します。

LCDモニター 
エラー表示

警告音 記録／ 
タリーランプ

原因と対策

E+エラーコード 連続音 高速点滅 本体の異常の可能性があります。
電源を切り、接続している機器やケーブル類、メディ
アに異常がないか確認してください。これらに異常が
ないときは、再度電源を入れ、エラーが継続する場
合はソニーのサービス窓口にご連絡ください。

（電源スイッチを（Standby）の位置にしても電源が
切れない場合は、バッテリーパックやDC IN電源も外
してください。）
本機の状況によっては、エラー表示や警告音が出な
い可能性があります。

警告表示

次のような表示が出た場合は、メッセージに従って対策してください。

LCDモニター 
警告表示

警告音 記録／ 
タリーランプ

原因と対策

Battery Near End 断続音 点滅 バッテリーパックの残量が少なくなっています。
早い機会に充電してください。

Battery End 連続音 高速点滅 バッテリーパックが消耗しました。記録はできません。
一旦操作を中止し、バッテリーパックを交換してくだ
さい。

Temperature High 断続音 点滅 内部温度が上昇しました。
一旦電源を切り、温度が下がるまで使用を中止してく
ださい。

Media Temperature 
High

断続音 点滅 CFexpressカードの温度が上昇しました。
カードを交換するか、温度が下がるまでカードの使
用を中止してください。

LCDモニター 
警告表示

警告音 記録／ 
タリーランプ

原因と対策

Voltage Low 断続音 点滅 DC IN電圧が低くなっています（段階1）。供給電源を
確認してください。

Insufficient Voltage 連続音 高速点滅 DC IN電圧が低すぎます（段階2）。記録はできません。
他の電源に接続し直してください。

Media Near Full 断続音 点滅 メモリーカードの残量が少なくなっています。
早い機会に交換してください。

Media Full 連続音 高速点滅 メモリーカードの残量がないため、記録、コピーはで
きません。
交換してください。

Clips Near Full 断続音 点滅 メモリーカードに記録できる残りのクリップ数が少な
くなっています。
早い機会に交換してください。

Clips Full 連続音 高速点滅 メモリーカードに記録できるクリップ数の上限に達し
ました。
これ以上記録やコピーはできません。交換してくださ
い。

Last Clip Recording 断続音 点滅 記録中のクリップの記録を完了すると、記録可能なク
リップ数の上限に達します。
新しいメモリーカードをご用意ください。

Media(A)1) Life Near 
End

断続音 点滅 メモリーカードの寿命が僅かです。早めに交換してく
ださい。

Media(A)1) Life End 連続音 高速点滅 メモリーカードの寿命がきました。交換してください。
Media(A)1) Near Full 断続音 点滅 同時記録機能使用時
Media(A)1) Full 連続音 高速点滅 同時記録機能使用時
Media(A)1) Clips 
Near Full

断続音 点滅 同時記録機能使用時

Media(A)1) Clips Full 連続音 高速点滅 同時記録機能使用時
Media(A)1) Last Clip 
Rec

断続音 点滅 同時記録機能使用時

Transfer Jobs Near 
Full

― ― FTPファイル転送ジョブ登録可能数が少なくなってい
ます。

Transfer Jobs Full ― ― FTPファイル転送ジョブ登録可能数が上限に達しまし
た。ジョブを追加したい場合は、不要なジョブを削
除してください。2)

1)	 スロットBに入れたカードの場合は(B)
2)	フルメニューのNetworkメニューのFile Transfer > View Job List（69ページ）からジョブを選んで削除することがで

きます。または、Monitor & Controlアプリケーションのジョブリストからジョブを削除することができます。
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注意・動作確認表示

画面中央部分に次のような注意・動作確認表示が現れることがあります。この場合は次表に従って対
処してください。

表示内容 原因と対策
Battery Error
Please Change Battery

バッテリーパックに異常が検出されました。
正常なバッテリーパックに交換してください。

Backup Battery End
Please Change

バックアップ電池の残量が不足しています。
バックアップ電池を充電してください。

Unknown Media（A）1）

Please Change
パーティションが切られているメモリーカードや、本機で扱えるク
リップ数を超えて記録されたメモリーカードが挿入されました。
本機では使用できませんので、交換してください。

Cannot Use Media（A）1）

Unsupported File System
ファイルシステムの異なるカードまたはフォーマットされていない
カードが挿入されました。
本機では使用できませんので、交換または本機でフォーマットし
てください。

Media Error
Media（A）1）Needs to be Restored

メモリーカードに異常が発生し、修復が必要な状態になりました。
メモリーカードの修復を行ってください。

Media Error
Cannot Record to Media（A）1）

メモリーカードが故障して、記録ができなくなりました。
再生は可能ですので、コピーをとるなどして、新しいメモリーカー
ドに交換することをお勧めします。

Media Error
Cannot Use Media（A）1）

メモリーカードが故障して記録も再生もできなくなりました。
本機では扱えませんので、他のカードに交換してください。

Media（A）1）Error
Recording Halted
Playback Halted

メモリーカードに異常が発生したため、記録または再生が停止し
ました。
頻繁に起きる場合には、メモリーカードを交換してください。

Media Reached Rewriting Limit
Change Media（A）1）

メモリーカードの寿命がきました。
バックアップをとり、速やかに交換してください。継続して使用す
ると、正常に記録・再生できない可能性があります。
詳しくは、メモリーカードの取扱説明書を参照してください。

The specified address is invalid. 指定したアドレスが間違っています。
正しく設定しているか確認してください。

Cannot Use Specified Port 
Number

指定したポート番号が間違っています。
正しく設定しているか確認してください。

Fan Stopped 本体内のファンが停止しています。
高温下での使用を避け、電源を切ってソニーのサービス担当者に
連絡してください。

表示内容 原因と対策
LENS Error Eマウントレンズ装着時にレンズI/F通信でレンズの不具合が検出

されました。
Eマウントレンズとの接続状態を確認してください。

This Multi Term. acc is not 
supported by the device and 
cannot be used.
Please verify the compatibility.

非対応のアクセサリーが検出されました。
本機が対応するマルチ端子アクセサリーは、付属のグリップリモ
コンのみです。

Failed. DHCP Onでアドレスが割り当てられない場合、本エラーが出る
可能性があります。
DHCPサーバーの設定を確認してください。

Addition of auto upload job failed. 転送ジョブの数が上限に達しています。
不要なジョブをクリアしてください。また、オリジナルクリップま
たはプロキシクリップの自動転送先設定が間違っている可能性が
あります。正しく設定しているか確認してください。

<SSID>Not found. 指定した<SSID>のネットワーク（アクセスポイント）が見つかりま
せん。
正しく設定しているか確認してください。

<SSID>Authentication Failed 指定した<SSID>のネットワーク（アクセスポイント）の接続認証に
失敗しました。
パスワードなどを正しく設定しているか確認してください。

An IP address conflict has 
occurred. Please check the 
network settings.

ワイヤレスLANステーションモード、または有線LANのネットワー
クセグメントがUSBテザリングと重複しています。
アドレスを手動で変更するか、お使いのネットワークルーターの
設定を変更してください。

The IP address of the Wireless 
LAN Access Point Mode has been 
changed due to an IP address 
conflict.

ワイヤレスLANアクセスポイントモードとUSBテザリングのネット
ワークセグメントが重複したため、ワイヤレスLANアクセスポイン
トモードのIPアドレスを変更しました。
IPアドレスを確認してください。

1）	スロットBに入れたカードの場合は（B）
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ファイルに保存される項目
フルメニューによる設定項目

Yes：ファイルに保存されます
No：ファイルに保存されません
―：ファイルに保存されません（一時的動作メニュー）

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Shooting ISO/Gain/EI Mode Yes No
ISO/Gain Yes No
Exposure Index Yes No
Shockless Gain Yes No
Base Sensitivity Yes No
Base ISO Yes No

ND Filter Display Mode Yes No
Shutter Mode Yes No

Shutter Speed On/Off Yes No
Shutter Speed Yes No
Shutter Angle Yes No
ECS On/Off Yes No
ECS Frequency Yes No

Iris Bokeh Control No ―

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Shooting Auto Exposure Level Yes No
Mode Yes No
Speed Yes No
Auto ND Filter Yes No
AGC Yes No
AGC Limit Yes No
AGC Point Yes No
Auto Shutter Yes No
A.SHT Limit Yes No
A.SHT Point Yes No
Auto Iris Yes No
Clip High light Yes No
Detect Window Yes No
Detect Window Indication Yes No
Custom Width Yes No
Custom Height Yes No
Custom H Position Yes No
Custom V Position Yes No

White White Select Yes No
Auto White Balance ― ―
ATW Yes No
Color Temp Yes No
Tint Yes No
R Gain Yes No
B Gain Yes No
Set to Preset Value ― ―

White Setting Shockless White Yes No
ATW Speed Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Shooting Focus AF Transition Speed Yes No
AF Subj. Shift Sens. Yes No
Focus Area Yes No
Subject Recognition AF Yes No
Touch Function in MF Yes No
Multi Selector Function Yes No
Pointer Color Yes No
Pointer Border Yes No
AF Assist Yes No

S&Q Motion Setting Yes No
Frame Rate Yes No

LUT On/Off SDI/HDMI Yes No
SDI Yes No
LCD/Proxy/Stream Yes No
LCD/HDMI/Px/Stream Yes No

Noise Suppression Setting(Custom) Yes No
Level(Custom) Yes No
Setting(Cine EI) Yes ―
Level(Cine EI) Yes ―

Flicker Reduce Mode Yes No
Frequency Yes No

Image Stabilization SteadyShot Yes No
PL Stabilization Yes No
Stabilization Adjustment Yes No
Focal Length Yes No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Project Base Setting Shooting Mode Yes ―
Target Display Yes ―

Rec Format Frequency Yes No
Imager Scan Mode Yes No
Codec Yes No
Video Format Yes No

Cine EI Setting Color Gamut Yes ―
Embed LUT File Yes No

HDR Setting LCD Monitor SDR Preview Yes No
SDR Gain Yes No

Simul Rec Setting Yes No
Proxy Rec Setting Yes No

Audio Channel Yes No
Interval Rec Setting No No

Interval Time Yes No
Number of Frames Yes No
Pre-Lighting Yes No

Picture Cache Rec Setting Yes No
Cache Size Yes No
Cache Rec Time ― ―

SDI/HDMI Rec Control Setting Yes No
Assignable Button <1> Yes No

<2> Yes No
<3> Yes No
<4> Yes No
<5> Yes No
<6> Yes No
<7> Yes No
<8> Yes No
<9> Yes No
<10> Yes No
<11> Yes No
Focus Hold Button Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Project Assignable Dial Grip/Remote Dial Yes No
Grip Dial Direction Yes No

Multi Function Dial Default Function Yes No
User File Load from UTILITY SD ― ―

Save to UTILITY SD ― ―
File ID No No
Load Customize Data Yes No
Load White Data Yes No

All File Load from UTILITY SD ― ―
Load from Cloud(Private) ― ―
Load from Cloud(Share) ― ―
Save to UTILITY SD ― ―
Save to Cloud(Private) ― ―
Save to Cloud(Share) ― ―
File ID Yes No
Load Network Data No No

Paint/Look Scene File Recall ― ―
Store ― ―
Delete ― ―
Preset Recall ― ―

Base Look Select Yes Yes
Delete ― ―
Delete All ― ―
Import from Utility SD ― ―
Import from Cloud(Private) ― ―
Import from Cloud(Share) ― ―
Input Yes ―
Output Yes ―
AE Level Offset Yes ―

Reset Paint Settings Reset without Base Look ― ―

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Paint/Look Black Master Black Yes Yes
R Black Yes Yes
B Black Yes Yes

Knee Setting Yes Yes
Auto Knee Yes Yes
Point Yes Yes
Slope Yes Yes

Detail Setting Yes Yes
Level Yes Yes
H/V Ratio Yes Yes
B/W Balance Yes Yes
Limit Yes Yes
Crispening Yes Yes
High Light Detail Yes Yes

Matrix User Matrix Yes Yes
Saturation Yes Yes
User Matrix Level Yes Yes
User Matrix Phase Yes Yes
User Matrix R-G Yes Yes
User Matrix R-B Yes Yes
User Matrix G-R Yes Yes
User Matrix G-B Yes Yes
User Matrix B-R Yes Yes
User Matrix B-G Yes Yes

Multi Matrix Setting Yes Yes
Area Indication No No
Area Indication Control Yes No
Reset ― ―
Axis No No
Hue Yes Yes
Saturation Yes Yes
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

TC/Media Timecode Mode Yes No
Run Yes No
Setting No No
Reset ― ―
TC Format Yes No

TC Display Display Select Yes No
Users Bit Mode Yes No

Setting No No
HDMI TC Out Setting Yes No
Genlock Reference Lock Type ― ―

Sync Shift Yes ―
Sync Shift Value ― ―

Clip Name Format Camera ID No No
Reel Number No No
Camera Position No No
XAVC Root Folder Name Yes No

Update Media Media(A) ― ―
Media(B) ― ―

Format Media Media(A) ― ―
Media(B) ― ―
Utility SD ― ―

Monitoring Output Format SDI1 Yes No
SDI2 Yes No
HDMI Yes No
REF No No

De-Squeeze Ratio Yes No
SDI (Monitor FHD) Yes No
HDMI (FHD Output) Yes No
LCD Monitor Yes No

Output Display SDI Yes No
HDMI Yes No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Monitoring Display On/Off Focus Mode Yes No
Focus Position Yes No
Network Status Yes No
File Transfer Status Yes No
Rec/Play Status Yes No
SDI/HDMI Rec Control Yes No
Tally Yes No
Battery Remain Yes No
Zoom Position Yes No
Image Stabilization Yes No
Media Status Yes No
Lens Info Yes No
Look Name Yes No
UWP RF Level Yes No
Focus Area Indicator Yes No
Subject Recognition Frame Yes No
Tracking AF Pointer Yes No
Clip Name Yes No
Video Level Warning Yes No
Timecode Yes No
Gamma Display Assist Yes No
Video Signal Monitor Yes No
Imager Scan Mode Yes No
Frame Rate Yes No
Rec Format Yes No
Rec Look Yes No
Level Gauge Yes No
Audio Level Meter Yes No
Auto Exposure Mode Yes No
Auto Exposure Level Yes No
ND Filter Yes No
Iris Yes No
ISO/Gain/EI Yes No
Base ISO/Sensitivity Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Monitoring Display On/Off Shutter Yes No
White Balance Yes No
Clip Number Yes No
Notice Message Yes No

Marker Setting Yes No
Color Yes No
Center Marker Yes No
Safety Zone Yes No
Safety Area Yes No
Aspect Marker Yes No
Aspect Mask Yes No
Aspect Safety Zone Yes No
Aspect Safety Area Yes No
Aspect Select Yes No
Custom Aspect Ratio Yes No
Guide Frame Yes No
100% Marker Yes No
User Box Yes No
User Box Width Yes No
User Box Height Yes No
User Box H Position Yes No
User Box V Position Yes No

LCD Monitor Setting Brightness Yes No
Color Mode Yes No

Gamma Display Assist Setting Yes No
Peaking Setting Yes No

Type Yes No
Normal Peaking Level Yes No
Color Peaking Level Yes No
Color Yes No
Color Edge Type Yes No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Monitoring Zebra Setting Yes No
Zebra1 Level Yes No
Zebra1 Aperture Level Yes No
Zebra2 Level Yes No

Focus Magnifier Focus Mag Button Target Yes No
Audio Audio Input CH1 Input Select Yes No

CH2 Input Select Yes No
CH3 Input Select Yes No
CH4 Input Select Yes No
INPUT1 MIC Reference Yes No
INPUT2 MIC Reference Yes No
Line Input Reference Yes No
Reference Level Yes No
CH1 Wind Filter Yes No
CH2 Wind Filter Yes No
CH3 Wind Filter Yes No
CH4 Wind Filter Yes No
CH3 Level Control Yes No
CH4 Level Control Yes No
CH3 Input Level Yes No
CH4 Input Level Yes No
Audio Input Level Yes No
Limiter Mode Yes No
CH1&2 AGC Mode Yes No
CH3&4 AGC Mode Yes No
AGC Spec Yes No
1kHz Tone on Color Bars Yes No
CH1 Level Yes No
CH2 Level Yes No
CH3 Level Yes No
CH4 Level Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Audio Audio Output Monitor CH Yes No
Volume No No
Headphone Out Yes No
Alarm Level Yes No
HDMI Output CH Yes No
SDI Out CH (Monitor FHD) Yes No

Clip 
Operations

Display Clip 
Properties

― ―

Set Clip Flag Add OK ― ―
Add NG ― ―
Add KEEP ― ―
Delete Clip Flag ― ―

Lock/Unlock Clip Select Clip ― ―
Lock All Clips ― ―
Unlock All Clips ― ―

Transfer Clip Select Clip ― ―
All Clips ― ―

Transfer Clip (Proxy) Select Clip ― ―
All Clips ― ―

Filter Clips OK ― ―
NG ― ―
KEEP ― ―
None ― ―
All ― ―

Customize View Clips Caption Yes ―

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Technical Color Bars Setting No No
Type Yes No

ND Dial CLEAR with Dial Yes No
Rec/Tally Rec/Tally Lamp Yes No

Tally Control Yes No
Rec Start/Stop Beep Yes No

LOCK Switch Settings with Rec Button Yes No
with Hand Grip Remote Yes No
with LCD Monitor Yes No

Touch Operation Setting Yes No
Rec Review Setting Yes No
Zoom Zoom Type Yes No
Handle Zoom Setting Yes No

High Yes No
Low Yes No

Menu Settings User Menu Only Yes No
User Menu with Lock No No

Menu Page On/Off Project Yes No
Audio Yes No
Monitoring Yes No
Assignable Button Yes No
Information Yes No
Media Yes No
Network Yes No
File Transfer Yes No

RCP CNS Mode Yes No
Fan Control Setting Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Technical Lens PL-Mt Interface Position Yes No
PL-Mt Voltage Yes No
Zoom Ring Direction Yes No
Shading Compensation Yes No
Chroma Aberration Comp. Yes No
Distortion Comp. Yes No
Breathing Compensation Yes No
Distance Display Yes No
Zoom Position Display Yes No

Video Light Set Video Light Set Yes No
APR APR ― ―
Camera Battery Alarm Near End:Info Battery Yes No

End:Info Battery Yes No
Near End:Sony Battery Yes No
End:Sony Battery Yes No
Near End:Other Battery Yes No
End:Other Battery Yes No
Detected Battery No No

Camera DC IN Alarm DC Low Voltage1 Yes No
DC Low Voltage2 Yes No

Network Network Setup Setup for Mobile App ― ―
User Name No No
Input Password No No
Generate Password No No
Show Authentication ― ―
LAN Type Select Yes No

Wireless LAN WPS ― ―
MAC Address ― ―

AP Mode Settings Channel Yes No
Channel Bandwidth(5GHz) Yes No
Camera SSID & Password ― ―
Regenerate Password ― ―
IP Address ― ―
Subnet Mask ― ―

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Network ST Mode Settings Camera Remote Control Yes No
Connected Network

SSID ― ―
Security ― ―
Password ― ―
DHCP ― ―
IP Address ― ―
Subnet Mask ― ―
Gateway ― ―
DNS Auto ― ―
Primary DNS Server ― ―
Secondary DNS Server ― ―

Scan Networks
SSID ― ―
Security ― ―
Password No No
DHCP Yes No
IP Address Yes No
Subnet Mask Yes No
Gateway Yes No
DNS Auto Yes No
Primary DNS Server Yes No
Secondary DNS Server Yes No

Manual Register
SSID Yes No
Security Yes No
Password No No
DHCP Yes No
IP Address Yes No
Subnet Mask Yes No
Gateway Yes No
DNS Auto Yes No
Primary DNS Server Yes No
Secondary DNS Server Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Network Wired LAN Camera Remote Control Yes No
Detail Settings

DHCP Yes No
IP Address Yes No
Subnet Mask Yes No
Gateway Yes No
DNS Auto Yes No
Primary DNS Server Yes No
Secondary DNS Server Yes No

MAC Address ― ―
USB Tethering Setting Yes No

Camera Remote Control Yes No
Device Name ― ―
IP Address ― ―
Subnet Mask ― ―

File Transfer Auto Upload Yes No
Auto Upload (Proxy) Yes No
Default Upload Server Yes No
Clear Completed Jobs ― ―
Clear All Jobs ― ―
View Job List ― ―
Server Settings1/Server Settings2/Server Settings3

Display Name Yes No
Service Yes No
Host Name Yes No
Port Yes No
User Name No No
Password No No
Passive Mode Yes No
Destination Directory Yes No
Using Secure Protocol Yes No
Root Certificate ― ―
Root Certificate Status ― ―
Reset ― ―

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Network Network Reset Reset ― ―
Maintenance Language Select Yes No

Clock Set Time Zone Yes No
Date Mode Yes No
12h/24h Yes No
Date No No
Time No No

All Reset Reset ― ―
Reset without Network ― ―
Reset to Factory Defaults ― ―

Hours Meter Hours(System) ― ―
Hours(Reset) ― ―
Reset ― ―

Version Version Number ― ―
Version Up ― ―
Lens Version Number ― ―
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ブロックダイヤグラム
「収録する音声を設定する」（106ページ）と「Userメニュー」（36ページ）の関連項目をあわせてご覧ください。

Audio Input (CH1&CH2)

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

XL
R

ア
ダ

プ
タ

ー
の

場
合

XL
R

ア
ダ

プ
タ

ー
の

場
合

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ～ 10

[CH1 Wind Filter]
On
Off

[CH2 Wind Filter]
On
Off

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ～ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
Off

[Audio Input Level]
0 ～ 99

[Limiter Mode]
Off, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 XLRアダプターからの音声入力があるときはManualになります。
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Audio Input (CH3&CH4)

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 ～ 99

CH4

[CH4 Input Level]
0 ～ 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ～ 99

[Limiter Mode]
Off, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
Off
INPUT1
Internal MIC
Shoe CH1

XL
R

ア
ダ

プ
タ

ー
の

場
合

XL
R

ア
ダ

プ
タ

ー
の

場
合

[CH3 Wind Filter]
On
Off

[CH4 Wind Filter]
On
Off

[CH4 Input Select]
Off
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
Off

 

*	 XLRアダプターからの音声入力があるときはManualになります。
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Audio Output (映像出力フォーマットがMonitor FHDのとき)

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[SDI Out CH (Monitor FHD)]
CH1/CH2, CH3/CH4

[Output Format]
SDI1, SDI2, HDMI

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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Audio Output (映像出力フォーマットがMonitor FHD以外のとき)

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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Eマウントレンズのソフトウェアをアップデートする
本機でEマウントレンズ本体のソフトウェアをアッ
プデートできます。
アップデートできるレンズ本体とそのソフトウェア
は、レンズのWebサイトをご覧ください。

バージョンを確認する

1	 Eマウントレンズを本機に取り付ける（18
ページ）。

2	 フルメニューのMaintenanceメニューの
Versionを選択してLens Version Number
を表示する（71ページ）。
Eマウントレンズのソフトウェアバージョン番
号が横に表示されます。

ソフトウェアをアップデートす
る

本機をマスストレージモードにします（118ペー
ジ）。
レンズのソフトウェアに添付された手順書に従っ
てソフトウェアをアップデートしてください。



145 7章　付録

ライセンスについて
MPEG-4 AVC Patent 
Portfolio Licenseについて

本製品は、MPEG LA, LLCがライセンス活動を
行っているAVC PATENT PORTFOLIO LICENSE
の下、次の用途に限りライセンスされています：
(i)	 消費者が個人的または他の報酬を受けていな

い使用目的で、MPEG-4 AVC規格に合致し
たビデオ信号（以下、AVC VIDEOといいます）
にエンコードすること。

(ii)	AVC VIDEO（消費者が個人的または他の報
酬を受けていない目的でエンコードしたもの、
若しくはMPEG LAよりライセンスを取得した
プロバイダーがエンコードしたものに限られま
す）をデコードすること。

なお、その他の用途に関してはライセンスされて
いません。プロモーション、商業的に利用するこ
とに関する詳細な情報につきましては、MPEG 
LA, LLC.のホームページをご参照ください。

GPL/LGPL適用ソフトウェア
の入手について

本製品はGPL/LGPL適用のソフトウェアを使用
しており、お客様には、これらのソフトウェアの
ソースコードの入手、改変、再配布の権利がある
ことをお知らせします。
これらのソースコードはインターネットのサーバー
からダウンロードすることが可能です。以下の
URLにアクセスすれば、具体的なダウンロードの
方法がわかるようになっています。

https://oss.sony.net/Products/Linux/

なお、ソースコードの中身についてのお問い合わ
せはご遠慮ください。

ライセンス内容（英文）に関しては、本機の内蔵メ
モリー内に記録されています。
本機とパソコンをマスストレージ接続し、

「PMHOME」 - 「LICENSE」内にあるファイルをご
一読ください。

END USER LICENSE 
AGREEMENT

お客様による本製品の使用開始をもって、お客
様がソフトウェア使用許諾契約書の内容にご同
意いただけたものとさせていただきます。
お客様と弊社との間のソフトウェ ア使用許諾契
約書は、弊社ウェブサイト（https://rd1.sony.
net/help/di/el23/h_zz/）でご覧いただけま
す。

オープンソースソフトウェアの
ライセンスについて

本製品には、弊社がその著作権者とのライセン
ス契約に基づき使用しているソフトウェアが搭載
されています。
当該ソフトウェアの著作権者の要求に基づき、弊
社はこれらの内容をお客様に通知する義務があ
ります。

ライセンス内容（英文）に関しては、本機の内蔵メ
モリー内に記録されています。
本機とパソコンをマスストレージ接続し、

「PMHOME」 - 「LICENSE」内にあるファイルをご
一読ください。

https://oss.sony.net/Products/Linux/
https://rd1.sony.net/help/di/el23/h_zz/
https://rd1.sony.net/help/di/el23/h_zz/
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保証書とアフターサービス
保証書

•	 この製品には保証書が添付されていますので、
お買い上げの際お受け取りください。

•	 所定の事項の記入および記載内容をお確かめ
のうえ、大切に保存してください。

アフターサービス

調子が悪いときはまずチェックを

この説明書をもう一度ご覧になってお調べくださ
い。

それでも具合が悪いときは

お買い上げ店、または添付の「ソニー業務用商品
相談窓口のご案内」にあるお近くのソニーのサー
ビス窓口にご相談ください。

保証期間中の修理は

保証書の記載内容に基づいて修理させていただ
きます。詳しくは保証書をご覧ください。

保証期間経過後の修理は

修理によって機能が維持できる場合、ご要望に
より有料修理させていただきます。
保証期間中の修理など、アフターサービスにつ
いてご不明な点は、お買い上げ店、またはソニー
のサービス窓口にお問い合わせください。
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仕様
一般

質量
	 約2.9 kg（本体、PLマウントアダプター）
	 約2.4 kg（本体のみ、PLマウントアダプターを含

まず）
外形寸法
	 149ページ参照
電源電圧
	 DC 12 V（11 V ～ 17 V）
消費電力
	 本体標準消費電力：約50.0 W（レンズ付、

6K 17:9、59.94P、X-OCN LT記録
時、ファンオート、グリップリモコ
ンおよび周辺機器を含まない）

	 本体最大消費電力：約66.0 W（レンズ付、
6K 17:9、59.94P、X-OCN LT記録
時、40 ℃環境、NDフィルター（1/4）、
Proxy RECオン、Wi-Fiオン、ファ
ンオート、グリップリモコンおよび
周辺機器を含む）

動作温度
	 0 ℃～ 40 ℃
保存温度
	 －20 ℃～＋60 ℃
連続操作時間
	 約100分（BP-GL95B使用時）
記録フォーマット（ビデオ）
	 X-OCN(LT)
	 XAVC H Intra HQ
	 XAVC H Intra SQ
	 XAVC H Long
	 XAVC Intra
	 XAVC Long
記録フォーマット（オーディオ）
	 LPCM 24ビット、48 kHz、4チャンネル

記録フレームレート
	 X-OCN(LT)
		  FF 8.6K 17:9/FF 8.6K 16:9/FF 5.8K 6:5 

29.97P、25P、24P、23.98P
		  FFc 6K 17:9/FFc 6K 16:9/FFc 3.8K 

16:9/S35 5.8K 17:9/S35 5.8K 
16:9/S35 4.3K 4:3/S35c 4K 17:9/
S35c 3.8K 16:9/S35 1.9K 16:9

			   59.94P、50P、29.97P、25P、
24P、23.98P

	 XAVC H Intra HQ
		  8192×4320/29.97P、25P、24P、

23.98P
		  7680×4320/29.97P、25P、23.98P
	 XAVC H Intra SQ
		  8192×4320/29.97P、25P、24P、

23.98P
		  7680×4320/29.97P、25P、23.98P
	 XAVC H Long
		  7680×4320/29.97P、25P、23.98P
	 XAVC Intra
		  4096×2160/59.94P、50P、29.97P、

25P、24P、23.98P
		  3840×2160/1920×1080/59.94P、

50P、29.97P、25P、23.98P
	 XAVC Long
		  3840×2160/1920×1080/59.94P、

50P、29.97P、25P、23.98P
記録・再生時間
	 125ページ参照

カメラ部

撮像素子
	 35mmフルサイズ相当単板CMOSイメージセン

サー
画素数
	 57.0M（total）

オートフォーカス
	 検出方式：位相差検出方式／コントラスト検出

方式
内蔵NDフィルター
	 CLEAR：OFF
	 リニア可変ND：0.6 (1/4) ～ 2.1 (1/128)
ISO感度
	 ISO 800/3200（Cine EIモード、Base ISO、

D55 Light source）
レンズマウント
	 PLマウント（PLマウントアダプター使用）
	 Eマウント（PLマウントアダプター未使用時）
フランジバック
	 PLマウント：52 mm
	 Eマウント：18 mm
ラティチュード
	 16 stops
シャッタースピード
	 1/8000秒 ～ 64F（23.98P時）
シャッターアングル
	 5.6°～ 360°、2 ～ 64frame
ホワイトバランス
	 2000 K ～ 15000 K
ゲイン
	 －3 dB ～＋18 dB（1 dB単位）

オーディオ部

サンプリング周波数
	 48 kHz
量子化特性
	 24ビット
周波数特性
	 本体XLR入力MICモード時：20 Hz ～ 20 kHz

（±3 dB以内）
	 本体XLR入力LINEモード時：20 Hz ～ 20 kHz

（±3 dB以内）

ダイナミックレンジ
	 本体XLR入力MICモード時：80 dB（Typical）
	 本体XLR入力LINEモード時：90 dB（Typical）
ひずみ率
	 本体XLR入力MICモード時：0.08%以下 

（入力レベル－40 dBu時）
	 本体XLR入力LINEモード時：0.08%以下 

（入力レベル＋14 dBu時）
内蔵スピーカー
	 モノラル
本体内蔵マイク
	 モノラル

入出力部

入力
INPUT 1/2：
	 XLR型、3ピン、凹
	 LINE / MIC / MIC+48V切り替え可能
	 MIC：Reference －30 dBu ～－80 dBu
TC IN：
	 BNC型
REF IN：
	 BNC型

出力
SDI OUT 1：
	 BNC型、12G-SDI、6G-SDI、 3G-SDI（Level 

A/B）、HD-SDI 
SDI OUT 2：
	 BNC型、3G-SDI（Level A/B）、HD-SDI
ヘッドホン（ステレオミニジャック）：
	 －16 dBu（基準レベル出力、モニターボリューム

最大、16 Ω負荷時）
HDMI：
	 TypeA、19ピン
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TC OUT：
	 BNC型
REF OUT：
	 BNC型

その他
DC IN：
	 XLR型、4ピン凸型（1）、11 V ～ 17 V
REMOTE：
	 2.5φ3極ミニミニタイプ
グリップリモコン端子：
	 3.5φ4極ミニジャック
USB-C：
	 USB3.2 Gen1
VF：
	 専用40ピン
ネットワーク端子：
	 RJ45型
ハンドル接続端子：
	 専用40ピン

表示部

ビューファインダー（LCD）
画面サイズ
	 対角8.8 cm（3.5型）
アスペクト比
	 16:9
画素数
	 1280（H）×720（V）

メディアスロット部

CFexpress Type Bカードスロット（2）
Utility SDカードスロット（1） 

ワイヤレスLAN

対応規格
	 IEEE 802.11a/b/g/n/ac
使用周波数帯
	 2.4 GHz帯／ 5 GHz帯
セキュリティ
	 WPA2-PSK (AES) ／ WPA3-SAE
接続方式
	 Wi-Fi Protected Setup™ (WPS) ／ 

マニュアル
アクセス方式
	 インフラストラクチャーモード

付属品

ハンドル（ビューファインダーアームを含む）（1）
ハンドル固定用ネジ（4）
LCDモニター（1）
ビューファインダールーペ（1）
ビューファインダー取り付け台座（1）
シム（円弧型）（1）
シム（1/3円弧型）（15）
Eマウントキャップ（1） 
PLマウントキャップ（1）
ご使用になる前に（1）
保証書（1）

仕様および外観は、改良のため予告なく変更す
ることがありますが、ご了承ください。

•	 必ず事前に記録テストを行い、正常に記録さ
れていることを確認してください。本機や記
録メディアなどを使用中、万一これらの不具
合により記録されなかった場合の記録内容の
補償については、ご容赦ください。

•	 お使いになる前に、必ず動作確認を行ってく
ださい。故障その他に伴う営業上の機会損
失等は保証期間中および保証期間経過後に
かかわらず、補償はいたしかねますのでご了
承ください。

•	 本製品を使用したことによるお客様、または
第三者からのいかなる請求についても、当社
は一切の責任を負いかねます。

•	 本機内、記録メディア等に記録されたデータ
の損失、修復、複製の責任は負いかねます。

•	 諸事情による本製品に関連するサービスの停
止、中断について、一切の責任を負いかねま
す。
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外形寸法

トップ（上面）／フロント（前面）／操作スイッチ面／リア（後面）

14

2.3

73

3×UNC 3/8-16, 
Depth:14

M2, Depth:3.9 
(Counterbore φ5.3, Depth:1.9)

6×UNC 3/8-16, Depth:10

8×UNC 1/4-20, 
Depth:103×UNC 1/4-20, 

Depth:9

6×M3, Depth:6

6×UNC 1/4-20, 
Depth:9

UNC 3/8-16, 
Depth:7

142.5

2712

70

14464.6

66.85

41.85 50 50

50 50

9

18
30.75 20 20

30 30

84

50.6

33.4

2×M3, Depth:5

2×M3, Depth:5

単位: mm

218.1 184.25

212.5

13.5 UNC 1/4-20, 
Depth:9

2×M3, Depth:5

62 29 25 20
20

6.05

59.1

145.7

25

7.4

12.5

12.5

7.4

25
50
25

184

50 50 75

50 5041.85

66.85

65.4

73

69

58.6 58.6

86.5

69.5
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端子面／ボトム（底面）
単位: mm

25
25
25

1.5

34.6

4×UNC 3/8-16, 
Depth:9

4×UNC 1/4-20, 
Depth:9

2×M3, Depth:5

25
25
25

14
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商標について

•	 HDMI、High-Definition Multimedia 
Interface、およびHDMIロゴ は、米国お
よびその他の国におけるHDMI Licensing 
Administrator, Inc.の商標または、登録商標
です。

•	 USB Type-C™およびUSB-C™はUSB 
Implementers Forumの商標です。

•	 その他、本書で登場するシステム名、製品名は、
一般に各開発メーカーの登録商標あるいは商
標です。なお、本文中で®、™マークは明記し
ておりません。
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